PrinterOn Enterprise/Express

Configuration Guide

Version 3.2.7
# Contents

## Chapter 1: Introduction

- PrinterOn Server editions ................................................................. 8
- PrinterOn printers and pools ................................................................. 9
  - PrinterOn printers ........................................................................... 9
  - Secure Release Anywhere pools ...................................................... 10
- The PrinterOn solution components .................................................. 10
  - Architecture overview .................................................................... 11

## Chapter 2: Exploring the Configuration Manager

- Launching the Configuration Manager .................................................. 13
  - Basic and Advanced views .............................................................. 14
  - Component-specific UI ...................................................................... 15
  - Tabbed interface ............................................................................... 16
- Accessing PrinterOn Server component configurations ........................ 22
- Administering the Configuration Manager ........................................... 23
  - Changing your Configuration Manager password ............................ 23
  - Connecting remote servers to a parent Configuration Manager ........ 24
  - Using LDAP/AD for Configuration Manager authentication ............. 25
  - Logging out ..................................................................................... 27

## Chapter 3: Managing and configuring PrinterOn printers

- Adding PrinterOn printers ................................................................. 29
- Working with the Printers list .............................................................. 29
- Configuring individual printer settings ................................................. 30
<table>
<thead>
<tr>
<th>Configuring Secure Release Anywhere release stations</th>
<th>79</th>
</tr>
</thead>
<tbody>
<tr>
<td>Formatting the Secure Release Anywhere URL for web-based release</td>
<td>81</td>
</tr>
<tr>
<td>Bookmarking the Secure Release Anywhere URL for Samsung Smart UX</td>
<td>84</td>
</tr>
<tr>
<td>Configuring the Ricoh device browser</td>
<td>86</td>
</tr>
<tr>
<td>Configuring a Brother BSI (local network) Secure Release Anywhere release station</td>
<td>87</td>
</tr>
<tr>
<td>Configuring the PrinterOn Network Print Valet</td>
<td>89</td>
</tr>
</tbody>
</table>

**Chapter 5: Configuring workflows** ........................................................................................................ 92

<table>
<thead>
<tr>
<th>Configuring the Web Print workflow</th>
<th>93</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring the Mobile Print workflow</td>
<td>95</td>
</tr>
<tr>
<td>Configuring the Email Print workflow</td>
<td>96</td>
</tr>
<tr>
<td>Configuring Exchange Web Services (EWS) settings</td>
<td>97</td>
</tr>
<tr>
<td>Configuring IMAP4 settings</td>
<td>99</td>
</tr>
<tr>
<td>Configuring MAPI settings</td>
<td>100</td>
</tr>
<tr>
<td>Configuring Domino settings (Enterprise Edition only)</td>
<td>101</td>
</tr>
<tr>
<td>Configuring the SMTP Server for outbound messages</td>
<td>103</td>
</tr>
<tr>
<td>Configuring the Advanced Email Settings</td>
<td>105</td>
</tr>
<tr>
<td>Configuring the Google Cloud Print workflow</td>
<td>106</td>
</tr>
<tr>
<td>Google Cloud Print authentication</td>
<td>107</td>
</tr>
<tr>
<td>Adding a Google Cloud printer</td>
<td>107</td>
</tr>
<tr>
<td>Configuring Google Cloud Print general settings</td>
<td>108</td>
</tr>
<tr>
<td>Sharing a Google Cloud printer</td>
<td>108</td>
</tr>
<tr>
<td>Configuring the PrinterOn Queue Management System (PQMS) workflow</td>
<td>109</td>
</tr>
<tr>
<td>Configuring the PQMS connector</td>
<td>110</td>
</tr>
<tr>
<td>Mapping the Windows Print Queue to a PrinterOn printer</td>
<td>111</td>
</tr>
<tr>
<td>Configuring IPP and Native iOS workflows</td>
<td>111</td>
</tr>
<tr>
<td>Configuring Native iOS Printing</td>
<td>111</td>
</tr>
<tr>
<td>Configuring IPP Printing</td>
<td>113</td>
</tr>
</tbody>
</table>

**Chapter 6: Configuring general settings** ........................................................................................................ 117

<table>
<thead>
<tr>
<th>Viewing system information</th>
<th>117</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewing version information for all installed server components</td>
<td>118</td>
</tr>
<tr>
<td>Exporting server and system information</td>
<td>119</td>
</tr>
<tr>
<td>Creating a package of diagnostic information</td>
<td>119</td>
</tr>
<tr>
<td>Configuring general cross-component settings</td>
<td>120</td>
</tr>
<tr>
<td>Setting debug logging levels</td>
<td>120</td>
</tr>
<tr>
<td>Configuring Job Management settings</td>
<td>122</td>
</tr>
<tr>
<td>Configuring proxy settings for the Central Print Services</td>
<td>123</td>
</tr>
<tr>
<td>Configuring printer synchronization settings</td>
<td>124</td>
</tr>
<tr>
<td>Configuring service capabilities</td>
<td>125</td>
</tr>
</tbody>
</table>
Starting, stopping, or restarting the PrinterOn services ................................................................. 128
Managing your PrinterOn license .................................................................................................. 128
  Updating your PrinterOn license .......................................................................................... 128
  Viewing your license information ....................................................................................... 130
  Downloading your PrinterOn license .................................................................................. 131
  Downloading a custom PrinterOn license .......................................................................... 131
  Modifying the server deployment mode .............................................................................. 132
Managing components ................................................................................................................. 136
  Adding component instances ............................................................................................ 136
  Changing the serial number of an active component ......................................................... 137
  Deleting unused serial numbers ......................................................................................... 137

Chapter 7: Configuring authentication settings .............................................................................. 139
Configuring LDAP/AD authentication .......................................................................................... 140
  Creating and managing LDAP/AD profiles ........................................................................ 142
  Configuring LDAP/AD server profiles .............................................................................. 144
  Configuring user rules and printer access .......................................................................... 148
  Managing Guest LDAP settings ........................................................................................ 150
Configuring PrinterOn AAA Login authentication .................................................................. 151
Configuring PrinterOn ACL authentication ............................................................................ 151
  Managing users .................................................................................................................. 152

Chapter 8: Integrating user lookup extensions .............................................................................. 155
Configuring User Lookup integration ........................................................................................ 155
  Configuring the User Lookup settings .............................................................................. 156
  Configuring the behavior for identified and unidentified users ........................................ 157

Chapter 9: Advanced clustering and document processing scalability ....................................... 160
PrintAnywhere Server clustering overview ............................................................................... 160
  Document processor clustering ......................................................................................... 161
  Server redundancy clustering ............................................................................................. 161
  Clustering requirements .................................................................................................... 161
  Print job processing in a clustered deployment ................................................................. 162
Creating and configuring a server cluster .................................................................................... 162
  Adding a new PrintAnywhere Server to your PrinterOn service ...................................... 163
  Installing the PrintAnywhere component on the remote server(s) .................................. 164
  Adding servers to a cluster ............................................................................................... 166
Chapter 10: Adding a Print Delivery Hub ................................................................. 171

System capacity ........................................................................................................ 172
Network layout ........................................................................................................... 172
Common deployment scenarios .................................................................................. 172
  Single server deployment ....................................................................................... 173
  Two node redundant deployment .......................................................................... 173
  Multiple redundant PDH clusters .......................................................................... 174
Configuring Internet communications ........................................................................ 175
  Network Identification and Access ....................................................................... 176
  Configuring PDH licensing and the Web Services Manager .................................. 177
  Configuring Network and Broadcast Settings ....................................................... 177
  Configuring Thread Pool settings ......................................................................... 178
  Configuring Print Delivery Station Communication settings ............................... 180
  XMPP notifications ............................................................................................. 181
Configuring PDH job storage .................................................................................... 181
  Configuring Print Processing settings .................................................................. 182
  Configuring Unclaimed Job Handling settings ..................................................... 183
  Advanced Network Settings ................................................................................. 184
Logging ...................................................................................................................... 185
Configuring SSL settings for your PDH .................................................................. 186
  SSL Certificate Keystore ....................................................................................... 187
  Entering SSL Information ...................................................................................... 188
Configuring scalability behavior .............................................................................. 189
  Configuring Cluster Security and Cluster Configuration ....................................... 190
  Configuring Remote Hub Replication .................................................................. 191
  Configuring Remote Hub Resynchronization ....................................................... 192
  Adding Cluster Peers ............................................................................................ 193
Proxy Configuration ................................................................................................ 195

Chapter 11: Configuring your mail server for PrinterOn email printing ................... 197

Maintaining email security ....................................................................................... 197
Recommended message routing configurations ...................................................... 198
  Configuring a printing-specific email subdomain .................................................. 198
Creating a printing-dedicated mailbox .................................................................... 199
  Setting up a mailbox alias in non-ActiveSync environments ............................... 199
  Creating a mailbox when aliases cannot be used ................................................... 200
Configuring email catch-alls ................................................................................... 203
  Setting up a catch-all in Exchange 2010 ............................................................... 203
  Setting up a catch-all in hMailServer .................................................................... 204
  Setting up a catch-all in Lotus Domino ................................................................. 204
Appendix D: PrinterOn Server network port usage ................................................................. 242

Appendix E: Additional configuration details ........................................................................ 244

Configuring Microsoft Office permissions ........................................................................... 244
Reconfiguring the Print Anywhere Server for newly installed applications ............................ 245
Configuring region-specific encoding for text files ............................................................... 247
Enabling PrintAnywhere to permit print jobs from a remote CPS server .............................. 248
Disabling strict SSL verification for CPS ............................................................................... 249
Enabling LDAP/AD for PrintWhere ...................................................................................... 250
Introduction

This guide explains how to configure and monitor the PrinterOn® Enterprise and PrinterOn Express software.

The PrinterOn solution allows your users to print without installing drivers and without a difficult setup or complicated configuration. Once your PrinterOn software is installed and configured, users can submit print jobs to PrinterOn connected printers in a variety of ways, including:

- using the PrinterOn Web Print portal
- using the PrinterOn Mobile App
- by email
- through Google Cloud Print
- through native Windows print queues, native iOS, or native IPP

With PrinterOn Enterprise/Express 3.2, PrinterOn also supports Secure Release Anywhere™ pull printing, which lets users print to a printer pool and then pull their print job to the printer that is most convenient.

1.1 PrinterOn Server editions

Your PrinterOn Server installation will install one of the following editions of the software:

- PrinterOn Enterprise: The Enterprise Edition is a full-featured print solution. This edition supports advanced features such as multi-server deployment, scalability through clustering, and integration with MDM/EDM solutions.
• PrinterOn Server Express: The PrinterOn Server Express edition is the starter package. Although it shares all the same basic features as PrinterOn Enterprise, it excludes many of the advanced configuration features of the Enterprise edition that are typically unnecessary for a small- to medium-sized business or organization. You can upgrade your Express edition to Enterprise at any time.

1.2 PrinterOn printers and pools

Before working with the PrinterOn solution, it is useful to understand two key concepts:

• PrinterOn printers
• Secure Release Anywhere pools

1.2.1 PrinterOn printers

A PrinterOn printer is not a physical printer, but rather a virtual printer. That is, it is a definition that points to a physical printer and defines the printing behavior. The PrinterOn server acts as middleware between the user and a physical printer. When users submit jobs to a PrinterOn printer, the PrinterOn server directs those jobs to the physical printer or print queue defined for that printer, referred to as an output destination. Before users can submit print jobs to a PrinterOn printer, you must point define that printer’s output destination.

PrinterOn printers need not map to physical printers on a one-to-one basis. The benefit of creating virtual printers is that you can specify different printing behavior or access privileges for the same physical printer. You simply create multiple PrinterOn printer definitions, apply different configuration settings to each, and then map them to the same physical printer. Although it is the same physical printer printing the jobs in each case, to the user, they appear as distinct printers with different available features.

For example, consider a hotel with a color printer. The hotel could create one printer definition that points to their color printer and allows users to print in colour at a specific price per sheet. They could then create a second printer definition that points to the same physical printer, but restricts print jobs to black and white, and charges a lower rate per sheet. For frequent guests, they could also create a third printer definition for the same printer that does not charge a fee at all.
1.2.2 Secure Release Anywhere pools

Secure Release Anywhere pools are groups of PrinterOn printers. To the user, a printer pool appears as just another printer. However, instead of distributing jobs to a single output destination, a printer pool can distribute print jobs to any of its member printers. Users can go to the output destination of any member printer and pull the print job down using their credentials or a secure release code.

The printers in a Secure Release Anywhere pool are not limited to a single network; you can include printers from disparate networks in a single printer pool. For example, a hotel chain could create a single Secure Release Anywhere pool that contains all the printers from their business centers in all their hotels worldwide. A guest in the Singapore location can print to the printer pool, go to the business center, and pull the job down. The same guest could travel to Seoul the next day, print to the same pool, go to the business center at the Seoul location, and pull the job down there.

1.3 The PrinterOn solution components

The PrinterOn server software consists of several components that work together to enable web-based printing from PCs and laptops with Internet access. The PrinterOn solution is comprised of the following components:

- **PrinterOn Configuration Manager**: Provides a single centralized management console for all software components, servers and options.
- **PrinterOn Central Print Services (CPS)**: The primary entry point for all requests submitted to the PrinterOn server. In addition to providing access to print services, the CPS also hosts the Web Print portal, and the CPS Administration Console.
- **PrinterOn PrintAnywhere® server (PAS)**: Provides document processing and rendering.
- **PrinterOn Print Delivery Station (PDS)**: Collects print jobs and provides privacy release capability.
- **PrinterOn Print Delivery Gateway (PDG)**: Provides support for printing from a variety of devices and systems including iOS, Google Cloud Print compatible applications or traditional print queues.
- **PrinterOn Print Delivery Hub (PDH)**: In Enterprise installations, distributes print jobs to PDSs installed on disparate networks.

For more information on the PrinterOn components, see [PrinterOn Server components glossary and overview](#).
The PrinterOn solution can be configured for several popular system integration models or customized as needed using the available HTML and Java source code. It is easy to deploy and can be hosted in multiple local or remote network scenarios. The PrinterOn software has been designed for optional integration with existing network infrastructures, including LDAP and Print Management Systems.

1.3.1 Architecture overview

Simplified PrinterOn architecture
Detailed PrinterOn architecture with communication ports

The following diagram illustrates a distributed PrinterOn Enterprise deployment. In PrinterOn Express, all components must be installed on a single server; multiple networks and the PDH component are not supported.

Note: The Print Delivery Hub (PDH) component is only available in PrinterOn Enterprise. It manages the delivery of print jobs to multiple PDS components across disparate networks. It is not available with PrinterOn Express.
Exploring the Configuration Manager

With the PrinterOn software installed, you can log in to the Configuration Manager to complete the server configuration and setup.

The Configuration Manager allows you to configure all PrinterOn Server settings, administer your printers, and synchronize printer settings.

2.1 Launching the Configuration Manager

To open the PrinterOn Configuration Manager:

1. Choose Start > All Programs > PrinterOn > Configure Server.

   **Note:** If on Windows 2012, search for Configuration Manager from the Start menu, or go to http://127.0.0.1:8057.

2. Log in to the Configuration Manager.
After you successfully log in, the Configuration Manager appears, displaying the Overview sub-tab of the Home tab.

### 2.1.0.1 Logging in with the default value

If you are logging in to the Configuration Manager for the first time, or you have reset the password or restored the Root user, you must log in using the default login credentials:

- **Username**: root
- **Password**: One of the following values:
  - For a trial installation, enter Trial.
  - For a licensed installation, enter the APIsiteAuth value found in the [site] section of your PrinterOn license file (PrinterOnConfig.txt). For example:

    ```
    [site]
    APIsiteUID = 562873393017
    APIsiteAuth = SzNQJxV7
    AdminEmail = email@printeron.com
    ```

    When you log in with your default password, the Configuration Manager immediately prompts you to change your password.

### 2.1.1 Basic and Advanced views

With version 3.2.1, you can display the Configuration Manager in two views:

- **Basic view**: Displays commonly configured settings.
- **Advanced view**: Displays all Basic view settings plus additional advanced settings. Advanced settings are those that are only rarely configured or are specific to a particular deployment.
By default, the Configuration Manager opens in Basic view. You can toggle between the two views using the **Show Advanced Settings** switch on the **Settings** menu. As you turn Advanced view on and off, the interface is updated in real time.

For completeness, this guide documents all settings. Screen shots are typically shown in Advanced view. As a result, if you are displaying Configuration Manager in Basic view, images in this guide may appear slightly different than what appears on screen. For a complete list of settings that are hidden when the Configuration Manager appears in Basic view, see **Appendix A: Advanced configuration settings**.

To show or hide advanced settings:

1. In the Configuration Manager, click the **Settings** button ( ).
2. Click **Show Advanced Settings** to toggle advanced settings on or off.

![Configuration Manager UI](image)

### 2.1.2 Component-specific UI

With version 3.2.2, the Configuration Manager provides a flexible UI that adapts based on which components are present on the server.

The PrinterOn software can be deployed in a variety of ways based on the needs of an organization. For example, an organization may have a remote Print Delivery Service component, it might have a Print Delivery Gateway installed on its own server, or may deploy components in some other distributed scenario in which components are installed on multiple servers.

To simplify the configuration process in these scenarios, the Configuration Manager displays only those settings that are relevant to the installed components. When you open the Configuration Manager, it first checks which components are installed on the server, then excludes those settings that do not apply to the installed components.

As a result, depending on your deployment and the server you are configuring, you may not see all the screens or settings described in this guide.
2.1.3 Tabbed interface

The Configuration Manager workspace contains a number of tabs from which you can configure all aspects of your PrinterOn solution.

**Note:** As of version 3.2.2, the Configuration Manager only displays configuration settings for those components that are installed on that server. Depending on which components you have installed, you may not see all of the tabs listed below.

<table>
<thead>
<tr>
<th>Tab/Menu</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Home]</td>
<td>Provides access to general information about your system health. You can also manage your PrinterOn license and add PDS, PDH, and Print Anywhere components to your PrinterOn deployment. For more information, see The Home tab.</td>
</tr>
<tr>
<td>![Workflows]</td>
<td>Lets you configure settings for the various printing workflows that users can use to print documents to your PrinterOn printers, such as Web Print or Mobile Print. For more information, see The Workflow tab.</td>
</tr>
<tr>
<td>![Authentication]</td>
<td>Lets you configure settings for your selected authentication method. For more information, see The Authentication tab.</td>
</tr>
<tr>
<td>![Printers]</td>
<td>Lets you add and configure your printers. For more information, see The Printers tab.</td>
</tr>
<tr>
<td>![Reports]</td>
<td>Lets you do generate reports on your overall PrinterOn deployment. For more information, see The Reports tab.</td>
</tr>
<tr>
<td>![Advanced]</td>
<td>Provides access to advanced configuration features, such as clustering and server stuff. For more information, see The Advanced menu.</td>
</tr>
<tr>
<td>![Settings menu]</td>
<td>Provides access to general administration tasks. For more information, see Accessing PrinterOn Server component configurations.</td>
</tr>
</tbody>
</table>
2.1.3.1 The Home tab

The Home tab provides access to general information about your system health. From the Home sub-tabs, you can also manage your PrinterOn license and add PDS, PDH, and Print Anywhere components to your PrinterOn deployment.

The Home tab contains the following sub-tabs:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>Provides system information and an overview of system health.</td>
</tr>
<tr>
<td>General Settings</td>
<td>Lets you configure cross-component settings.</td>
</tr>
<tr>
<td>Services</td>
<td>Lets you view and change the status of the PrinterOn services.</td>
</tr>
<tr>
<td>Licensing</td>
<td>Lets you view and manage your license information.</td>
</tr>
<tr>
<td>Serial Numbers</td>
<td>Lets you view serial number information for server components.</td>
</tr>
</tbody>
</table>
2.1.3.2 The Workflow tab

The Workflow tab lets you configure settings for the various printing workflows that users can use to print documents to your PrinterOn printers, such as Web Print or Mobile Print.

The Workflow tab contains the following sub-tabs:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Print</td>
<td>Lets you configure settings for Web Print, which allows users to upload documents to the Web Print portal. For more information, see Configuring the Web Print workflow.</td>
</tr>
<tr>
<td>Mobile</td>
<td>Lets you configure settings to allow users to submit jobs using one of PrinterOn’s mobile client apps. For more information, see Configuring the Mobile Print workflow.</td>
</tr>
<tr>
<td>Email Print</td>
<td>Lets you configure settings to allow users to email documents as printable attachments directly to a PrinterOn printer. For more information, see Configuring the Email Print workflow.</td>
</tr>
<tr>
<td>Google Cloud Print</td>
<td>Lets you configure settings to allow users to submit print jobs via the Google Cloud. For more information, see Configuring the Google Cloud Print workflow.</td>
</tr>
<tr>
<td>PQMS</td>
<td>Lets you configure settings to allow users to print to Windows print queues that are mapped to PrinterOn printers. For more information, see Configuring the PrinterOn Queue Management System (PQMS) workflow.</td>
</tr>
<tr>
<td>IPP and Native iOS</td>
<td>Lets you configure settings to allow users to print using either IPP printers that are mapped to PrinterOn printers, or using iOS native printing. For more information, see Configuring IPP and Native iOS workflows.</td>
</tr>
</tbody>
</table>
2.1.3.3 The Authentication tab

The Authentication tab lets you specify the authentication method you want to use with your PrinterOn solution, and to configure user lookup integration.

The Authentication tab contains the following sub-tabs:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication</td>
<td>Lets you specify and configure the authentication method. For more information, see Configuring authentication settings.</td>
</tr>
<tr>
<td>Integration</td>
<td>Lets you configure how PrinterOn performs user lookup with third-party print management services. For more information, see Integrating user lookup extensions.</td>
</tr>
</tbody>
</table>
2.1.3.4 The Printers tab

The Printers tab lets you define your PrinterOn printer definitions, monitor print jobs, and create printer pools for pull printing.

The Printers tab contains the following sub-tabs:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printers</td>
<td>Lets you create and configure PrinterOn virtual printers and connect them to a physical printer or print queue. For more information, see Managing and configuring PrinterOn printers.</td>
</tr>
<tr>
<td>Secure Release</td>
<td>Lets you assign your PrinterOn printers to printer pools. When printing, users choose a pool, and can pull their print job down to any of the printers in the pool. For more information, see Creating and configuring Secure Release Anywhere pools.</td>
</tr>
<tr>
<td>Secure Release</td>
<td>Note: This tab is only available if you have Secure Remote Release enabled for your PrinterOn service.</td>
</tr>
<tr>
<td>Anywhere Pools</td>
<td>Queue Monitor lets you monitor the status of print jobs sent to all your PrinterOn printers.</td>
</tr>
<tr>
<td>Servers</td>
<td>Lets you configure the Print Delivery Station software.</td>
</tr>
</tbody>
</table>
2.1.3.5 The Reports tab

The Reports tab lets you generate reports on your PrinterOn deployment.

The Reports tab contains the following sub-tabs:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary</td>
<td>Provides a three-month summary of print behavior.</td>
</tr>
<tr>
<td>Printer Activity</td>
<td>Lets you generate a report for a selected printer.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Lets you generate reports on key printing metrics of all your PrinterOn printers.</td>
</tr>
</tbody>
</table>

2.1.3.6 The Advanced menu

The Advanced menu lets you configure settings for the servers, components, and clusters in your PrinterOn deployment. The Advanced menu contains the following menu items:

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Servers</td>
<td>Lets you configure Server settings.</td>
</tr>
<tr>
<td>Components</td>
<td>Lets you configure component-specific settings for each of the PrinterOn server components installed on this server, or on any child server.</td>
</tr>
<tr>
<td>Clustering</td>
<td>Lets you configure clustering for Print Anywhere Processing and Status Servers. For more information, see Advanced clustering and document processing scalability.</td>
</tr>
</tbody>
</table>
2.2 Accessing PrinterOn Server component configurations

In addition to the configuration settings that are applied to your PrinterOn service, you can also modify additional component-specific settings in the Configuration Manager. You can access these component specific configurations from the Advanced menu, or via the Home screen.

To access a component configuration for a component installed on the local server:

1. In the Configuration Manager, do one of the following:
   - Click Advanced > Components.
   - or
   - Click Home, then in the System Health panel, click on the Number of Managed Components link.

The Managed Components page appears.

2. Click on the Configure button adjacent to the component you want to configure. The component configuration for the selected component appears.
2.3 Administering the Configuration Manager

The Settings menu, identified by the gear icon (⚙️), lets you perform some general administration tasks.

2.3.1 Changing your Configuration Manager password

You can change your password at any time from the Configuration Manager Settings menu.

To change your Configuration Manager password:

1. In the Configuration Manager, click the Settings button (⚙️).
2. Click Change Password. The Change Password dialog appears.

3. Enter your old password, then enter and confirm your new password and click Login.

Your new password must meet the following criteria:

- It must not contain your Username.
- It must not have 4 or more consecutive letters or digits.
- It must be at least 8 characters in length, with at least 1 letter, 1 number, and 1 special character. Passwords of 10 or more characters must have at least 2 letters, 2 numbers and/or 2 special characters.
2.3.1.1 Resetting the Configuration Manager Password

In some cases, it might be necessary to reset your Configuration Manager administrator password. To ensure the process is secure, you must have your APIsiteAuth value, which is part of your PrinterOn Server license file.

To reset your password:

1. Launch the Configuration Manager.
2. Click **Forgot Password?** The Reset Password dialog appears.
3. Enter your Site Auth value, then click **Reset Password**.

   Your password is now reset to the default. When you login, you’ll be prompted to change your password immediately.

2.3.2 Connecting remote servers to a parent Configuration Manager

The PrinterOn Configuration Manager allows you to manage multiple servers from a single location. To complete this process, you must log into the Configuration Manager on the remote server and select a parent configuration server.

**Note:** You can still configure individual servers locally on each remote server, regardless of the parent configuration.

To connect to a parent server:

1. On the remote server, log into the Configuration Manager and click **Settings** > **Settings**.
The Settings page appears.

2. In the **Parent URI** field, enter the IP address and port of your central PrinterOn Server machine. The default port is 8057.

3. Press **Connect**.

You can now log into Configuration Manager on your parent server to manage and configure the PrinterOn components installed on the remote server.

### 2.3.3 Using LDAP/AD for Configuration Manager authentication

By default, Configuration Manager uses a built-in Root administrator account. However, if you have an LDAP/AD server, you can configure the Configuration Manager to authenticate against an LDAP/AD server instead.

**Note:** Before setting up Configuration Manager to use LDAP/AD credentials, you must:

- **Turn on Advanced view.** Setting up LDAP/AD authentication for Configuration Manager requires settings that are only available in Advanced view.
- Set up LDAP/AD authentication for your PrinterOn service. For more information, see Configuring LDAP/AD authentication.
- Set up an LDAP/AD profile specifically for PrinterOn administrators. To designate an LDAP/AD profile for PrinterOn administrators, you must enable the **Enable Configuration Manager Access** setting within the LDAP/AD profile configuration. For more information, see Configuring LDAP/AD server profiles.

To use LDAP/AD authentication to log into Configuration Manager:

1. Log into the Configuration Manager.
2. Click **Settings** > **Settings**. The Settings page appears.

3. In the Authentication Settings panel, check **Enable CPS authentication**.
4. To only use LDAP/AD for authentication, disable the **Enable “root” User** setting.

   **Note:** If you disable the Root user, and you have not properly configured LDAP/AD settings for the PrinterOn Server or the LDAP/AD server becomes inaccessible for any reason, you may temporarily be unable to access the Configuration Manager. If necessary, you can restore Root access to ensure there is no disruption in your ability to manage your PrinterOn service. For more information, see [Restoring Root access to the Configuration Manager](#).

5. Click **Apply Settings**.

### 2.3.3.1 Restoring Root access to the Configuration Manager

If you disable the Root user and rely exclusively on LDAP/AD for authentication, should you lose access to the LDAP/AD server for some reason, you may be temporarily unable to log in to the Configuration Manager. If necessary, you can restore Root access to ensure that you can still manage your PrinterOn service.

To restore Root access to the Configuration Manager:

1. Open any text editor. You **must** open the editor as administrator. To open the text editor as the administrator:
   a) In the Windows **Start** menu or File Manager, right-click the text editor.
   b) Select **Run as Administrator**.
2. In the text editor, open the following file:

   ```
   PrinterOn_Install_Dir\printer-on-web\WEB-INF\classes\ponconf.properties
   ```
3. In the ponconf.properties file, locate the following entry:
   ponconf.rootUser = false
   and change it to the following:
   ponconf.rootUser = true
4. Save the file. The Root User is restored, and the password is reset to the default.

2.3.4 Logging out

To log out of the Configuration Manager:
1. Click Settings ( ) > Logout.
Managing and configuring PrinterOn printers

The Printers tab lets you to create, edit, and manage your PrinterOn printers. A PrinterOn printer is not a physical printer, but rather a virtual printer that both points to a physical printer (the output destination) and defines printing behavior.

You can add as many PrinterOn printers as your license permits. However, before users can submit print jobs to a PrinterOn printer, you must point the PrinterOn printer to a physical printer or print queue.

To view your PrinterOn printers:

1. In the Configuration Manager, click Printers. The Printers tab appears, displaying a list of currently available printers.
3.1 Adding PrinterOn printers

You can add as many PrinterOn printers to your deployment as your PrinterOn license permits.

To add a new PrinterOn printer:

1. In to the Configuration Manager, click **Printers**.
2. Click **Add Printer**. A new printer is added to the printers list.
3. Configure the printer settings as necessary.

3.2 Working with the Printers list

You can interact with the Printers list to perform a variety of functions.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enabled</strong></td>
<td>Indicates whether the printer appears in the user’s list of available printers. Click the icon to enable or disable the selected printer.</td>
</tr>
<tr>
<td><strong>Printer Name</strong></td>
<td>The name used to identify the printer on the printeron.com website.</td>
</tr>
<tr>
<td><strong>Output Destination</strong></td>
<td>Defines the physical printer, print queue, or file to which the PrinterOn printer directs print jobs. You must define the Output Destination for the PrinterOn Server to communicate with your physical printers, or with a print queue. You set the output destination in the <strong>Output Location settings</strong> panel of the Printer Configuration dialog. For detailed information about defining the output destination for a printer, see Configuring Printer Output Destinations.</td>
</tr>
<tr>
<td><strong>Guest</strong></td>
<td>Indicates whether the printer allows guest users (that is, users without credentials) to submit print jobs. <strong>Note:</strong> This column only appears when LDAP/AD authentication is configured for the server, with the <strong>Guest Login Enabled</strong> setting selected. Click the icon to enable or disable guest printing for the selected printer.</td>
</tr>
</tbody>
</table>
3.3 Configuring individual printer settings

Individual printer settings are managed through the **Printers** tab. Each printer can be configured individually.

If you have a large number of printers to configure, you can configure a single printer and then use that printer as a template for other printers to quickly copy groups of settings. For more information, see Copying template settings to multiple printers.

To configure a printer:

1. In the PrinterOn Printers list, click next to the printer that you want to configure. The printer actions appear.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval</td>
<td>Indicates whether the approval screen appears, allowing the user the option to cancel the print job before it is submitted to the printer or to the print queue. Click the icon to enable or disable the approval screen for the selected printer.</td>
</tr>
<tr>
<td>PQMS</td>
<td>Indicates whether the printer is enabled for the PrinterOn Queue Management System. This column is read-only. To configure the printer to use Google Cloud Printing, see Configuring the PrinterOn Queue Management System (PQMS) workflow.</td>
</tr>
<tr>
<td>GCP</td>
<td>Indicates whether the printer supports Google Cloud Printing. This column is read only. To configure the printer to use Google Cloud Printing, see Configuring the Google Cloud Print workflow.</td>
</tr>
<tr>
<td>Discovery</td>
<td>Indicates whether the printer is discoverable by users. Click the icon to enable or disable discovery.</td>
</tr>
</tbody>
</table>
2. Click **Configure**. The Printer Configuration dialog appears. The dialog contains the printer ID summary, along with a printer-specific QR code.

**Note:** You can use the QR code to quickly locate and print to the printer using the PrinterOn Mobile apps.

3. Click on any section to expand the configuration options. See the following sections for details.
   - Defining the printer identification and location settings
   - Specifying printer driver information
   - Configuring the printer’s network location
   - Configuring printer-specific workflow options
   - Configuring user input labels
   - Configuring print job and user information
   - Configuring print release settings
   - Configuring finishing options
   - Configuring paper sizes
   - Configuring print service pricing
   - Configuring authorization settings (Enterprise Edition only)

4. When you have finished modifying the printer configuration, click **Apply Settings**.
3.3.1 Defining the printer identification and location settings

The Printer Configuration settings define basic identification and location information for the printer. This information is displayed to users and can be used to search for and locate destination printers.

3.3.1.1 Printer Configuration settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Printer Description| A descriptive label that describes the printer to users. The value should be unique and descriptive.  
**Note:** PrinterOn does not enforce uniqueness on this value, but recommends that you set this value to a simple and easy-to-understand label for the printer. |
| PrinterOn Name     | A unique printer queue name used throughout the software to both identify and organize printers.  
This value is combined with the email domain to create the email address for the printer, to which users can email print jobs. For example:  
warehouse-printer-1@emailprint.com |
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department</td>
<td>The Printer Department to which the printer belongs. The drop-down list only lists existing departments. For information about creating departments, see Managing printer departments.</td>
</tr>
<tr>
<td>Default Printer Language</td>
<td>The default language for the printer, which the server uses to respond to email print jobs.</td>
</tr>
<tr>
<td>Address, City, State/Province, Country Code, Postal Code</td>
<td>The physical address for the printer. Mobile app users looking for a PrinterOn enabled printer can search on any value of the address to locate a printer. The mobile app also displays the address in the Printer Details.</td>
</tr>
<tr>
<td>Latitude, Longitude</td>
<td>The GPS coordinates for the location of the printer. The GPS coordinates are used to display the printer location on a map when users attempt to locate a printer using the PrinterOn Mobile app.</td>
</tr>
<tr>
<td>External ID</td>
<td>The external ID for this printer. When integrating with Samsung embedded agents or software, <strong>External ID</strong> specifies the MAC address of the printer.</td>
</tr>
</tbody>
</table>
3.3.2 Specifying printer driver information

The Printer Driver settings define the printer driver used by the PrinterOn Server to convert documents for the destination printer.

PrinterOn includes a number of print drivers with the server installation that provide basic support for many common printers, including PCL, Postscript and XPS print output.

3.3.2.1 Printer Driver settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer Driver</td>
<td>The printer driver that the PrinterOn Server uses to process any jobs sent to the printer.</td>
</tr>
<tr>
<td></td>
<td>Printer drivers are sorted by manufacturer. First, select the printer driver manufacturer from the upper list, then select the printer driver from the lower list.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: If multiple servers are being used for document processing, ensure that the same driver is installed on all servers.</td>
</tr>
<tr>
<td>Model</td>
<td>Printer driver information that is presented to the user when viewing printer details. This value does not need to match the actual printer model.</td>
</tr>
<tr>
<td>Printer Model Name</td>
<td>The printer model name. This field is only used when you specified Samsung as the Printer Driver manufacturer and Samsung Universal EMU V2 as the printer driver, and allows the PrinterOn to optimize output for specific Samsung printer models.</td>
</tr>
<tr>
<td></td>
<td>If you don’t know the specific model, select <strong>UnsupportedMono</strong> or <strong>UnsupportedColor</strong>.</td>
</tr>
</tbody>
</table>
3.3.3 Configuring the printer’s network location

The Output Location settings allow you to specify the network location of the printer to which the PDS directs print jobs and how the server delivers print jobs to this printer (directly to a PDS, or to a PDH). You can also specify whether the printer is an IPP printer that bypasses the PDS.

3.3.3.1 Output Location settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Printer is an IPP Printer| When checked, indicates that the printer supports the IPP protocol. When you enable this setting, the remaining settings change to simplify the configuration.  
  Note: When Printer is an IPP printer is enabled, the remaining Output Location settings are disabled and set to Direct Printing Only, which indicates that jobs are sent directly to the printer. This setting is not configurable. |
| Printer Address          | The IP address and port for an IPP printer.                                 |
| Attach Printer To        | Links the printer with a Print Delivery Station. This field is only displayed only when Printer is an IPP Printer is disabled.  
  Note: You can also configure this setting for printers with an embedded PDS in the Link Printers dialog. For more information, see Linking printers with a Print Delivery Station. |
### Setting Description

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Destination</td>
<td>Defines the physical printer, print queue, or file to which the PrinterOn printer directs print jobs. You must define the Output Destination for the PrinterOn Server to communicate with your physical printers, or with a print queue. For detailed information about defining the output destination, see Configuring Printer Output Destinations.</td>
</tr>
<tr>
<td>Allow Printing Directly to PDS</td>
<td>When checked, indicates that print jobs are sent to the PDS server. Note: Only select this option if the PDS is accessible from the main server. In some cases, print jobs can only be delivered to a PDS using an intermediate Print Delivery Hub (PDH).</td>
</tr>
<tr>
<td>Server Address</td>
<td>The fully qualified network address of the Print Delivery Station server. Select a scheme to indicate whether SSL will be used. Usually this is simply the local server. Indicating an explicit port along with the server address can improve print performance. The server automatically selects the port, if specified. Otherwise, it scans ports 80, 443, and 631, as well as SSL and non-SSL connections, which can slow delivery. Note: This field is only displayed when Allow Printing Directly to PDS is selected.</td>
</tr>
<tr>
<td>Print Directly to PDS Only</td>
<td>When checked, all print jobs are printed directly to the PDS, and are not sent to a PDH. This setting only applies if a PDH is available. In most cases, you should enable this setting.</td>
</tr>
<tr>
<td>Use an Alternate/Local Print Delivery Hub to Host Print Jobs</td>
<td>When checked, indicates that a Print Delivery Hub server is available for printing. This option should be specified if a PDS is accessible directly by the server. In some cases, this option may be used if multiple PDS servers are deployed for the same printer, for redundancy. Configuring both a PDS and PDH server can assist desktop printing using PrintWhere for roaming users who may move between networks regularly and cannot always contact PDS.</td>
</tr>
<tr>
<td>Server Address</td>
<td>The fully qualified network address of the Print Delivery Hub server. Select a scheme to indicate whether SSL will be used. Indicating an explicit port along with the server address can improve print performance. The server automatically selects the port, if specified. Otherwise, it scans ports 80, 443, and 631, as well as SSL and non-SSL connections, which can slow delivery. Note: This field is only displayed when Use an Alternate/Local Print Delivery Hub to Host Print Jobs is selected.</td>
</tr>
</tbody>
</table>
### 3.3.4 Configuring printer-specific workflow options

The **Workflow Options** panel allows you to configure which methods users can use to print to the individual print queue, as well as some other printer-specific workflow settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Web Printing</td>
<td>When checked, the <strong>Web Print workflow</strong> is enabled for this printer, allowing users to open their browser to the Web Print portal to upload a document for printing.</td>
</tr>
<tr>
<td>Enable PrintWhere Printing</td>
<td>When checked, the <strong>PQMS workflow</strong> is enabled for this printer, allowing users to print from the Windows queue using PrintWhere.</td>
</tr>
<tr>
<td>Enable Document API Printing</td>
<td>When checked, workflows including <strong>Mobile workflow</strong>, <strong>Google Cloud Print workflow</strong>, and <strong>iOS Native Print workflow</strong> are enabled for this printer.</td>
</tr>
<tr>
<td>Email Domain</td>
<td>The email domain that should be appended to the printer name when advertising email print addresses to users.</td>
</tr>
<tr>
<td>Enable Email Printing</td>
<td>When checked, the <strong>Email Print workflow</strong> is enabled for this printer. If disabled, users receive a message indicating the service is disabled.</td>
</tr>
<tr>
<td>Print Body of the Email</td>
<td>When checked, the body of an email is printed when receiving email print jobs. If disabled, only attachments are printed.</td>
</tr>
<tr>
<td>One Release Code for All Attachments</td>
<td>When checked, a single release code is provided to users when submitting email print jobs with multiple attachments. This setting is only used when release codes are enabled.</td>
</tr>
</tbody>
</table>

If using embedded solutions such as the Ricoh HotSpot embedded with touch panel screens, where jobs may be individually selected at release time, you can enable this setting.
3.3.5 Configuring user input labels

User Input Labels are used to information from users when printing. If the server requires additional user input, such as user credentials or a release code, before it can proceed with the print job, it displays a form to the user. The User Input labels define the text displayed in the form.

The Labels settings also supports multiple languages; you can customize labels for each language you support.

**Note:** The Labels settings are displayed in Advanced view only.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label Language</td>
<td>Specifies for which language the settings below are displayed. Select the language, then define the labels for that language.</td>
</tr>
<tr>
<td>User Identifier</td>
<td>The text displayed to request the user’s name.</td>
</tr>
<tr>
<td>Client UID</td>
<td>Reserved for some custom integrations.</td>
</tr>
<tr>
<td>Session Meta Data</td>
<td>Reserved for some custom integrations.</td>
</tr>
<tr>
<td>Privacy Release Code</td>
<td>The text displayed to request the user’s release code.</td>
</tr>
</tbody>
</table>
3.3.6 Configuring print job and user information

Print jobs sent from the server may require additional information used to identify the sender. The Job and User Information allows you to control how your server will collect and use this information. This information is usually reserved for specific 3rd party integrations.

### 3.3.6.1 Job and User Information settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Identifier</td>
<td>When selected, the user is asked to provide Job Owner information that will be included with a print job.</td>
</tr>
<tr>
<td>Client UID (Advanced view only)</td>
<td>Used in combination with custom integrations of third-party solutions to request user information. When the adjacent Secured check box is enabled, the server does not save the Client UID.</td>
</tr>
<tr>
<td>Session Meta Data (Advanced view only)</td>
<td>Used in combination with custom integrations of third-party solutions to request user information. When the adjacent Secured check box is enabled, the server does not save the session metadata.</td>
</tr>
</tbody>
</table>
3.3.7 Configuring print release settings

The Release Print Jobs settings define how jobs will be managed after printing. The Release settings are divided into basic settings for the PrinterOn solution, and Third-party integration settings required for integration of third-party print/output management solutions.

Note: The third-party integration settings are displayed in Advanced view only.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Release Print Jobs</td>
<td>How print jobs are released. There are two options:</td>
</tr>
<tr>
<td></td>
<td>- Automatically when they arrive: When selected, print jobs are automatically released to the printer or print queues without being held. When integrating with most print/output management solutions, you should select this option.</td>
</tr>
<tr>
<td></td>
<td>- Using a PrinterOn Solution or HotSpot printer: Print jobs are released using a PrinterOn solution. Users must supply a Release Code or other identifying information to access their print jobs.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Privacy Release Code</td>
<td>Indicates if users must provide a release code to retrieve their print jobs. You should typically set this value to <strong>Required</strong> or <strong>Optional</strong> when using a PrinterOn Print Valet or embedded agent that supports entering a release code.</td>
</tr>
<tr>
<td>Always use numbered release codes <em>(Advanced view only)</em></td>
<td>When checked, generated Release Codes contain only numbers.</td>
</tr>
<tr>
<td></td>
<td>Available only when <strong>Privacy Release Code</strong> is set to <strong>Required</strong> or <strong>Optional</strong>.</td>
</tr>
<tr>
<td>Auto-generate release codes</td>
<td>When checked, the server creates unique Release Codes for jobs and supplies them to the user.</td>
</tr>
<tr>
<td><em>(Advanced view only)</em></td>
<td>Available only when <strong>Privacy Release Code</strong> is set to <strong>Required</strong> or <strong>Optional</strong>.</td>
</tr>
<tr>
<td>Enable Remote Job Release</td>
<td>When checked, indicates that Secure Remote Release is enabled for this printer, allowing users release print jobs without being present at the printer. Remote job release is supported by the Web, Mobile, and Email Print workflows.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: Secure Remote Release requires specific printer, PDS, and workflow settings to be properly configured. For complete step-by-step instructions on setting up this feature for a printer, see Managing printer departments.</td>
</tr>
</tbody>
</table>
### 3.3.7.2 Third-Party Integration settings

**Note:** The third-party integration settings are displayed in *Advanced view* only.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable 3rd Part Integration</td>
<td>When checked, lets you set the following settings to define release settings for your third-party Print Management Integrations:</td>
</tr>
<tr>
<td>Print Management Integration</td>
<td>When Enable 3rd Part Integration is enabled, defines the integration that is used with your PrinterOn Server.</td>
</tr>
<tr>
<td>Additional Integration Options</td>
<td>When Enable 3rd Part Integration is enabled, defines the additional integrations, if required by the selected <strong>Print Management Integration</strong>. In some cases, multiple integrations need to be combined to provide a final workflow.</td>
</tr>
<tr>
<td>Enable Advanced Integration Features</td>
<td>When Enable 3rd Part Integration is enabled, defines whether customized delivery of information is enabled. Please consult with your integration partner to determine if you should set this option.</td>
</tr>
<tr>
<td>Note:</td>
<td>Enabling this option when not required will result in incorrect job information being transmitted to the integration.</td>
</tr>
<tr>
<td>Enable Printer Based Authorization Integration</td>
<td>When Enable 3rd Part Integration is enabled, defines whether the PrinterOn Server supports printer-based authorization of jobs.</td>
</tr>
<tr>
<td>Inject a PJL Header container if none exists</td>
<td>When checked, the PrinterOn Server injects a PJL header into the print job. Many printers and print/output management solutions use PJL headers to collect job information. Some print drivers do not automatically include these PJL headers. If you encounter issues with your integration, enabling this option may be required.</td>
</tr>
<tr>
<td>Manage PJL headers for Passthrough Jobs</td>
<td>When checked, the PrinterOn Server modifies PJL headers. PrinterOn is able deliver print jobs from 3rd party systems through the print service. In some cases, those jobs may be pre-rendered data that contains PJL headers. This setting allows the PrinterOn server to process and modify these headers as necessary to prevent jobs from failing.</td>
</tr>
</tbody>
</table>
3.3.8 Configuring finishing options

The Finishing Options settings allow you to configure what finishing options are supported, and set additional limits or default behavior.

### 3.3.8.1 Finishing Options settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include a Cover Page with print jobs</td>
<td>When checked, a cover page is added to each print job, identifying the sender and the time the job was submitted.</td>
</tr>
<tr>
<td>Use Document Conversion</td>
<td>When checked, the PrinterOn Server attempts to convert the document into an electronic presentation format such as XPS, rather than render it for printing. Any web links in the original document are preserved and functional in the converted file.</td>
</tr>
</tbody>
</table>

Currently, PrinterOn only converts Microsoft Office formats (.pptx, .docx, and .xlsx). The only output format supported is XPS.

Notes:

- To support document conversion, Microsoft Office must be installed on the same machine as the PrinterOn Server.
- To convert documents, you must specify the XPS Driver in the **Printer Driver settings**.
### Print Embedded Documents

When checked, the PrinterOn Server will attempt to extract and print any documents that are embedded in the original document.

**Notes:**

- Currently, the PrinterOn Server only supports printing of documents that are embedded in PowerPoint (.ppt, .pptx) documents.
- Only documents embedded in the master document are printed. If an embedded document itself contains embedded documents, those documents are ignored.

### Color Printing

Defines whether color printing is supported. This setting allows users searching for printers to limit their search to those printers that support color.

If you have a color printer but wish to discourage users from printing in color, select **Does not support color**.

### Copy Management

Specifies how print copies are managed when the user has chosen to print multiple copies of a document.

You can choose from the following options:

- **Application-based:** The source application for the document determines how to manage print copies. Typically with application-based copy management, the document print data is simply sent to the printer once for each copy specified. Because multiple copies of the document data are sent to the printer, this option can result in large print data streams. This is the default setting.

- **PJL-based:** Some printers and MFPs support managing print copies through PJL headers instead of in the print data stream itself. If the printer connected to the queue supports PJL-based copy management, choosing this option can reduce print data size when multiple copies are printed.

- **Driver-based:** The printer driver determines how to manage print copies based on the capabilities of the printer. If the driver can determine that the printer supports PJL headers and that it has a hard disk, it will use the PJL header to specify the number of copies to print. Otherwise, the document print data is sent to the printer the specified number of times.
3.3.9 Configuring paper sizes

You can configure which paper sizes are available for the printer and manage what paper-selection options the user can choose when they print.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Duplexing Type</strong></td>
<td>Defines the duplexing configuration.</td>
</tr>
<tr>
<td></td>
<td>If you prefer to let the printer control duplexing, select Not Managed.</td>
</tr>
<tr>
<td><strong>Maximum Page Count</strong></td>
<td>The maximum number of pages a print job may use. Print requests exceeding this limit will be accepted. The maximum page count includes the cover page.</td>
</tr>
<tr>
<td><strong>Maximum Printed Size</strong></td>
<td>The maximum data size of a print job. Print requests exceeding this limit will be accepted.</td>
</tr>
<tr>
<td><strong>N-Up Supported</strong></td>
<td>Defines whether multi-page layouts, in which multiple pages are printed on a single sheet of paper, are supported.</td>
</tr>
<tr>
<td><strong>PJL Encoding (Advanced view only)</strong></td>
<td>Specifies the Printer Job Language encoding. If your printer needs to support double byte characters, set this to UTF-8. and check Override Encoding Specification.</td>
</tr>
</tbody>
</table>

3.3.9.1 Paper Sizes settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search</td>
<td>Lets you search a specific paper size. Enter a partial paper size to filter results.</td>
</tr>
<tr>
<td>Supported</td>
<td>When checked, the adjacent paper size is supported by the printer. You cannot disable this setting for the default paper size.</td>
</tr>
</tbody>
</table>
### 3.3.10 Configuring print service pricing

The Printing Prices settings configure pricing information and behavior when charging for print services.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make Default</td>
<td>When clicked, the adjacent paper size is used as the default paper size for the printer. When a user prints to this printer, this paper size is selected by default in all print workflows.</td>
</tr>
</tbody>
</table>

#### 3.3.10.1 Printing Prices settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Charge for Print</td>
<td>When checked, users are charged a fee for each print job sent to this printer. When you enable this setting, additional settings appear, letting you define the specific payment details, such as currency, cost per page, and others.</td>
</tr>
</tbody>
</table>
### 3.3.11 Configuring authorization settings (Enterprise Edition only)

The Authorizing Users settings configure an authentication loop to ensure that users have been authenticated and are authorized to print before the job is released to the printer. The user is redirected to a specified URL to provide the necessary credentials before they can continue.

#### 3.3.11.1 Authorizing Users settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requires Authentication to Print</td>
<td>When checked, users are prompted for their credentials when scanning the QR code via the PrinterOn mobile apps.</td>
</tr>
<tr>
<td>User Authentication URL</td>
<td>When checked, users are redirected to the URL specified in the adjacent field for authentication.</td>
</tr>
<tr>
<td>Web Authorize URL</td>
<td>When checked, users are redirected to the URL specified in the adjacent field for authorization to use Web Print job submission.</td>
</tr>
<tr>
<td>Mobile Authorize URL</td>
<td>When checked, users are redirected to the URL specified in the adjacent field for authorization to use Mobile Print job submission.</td>
</tr>
<tr>
<td>Security Protocol</td>
<td>The level of security that must be passed before PrinterOn continues to process the print job. The value can be one of:</td>
</tr>
<tr>
<td></td>
<td>• <strong>ClearText:</strong> Basic validation. PrinterOn only checks to determine that the user has been authorized/approved to print using the selected workflow.</td>
</tr>
<tr>
<td></td>
<td>• <strong>MD5:</strong> Increased validation. PrinterOn checks that the user is authorized/approved to print, and checks for an MD5-based security token, which must also be validated before printing can continue.</td>
</tr>
</tbody>
</table>
3.4 Configuring Printer Output Destinations

The Output Destination setting defines the physical printer, print queue, or file to which the PrinterOn printer directs print jobs. You must define the Output Destination for the PrinterOn Server to communicate with your physical printers, or with a print queue. The Output Destination is defined in the Output Location settings panel of the Printer Configuration dialog.

The following table outlines how to define the Output Destination.

<table>
<thead>
<tr>
<th>If your printer...</th>
<th>Then use this scheme:</th>
<th>And define the destination as follows:</th>
<th>Examples</th>
</tr>
</thead>
</table>
| Connects directly to the PDS computer | local://              | Click Map and select the correct printer from the list, OR enter the printer name in the text field. | local://Samsung X3186  
local://HP LaserJet 4000 Series |
| Connects to the printer via a network or print spooler | share://              | Click Map Network and select the correct printer from the list, OR enter the share name in the text field. | share://printer_server/my_share  
share://192.168.1.2/my_share |
| Can be reached directly by its IP address | tcp://                | Enter the IP address and optionally, the port. | tcp://172.16.1.1:9100  
raw://172.16.1.1:9100 |
| Supports the IPP protocol           | ipp://                | Enter the IP address or URI of the printer followed by the printer queue.  
If your printer supports SSL, use the https:// or ipps:// schema. | ipp://172.16.1.1/ipp/port1  
ipp://172.16.1.1/ipp/port1  
https://172.16.1.1/ipp/port1 |
| Supports the LPR protocol           | lpr://                | Enter the IP address or URI of the printer. | lpr://172.16.1.1 |
| Outputs print jobs to file          | file://               | Enter the folder to save the printed jobs. | file://C:\Documents\printjobs |
3.5 Managing and configuring Print Delivery Stations (PDS)

PrinterOn supports a wide range of deployment options. In many cases a single release station, referred to by PrinterOn as the Print Delivery Station, is all that is required. In some deployments, multiple Print Delivery Stations will be used to distribute printers, provide redundancy, or connect printers in remote locations.

**Note:** This option only applies to On-Premise Deployments.

3.5.1 Adding Print Delivery Stations

The PrinterOn Server supports unlimited PDS instances. Generally each PDS links to a list of printers for which it will receive jobs. The association between the PDS and its printers is done using a unique ID referred to as a Serial Number. Each PDS instance receives a Serial Number and Label to help identify it.

To add a PDS:
1. Click **Home > Serial Numbers**.
2. Scroll to the bottom of the page and click **Add Print Delivery Station**.
3. In the Add Print Delivery Station dialog, enter the **Server Description** for the PDS. The server description is used to identify the PDS, so it should be meaningful.

4. Click **Add**.

### 3.5.2 Configuring the Print Delivery Station software

To configure a Print Delivery Station:

1. In the Configuration Manager, click **Printers > Servers**. The Servers tab appears.

2. In the **Print Delivery Software** panel, select the PDS that you want to configure. If necessary, you can search a specific PDS instance using the **Search** field.
3. In the **Configure Software** panel, select the **PDS Type**. You can choose:
   - **Software-Based**: Indicates that the PDS is a stand alone component installed on a server.
   - **Ricoh Hotspot**: Indicates that the PDS that is embedded within a Ricoh printer or MFP.

   **Note**: If the PDS Type is a Ricoh HotSpot that will serve as a PDS agent for multiple devices, you must define the device as a host. For more information, see *Editing the printer network destination for an embedded PDS agent*.

Each PDS Type has its own configuration requirements. The PDS Type you select determines which configuration settings appear in the panel.

4. Configure the remaining **Configure Software settings** as necessary.

5. To configure which printers to associate with the selected PDS, click **Link Printers**. For more information, see *Linking printers with a Print Delivery Station*.

6. Click **Save** to save the PDS configuration.
### 3.5.2.1 Configure Software settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Serial Number</strong></td>
<td>The serial number supplied by PrinterOn for this PDS instance. Each PDS instance that you add, regardless of type, is assigned a unique PrinterOn serial number. This value may be useful when configuring a software-based PDS installation to assist in identifying the specific instance.</td>
</tr>
</tbody>
</table>
| **PDS Type**    | The type of Print Connector used for this PDS instance. Select the PDS type that is appropriate for your deployment. Options include:  
  - **Software-Based**: A PDS instance installed on a network server.  
  - **Ricoh Hotspot**: A PDS instance that is embedded in a Ricoh device.  
  
  Each PDS Type has its own configuration requirements. The PDS Type you select determines which configuration settings appear in the panel.  
  
  **Note**: If the PDS Type is a Ricoh HotSpot that will serve as a PDS agent for multiple devices, you must define the device as a host. For more information, see [Editing the printer network destination for an embedded PDS agent](#). |
| **Description** | A description of the Print Connector to help you differentiate it from other PDS or HotSpot printers in a deployment. The description is a searchable value. |
| **Machine ID**  | The serial number or machine identifier of the physical printer or MFP. PrinterOn uses this value to validate the license and connect to the physical printer/MFP.  
  
  **(Embedded PDS only)** |
| **PDH URI**     | The fully qualified domain name of the Print Delivery Hub (PDH) server used by the embedded PDS to locate and download new print jobs.  
  
  The URI should include the URL scheme (http:// or https://) and the port that is configured for the server. When using SSL, the server must be configured with a fully qualified SSL certificate.  
  
  This value is downloaded by the software during initialization, which provides an easy way to pre-configure or modify the configuration of the software without interacting with the physical device.  
  
  **Note**: Set this value only if you are integrating your embedded PDS with a Print Delivery Hub.  
  
  **(Embedded PDS only)** |
Managing and configuring PrinterOn printers

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PDH Password</strong></td>
<td>The password required to connect to the PDH server located at the PDH URI. This password is configured in the PDH server software and must be supplied by the PDH server administrator.</td>
</tr>
<tr>
<td><strong>Check Jobs URI</strong></td>
<td>The fully qualified domain name of the URI that this PDS instance polls to determine if new print jobs are available. Communication with this URI is very lightweight. No job data is communicated via this URI. All communication of Job data occurs via the PDH URI. The URI should include the URL scheme (http:// or https://) and the port (typically a non-SSL port, such as port 80) configured for the server. <strong>Note:</strong> If using SSL with a Ricoh HotSpot, the server must be configured with a fully qualified SSL certificate. Due to compatibility challenges with the Ricoh SDK/J platform, self-signed certificates are not supported. Use the scheme to determine whether SSL is enabled or not.</td>
</tr>
<tr>
<td><strong>Check Jobs Interval</strong></td>
<td>How often the software should perform a Check Job operation to locate new jobs. The minimum time interval is 1 minute. Software versions that support PrinterOn's Push Notification do not use this value, and instead rely on the push notification technology. However, this value is still used when the software cannot establish a successful notification connection and must revert to polling.</td>
</tr>
<tr>
<td><strong>Push Notification Timeout</strong></td>
<td>The length of time before push notifications time out and are considered expired. Only used when the software versions supports PrinterOn's Push Notifications.</td>
</tr>
<tr>
<td><strong>Status Check Interval</strong></td>
<td>How often the software should check the status of the current print job.</td>
</tr>
<tr>
<td><strong>Override Settings</strong></td>
<td>Used by desktop PDS deployments to indicate if output destinations should be overridden by online settings if local settings have been made. <strong>Note:</strong> If you intend to import printers using a CSV file but want to set the printer's output destination in the PDS, you must enable this setting.</td>
</tr>
</tbody>
</table>
### Setting | Description

**Pull Mode**  
How jobs are handled after being delivered to the Print Delivery Hub. The value can be one of:

- **Local Download**: Indicates that jobs should be download locally to the PDS. Jobs are also kept on the PDH after download.

- **Central Store**: Indicates jobs should not be automatically downloaded to the PDS; they are held on the Print Delivery Hub and downloaded on demand.

**Post Print Option**  
How jobs should be handled after being printed by the software on the printer/MFP. The value can be one of:

- **Delete from Store**: Indicates that jobs should be deleted from the PDH after the user request the jobs are printed

- **None**: Indicates that jobs should be left on the PDH after printing. Jobs will be purged automatically by PDH after its configured time.

**API Token (Embedded PDS only)**  
A security token used by the embedded PDS software on the agent to secure communication with PrinterOn Enterprise or PrinterOn Express. This value can be retrieved from the PrinterOn Configuration Manager and copied to this location to be downloaded and used by the software.

**Enable Card Authentication (Ricoh HotSpot only)**  
When selected, the HotSpot software should look for and use a card reader for authentication information.  
**Note**: This setting is only available if you have Ricoh Card Authentication Package enabled for your PrinterOn service.

**Bypass User Login Page for Cards (Ricoh HotSpot only)**  
When selected, and **Enable Card Authentication** is also selected, the HotSpot software skips the Login page.  
**Note**: This setting is only available if you have Ricoh Card Authentication Package enabled for your PrinterOn service.
## User Authentication Workflow *(Ricoh HotSpot only)*

Indicates how the Ricoh Hotspot App determines what screen should initially be displayed to the user.

You can select one of the following four values:

- **Automatically Choose Workflow**: The HotSpot determines the most appropriate screen to display, based on the other configuration settings.

- **Always Display Home Screen**: The HotSpot always displays two options to the user: **User Login**, which takes them to the User Login Page; and **Release Code**, which takes them to the Release Code Page.

- **Always Display User Login**: The HotSpot displays the User Login Page.


**Note**: If you have a hybrid deployment, you need configure your printer settings on the PrinterOn.com web admin portal to enable authentication:

2. Click the **Printers** icon.
3. Locate the printer listing for the MFP with the Ricoh HotSpot embedded software, then click **Payment and Authentication**.
4. In the **Authorizing Users** section of the Payment and Authentication page, enable **Requires Authentication to Print**, then save your changes.

## Remote Queue Monitor URI

The URL and port used by CPS to communicate with the PDS to display the remote queue monitor, which is used to remotely release a print job to the printer.

Defining this URI simplifies remote release for users by allowing them to access a central URL hosted by the PrinterOn Server to release their print jobs remotely, instead of requiring them to connect directly to the PDS host machine.

By default, this URI is set to https://127.0.0.1:8181, which points to the local machine hosting the PrinterOn Server.
3.0.1 Linking printers with a Print Delivery Station

The **Link Printers** button provides a simple way to connect printers to Print Delivery Stations with simple drag and drop actions.

To link a printer with a PDS:

1. Click **Printers > Servers**.
2. In the **Print Delivery Software** panel, select the PDS that you want to configure. If necessary, you can search a specific PDS instance using the **Search** field.
3. In the **Configure Software** panel, select **Link Printers**.

4. Link the printers to the PDS by moving them from the **Available Printers** list to the **Linked Printers** list:
   a) Select one or more printers from the **Available Printers** list.
   b) Drag the printers to the **Linked Printers** list, or click the arrow.
5. To unlink printers from the PDS:
   a) Select one or more printers from the **Linked Printers** list.
   b) Drag the printers to the **Available Printers** list, or click the arrow.
6. To edit the printer connection settings, click **Edit**. For more information, see **Editing the printer network destination for an embedded PDS agent**.
7. Click **Apply Settings**.

**Note**: A printer can only be linked with a single PDS. Linking a printer to a PDS automatically unlinks it from any other PDS instance.
3.0.2 Editing the printer network destination for an embedded PDS agent

When linking a printer to a PDS instance, you can edit the individual printers linked with that PDS to define a network destination for the device. The Edit Printer dialog also allows you to specify whether the device is a Ricoh device with an embedded PDS agent that will serve other devices.

**Note:** The Edit Printer button only appears if the selected PDS is an embedded PDS agent, such as a Ricoh HotSpot.

To edit printer connection settings:

1. In the Link Printers dialog, select the printer you want to configure and click **Edit Printer**. The Edit printer dialog appears.

2. **Configure the following settings as necessary:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Local IP Address</strong></td>
<td>The local IP address of the printer.</td>
</tr>
<tr>
<td><strong>Port</strong></td>
<td>The port the printer uses for communication.</td>
</tr>
<tr>
<td><strong>Host</strong> (Embedded PDS only)</td>
<td>When enabled, indicates that the device has an embedded PDS agent that serves other devices.</td>
</tr>
</tbody>
</table>

3. Click **Apply Settings**.

3.0.3 Installing and configuring a remote PDS

Having a PDS on a different machine than the PrinterOn server is a common deployment scenario. You may need to install a PDS together with a PDH on a server that’s located on a different network, or you might need to embed a PDS on a printer or MFP.
3.0.3.1 Before you begin

Before you install a remote PDS, you’ll need to complete the following tasks:

1. **Add a new PDS instance to your PrinterOn server.** This creates a new PDS serial number. When you install the PDS on the remote server, you’ll choose this serial number, which links the configuration settings to the PDS component.

2. **Configure the PDS instance as necessary.** Ensure that you select the PDS you just created in Step 1.

3. **Link printers to your new PDS instance.**

4. **Configure each linked printer as necessary.** Because the PDS is on a different machine, at minimum, you’ll need to configure **Server Address** in the Print Delivery settings to properly define the IP address of the machine that is hosting the new PDS.

5. **Ensure that the Internal Service URI value is correctly configured.** The Internal Service URI is used by the subcomponents to communicate with the Central Print Services in a distributed deployment.

6. **Download your license file** on the parent PrinterOn server and copy it to the remote server that will host the PDS.

3.0.3.2 Installing the PDS on a remote server

Once you have complete the configuration steps above, you can install the PDS component on the remote server.

To install a remote PDS:

1. **Run PSIM.exe** to launch the PrinterOn Installation Wizard. The wizard guides you through the installation of the PrinterOn software. You can download the PSIM.exe from printeron.com.

2. **Click Next** at the Welcome screen, then accept the License Agreement to proceed with the installation.

3. On the License Summary File screen, browse to your PrinterOn license file and select it, then click Next.
4. On the Setup Type screen, choose **Custom**, then click **Next**.

5. In the Select Features screen, select only **Print Delivery Station**, then click **Next**.

6. On the Serial Numbers screen, select the serial number for the PDS instance you are installing on the remote host, then click **Next** to install the PDS.
7. When the installation is complete, click Finish, and then reboot the computer.
8. If you choose, you can connect this PDS to a parent configuration server. For more information, see Connecting remote servers to a parent Configuration Manager.

3.1 Enabling Secure Remote Release for printers

Secure Remote Release allows users to submit a release code to the printer remotely, from their mobile device or browser, instead of requiring them to type the release code in at the printer. Once the user releases the print job, the printer adds it to the print queue and prints it in sequence.

To set up Secure Remote Release, you’ll need to perform the following tasks:

1. Define the Remote Queue Monitor URI for each remote PDS.
2. Configure a printer to support Secure Remote Release.
3. Ensure that the PDS that services that printer uses SSL.

**Note:** If you intend to support Secure Remote Release with the Mobile Print workflow to allow users to release their jobs directly from their mobile devices, you’ll also need to ensure that the Document API URI is properly configured to point to the external service URI. For more information, see Configuring the Mobile Print workflow.

3.1.1 Defining the Remote Queue Monitor URI for each remote PDS

The Remote Queue Monitor URI is the URL through which the PrinterOn Server accesses the print job queue on a remote PDS. By default, the server is configured to point to port 8181 on the local host (127.0.0.1:8181). If the PDS is installed on a different server than the
Managing and configuring PrinterOn printers

PrinterOn Server, then you must configure this value to reflect the IP address of the PDS host computer.

Defining a Remote Queue Monitor URI allows users to connect to the PrinterOn server to release their print jobs remotely, instead of requiring them to connect directly to the PDS host machine.

To configure the Remote Queue Monitor for a printer:

1. In the Configuration Manager, click **Printers > Servers**.
2. In the Print Delivery Software panel, select the PDS instance you want to configure from the list of available Print Delivery Stations. The values in the Configure Software Panel change to reflect the selected PDS.
3. In the Configure Software panel, locate the **Remote Queue Monitor URI** field.
4. Enter the IP address of the machine hosting the remote PDS, and the port on which the PDS listens. By default, PDS listens on port 8181.
5. Click **Save**.

### 3.1.2 Configuring a printer to support Secure Remote Release

To configure the Secure Remote Release feature for a printer:

1. In the Configuration Manager, click **Printers**.
2. In the PrinterOn Printers list, click next to the printer that you want to configure to use the Secure Remote Release feature. The printer actions appear.

3. Click **Configure**.
4. In the Printer Configuration dialog, expand the **Releasing Print Jobs** settings and ensure that:
   - **Privacy Release Code** is set to **Optional** or **Required**.
   - **Enable Remote Release** is selected.

Expand the Print Delivery settings and ensure that:
- **Server Address** points to the IP address of the machine hosting the PDS instance that services the selected printer.
- **Server Address** uses the HTTPS scheme.

5. Click **Apply Settings**.

### 3.1.3 Ensuring that the PDS is configured to use SSL

To configure the PDS to use SSL:

1. In the Configuration Manager, click **Advanced > Components**.
2. Click the **Configure** button adjacent the **Print Delivery Station** component. The PDS component configuration appears.
3. Click **Listeners**, then locate the **Default IPP Port** and check **SSL**.

4. Click **Apply Settings**.
3.2 Managing printer departments

Printer departments are used by PrinterOn to organize printers into groups. These departments can be used in reports to determine usage of certain printers, but more importantly, printer departments can be used along with LDAP/AD Organization Units and AD Groups to create user rules that provide additional access control options, and limit groups of printers to existing user groups.

For more information about using printer departments to control user access, see Configuring user rules and printer access.

The PrinterOn Server provides a simple, drag & drop interface to manage and configure departments.

**Note:** Department management only applies to On-Premise Deployments.

3.2.1 Adding, removing, and editing departments

New Printer Departments can easily be added, and existing departments can be deleted or renamed using the Manage Departments dialog.

To manage your departments:

1. Select **Printers**.
2. Select **Manage Departments**.

![Manage Departments dialog](image-url)
3. Click **Add Department** to add a new department.

![Add Department](image)

4. Click **Printers** next to an existing department to modify the list of printers linked to the department. For more information, see Adding printers to a department.

5. Click **Edit** next to an existing department to modify its name.

6. Click **Delete** next to an existing department to remove it.

**Note:** Printers linked to the department will *not* be assigned to another department automatically.

### 3.2.2 Adding printers to a department

1. Select Printers.
2. Select **Manage Departments**.
3. Click the **Printers** button adjacent to the department you want to add printers to. The Link Printers dialog appears.

![Link Printers](image)

4. To add printers to a department:
   a) Select one or more printers from the **Available Printers** list.
   b) Drag the printers to the **Linked Printers** list, or click the arrow.

5. To remove printers from a department:
   a) Select one or more printers from the **Linked Printers** list.
   b) Drag the printers to the **Available Printers** list, or click the arrow.

6. Click **Apply Settings**.
3.3 Configuring multiple printers at once

To simplify adding and configuring printers for organizations with multiple printers, PrinterOn offers a couple of solutions:

- Copying template settings to multiple printers
- Configuring printers using configuration profiles
3.3.1 Copying template settings to multiple printers

The PrinterOn Configuration Manager allows you to copy settings across printers to quickly configuring multiple printers at once.

**Note:** To avoid performance issues, you should limit the copy operation to a maximum of 100 printers.

To copy settings, you must first configure at least one printer to use as a configuration template. You can then copy those settings to one or more additional printers in bulk. You can even choose which groups of settings you want to copy, allowing you to omit certain settings from the copy process.

To copy printer settings:

1. In the PrinterOn Printers list, click ‡ next to the printer that you want to use as the template configuration. The printer actions appear.

2. Click Copy. The Template page appears.

3. The Copy Settings are organized into groups. Select one or more groups of settings that you want to copy to other printers.
4. Select the printers to which you want to apply changes by moving them from the Available Printers to the Chosen Printers list.
5. Click Apply Settings.

3.3.2 Configuring printers using configuration profiles

To create and configure multiple PrinterOn printers at once, you can create a printer configuration profile and then import that file into the Configuration Manager. A configuration profile is a CSV text file that defines configuration properties of multiple printers. Configuration profiles simplify the printer creation and configuration process when you have a large number of printers. For information on creating a configuration profile, see

A printer configuration profile defines a number of settings, including:
- Printer Name
- Printer Description/Location Settings
- Print Workflows Options
- Print Driver Settings
- Printer Capabilities

To further simplify the process, you can use printer configuration profiles in conjunction with printer templates. For certain properties, if values are left blank, the server applies the value found in the specified template.

3.3.2.1 Importing a printer configuration profile into the Configuration Manager

To import a printer configuration profile:
1. In the Configuration Manager, click Printers. The Printers tab appears, displaying a list of currently available printers.
2. Click the **Import** icon.

3. Click **Browse** and locate the CSV Data Set file to import.

4. Click **Upload**.
   - Wait for the transaction to be processed. If there are no validation errors, the printers will be added or modified accordingly.

5. Verify the results by checking one or more printer settings.
Configuring Secure Release Anywhere pull printing

The PrinterOn solution supports pull printing through the Secure Release Anywhere feature. Pull printing simplifies printing for users; rather than require users to know the physical location of the specific printer they printed to, users simply print, then go to the nearest printer, enter their credentials or release code, and pull the job to that location to be printed.

PrinterOn’s Secure Release Anywhere supports a variety of printers, MFPs, and release stations, and can be configured to work with built-in browsers, keypads, or with PrinterOn’s Print Valet connected to single function printers.

To setup your PrinterOn Server to support Secure Release Anywhere, you need to perform the following tasks:

1. Add and configure your individual printers. Define the output destination to link the PrinterOn printer definition with a physical printer. For more information, see Managing and configuring PrinterOn printers.

2. Create one or more Secure Release Anywhere printer pools, and link the individual printers with a pool. For more information, see Creating and configuring Secure Release Anywhere pools.

3. Configure Secure Release Anywhere workflow options. For more information, see Configuring the Secure Release Anywhere workflow.

4. Set up your release stations to pull down print jobs. For more information, see Configuring Secure Release Anywhere release stations.
4.1 About Secure Release Anywhere

To implement pull printing, Secure Release Anywhere uses the concept of printer pools. A Secure Release Anywhere pool is a group of output destinations or printers. Each output destination is represented as a PrinterOn virtual printer in the PrinterOn solution.

To the user, a Secure Release Anywhere printer pool appears as just another printer; users print to a Secure Release Anywhere pool just as they would any printer.

Secure Release Anywhere pools have the following features:

- Secure Release Anywhere pools can be configured like any other printer. You can configure options such as descriptive information, color/B&W, duplex, and supported driver.

  **Note:**
  - The configuration you apply to the pool applies to every printer that is a member of that pool, regardless of the capabilities of the individual printer.
  - It is important to ensure that all printers in the pool can use the same driver and language. PrinterOn provides both generic PCL and Postscript drivers with the installation, which should work in most cases.

- Users can access Secure Release Anywhere Pools using any enabled PrinterOn workflow, including mobile apps, web print, Google Cloud Print, email, etc.
- Secure Release Anywhere pools are backwards compatible with existing PrinterOn apps and workflows. Once they have been configured and added to your solution, Secure Release Anywhere pools are available to all users.
- You can apply role-based access control to Secure Release Anywhere Pools, just as with regular printers.
- A single PrinterOn printer can be a member of multiple Secure Release Anywhere Pools.

4.1.1 Secure Release Anywhere deployment modes

Two deployment modes, Basic and Advanced, are provided to support different network requirements; each provides additional configuration options to further customize the options.
4.1.1.1 Basic Secure Release Anywhere

Basic Secure Release Anywhere is intended for networks where all servers and printers are accessible and can communicate on the same network.

Users may still submit using any print method and from any network. The PrinterOn server must be able to deliver jobs to printers on the same network.

4.1.1.2 Advanced Secure Release Anywhere

Advanced Secure Release Anywhere extends the support for pull printing beyond a single network and provides global access for users.

Using PrinterOn secure print delivery solution, jobs may be delivered between networks without requiring major changes to network configuration, opening ports between networks or a wide area network.

Using the PrinterOn Print Delivery Hub, jobs can be delivered to or made available to multiple networks automatically. Administrators can then decide the optimal deployment based on their specific needs.

This is useful when enabling Secure Release Anywhere Pools across multiple networks. It allows a copy of print jobs to be delivered to each network automatically and decreases
the time to complete the print. It also allows users to release their jobs in any network.

4.2 Creating and configuring Secure Release Anywhere pools

Before creating and configuring Secure Release Anywhere pools, ensure that all printer definitions are configured and their output destinations are defined.

**Note:** Ensure that the Release And Privacy mode for all printers is set to General Delivery to ensure jobs are correctly held.

Setting up your Secure Release Anywhere pools is a four-step process:

1. Add your pool.
2. Configure the pool settings.
3. Add printers to your pool.
4. Link the pool with a Print Delivery Station.

4.2.1 Adding a Secure Release Anywhere pool

To add a Secure Release Anywhere pool:

1. In the Configuration Manager, click **Printers > Secure Release Anywhere Pools**. The Secure Release Anywhere Pools list appears.
2. Click **Add Pool**. A new printer pool is added to the pool list.

You can now **configure the pool settings**.

### 4.2.2 Configuring the printer pool settings

The configuration settings that you apply to the Secure Release Anywhere pool apply to all printers that are members of the pool, regardless of their capabilities.

**Note:** It is important to ensure that all printers in the pool can use the same driver and language. PrinterOn provides both generic PCL and Postscript drivers with the installation, which should work in most cases.

To configure the printer pool settings:

1. In the Pools list, click next to the printer pool that you want to configure. The printer pool actions appear.

2. Click **Configure**. The Pool Configuration dialog appears.

3. Configure all settings. You configure the same settings for a printer pool as you do for an individual printer. For information on those settings, see **Configuring individual printer settings**.

4. Click **Apply Settings**.

You can now add printers to your pool.
4.2.3 Adding printers to a Secure Release Anywhere pool

Once a Secure Release Anywhere Pool has been created and configured, you can attach printers to the pool. Printers can be added to multiple Secure Release Anywhere pools.

To link printers to a Secure Release Anywhere pool.

1. In the Pools list, click next to the printer pool that you want to configure. The printer pool actions appear.

2. Click Manager Printer Pool.

3. Select one or more printers from the Available Printers column on the left.

4. Click the Right Arrow or drag and drop the printers to the Linked Printers column.

5. Click Apply Settings to complete the configuration.

You can now link the pool with a Print Delivery Station.

4.2.4 Link Secure Release Anywhere Pool to a Release Station (PDS)

In order for jobs to be delivered to a Print Delivery Station (PDS), the Secure Release Anywhere pool must be linked to one or more Print Delivery Stations.

A Secure Release Anywhere Pool MUST be associated with all Print Delivery Stations that will support release. Normally, any Print Delivery Station with a child printer should also have the Secure Release Anywhere Pool linked.

To link a pool with a PDS:

1. In the Configuration Manager, click Printers > Secure Release Anywhere Pools.

2. At the bottom of the Secure Release Anywhere Pools list, click Link Printers. The PDS Server dialog appears.
3. From the **Select PDS Server** drop-down, select the Print Delivery Station to which you want to link a Secure Release Anywhere pool.

4. Select the Secure Release Anywhere pool from the **Available Printers** column on the left.

5. Click the **Right Arrow** or drag and drop the printers to the **Linked Printers** column.

6. Click **Apply Settings**.

### 4.3 Configuring the Secure Release Anywhere workflow

PrinterOn’s Secure Release Anywhere solution may be configured to meet specific workflow and network requirements. This allows the administrator to configure behavior for job retention before and after printing, as well as configuring how jobs will be distributed throughout the network.
To configure the Secure Release Anywhere workflow:

1. In the Configuration Manager, click **Workflows > Secure Release Anywhere**.

2. From the **Secure Release Anywhere Mode** drop-down, choose which deployment workflow you are configuring.
   - **Basic**: All servers and printers are accessible and can communicate on the same network. For more information on this deployment, see **Basic Secure Release Anywhere**.
   - **Advanced**: Extends beyond a single network and provides global access for users. For more information on this deployment, see **Advanced Secure Release Anywhere**.

   The configuration panel for the selected mode appears.

3. Configure the workflow options as necessary,
   - **Configuring Basic Secure Release Anywhere**
   - **Advanced Secure Release Anywhere workflow options**

4. Click **Apply Settings**.
4.3.1 Configuring Basic Secure Release Anywhere

Selecting the Basic Secure Release Anywhere mode displays the Standard Release Anywhere Settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Unreleased Job Cleanup</td>
<td>When checked, the Print Delivery Station automatically deletes print jobs that have not been released by users. If this option is not selected, print jobs are never deleted.</td>
</tr>
<tr>
<td>Cleanup Unreleased Jobs After</td>
<td>The length of time that print jobs that have not been printed are held by the Print Delivery Station. This applies to all printers managed by the Print Delivery Station.</td>
</tr>
<tr>
<td>Cleanup Released Jobs After</td>
<td>The length of time (from the moment they were first printed) that printed jobs should be held by the Print Delivery Station.</td>
</tr>
</tbody>
</table>

**Note:** Jobs released by the user when Basic Secure Release Anywhere is enabled cannot be released to multiple printers in the pool.
4.3.2 Configuring Advanced Secure Release Anywhere

Selecting the Advanced Secure Release Anywhere mode displays the Advanced Release Anywhere Settings:

<table>
<thead>
<tr>
<th>Advanced Release Anywhere Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Delivery</td>
</tr>
<tr>
<td>Automatically Distribute Jobs</td>
</tr>
<tr>
<td>Delete Jobs From Hub After Printing</td>
</tr>
<tr>
<td>Job Handling</td>
</tr>
<tr>
<td>Enable Hub Job Cleanup</td>
</tr>
<tr>
<td>Cleanup Hub Jobs After</td>
</tr>
<tr>
<td>Enable Unreleased Job Cleanup</td>
</tr>
<tr>
<td>Cleanup Unreleased Jobs After</td>
</tr>
<tr>
<td>Cleanup Released Jobs After</td>
</tr>
</tbody>
</table>

4.3.2.1 Advanced Secure Release Anywhere workflow options

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically Distribute Jobs</td>
<td>When checked, print jobs should be automatically downloaded by all Print Delivery Stations linked to the Secure Release Anywhere pool. This option is useful when enabling a Secure Release Anywhere pool across multiple networks. It allows a copy of print jobs to be delivered to each network automatically and decreases the time to complete the print. It also allows users to release their jobs in any network. Note that although enabling this option increases network bandwidth, PrinterOn attempts to minimize the impact by compressing data during delivery.</td>
</tr>
<tr>
<td>Delete Jobs From Hub After Printing</td>
<td>When checked, the Print Delivery Station informs the Hub when the job is printed, and deletes the job from the central storage. The job cannot be downloaded to other release stations after printing. If you want jobs to be accessible and reprintable at multiple locations when jobs are NOT being distributed automatically, disable this option.</td>
</tr>
</tbody>
</table>
4.4 Configuring Secure Release Anywhere release stations

A Secure Release Anywhere release station is a printer that has been configured to accept input from the user to pull a print job to that device.

**Note:** A Secure Release Anywhere release station depends on communication with a Print Delivery Station to access and release print jobs.
PrinterOn’s solution supports using a variety of release station interfaces to support a range of devices:

<table>
<thead>
<tr>
<th>Release interface</th>
<th>Description</th>
</tr>
</thead>
</table>
| Web-based release                  | Many devices provide access to a web browser to allow users to pull their print job down to the device. The web release interface can be used by:  
  - MFPs with integrated web browsers  
  - Dedicated tablets  
  - User phones or tablets  
  - A Windows PC running a full Print Delivery Station  
  To configure web-based release, you’ll need to define the URL used to communicate with the PDS. For more information, see Formatting the Secure Release Anywhere URL for web-based release. |
| Samsung Smart UX printers and MFPs | Samsung Smart UX devices support web-based release. To improve the user experience, you can add a bookmark to the Secure Release Anywhere URL on the Home page.  
  For more information, see Bookmarking the Secure Release Anywhere URL for Samsung Smart UX. |
| Ricoh MFPs                         | Ricoh MFPs support web-based release. However, because browser capabilities and screen sizes vary across devices, you might need to customize the URL. To improve the user experience, you can also add a link to the Secure Release Anywhere URL on the Home page.  
  For more information, see Configuring the Ricoh device browser. |
| Brother BSI-enabled print devices  | Brother BSI-enabled devices support web-based release. However, these devices require a custom URL to receive Brother-specific content, and must be configured to provide a method of quickly accessing the URL.  
  For more information, Configuring a Brother BSI (local network) Secure Release Anywhere release station. |
| PrinterOn Print Valet              | You can attach the PrinterOn Print Valet to transform single-function printers and MFPs with no keypad or touch screen into network-based secure release code terminals.  
  To configure Print Valet, see Configuring the PrinterOn Network Print Valet. |
4.4.1 Formatting the Secure Release Anywhere URL for web-based release

Using PrinterOn’s Secure Release Anywhere solution, any device that includes a web browser can be used as a release station.

The Secure Release Anywhere Scheme is defined as follows:

```
http(s)://<PDS_IPAddress_or_DNS>:8181[/basic]/
printerNumber=<PON_printer_number>&num=<rows>&lang=<lang_code>
```

By formatting the URL used to communicate with a Print Delivery Station you can:

- Customize the Secure Release Anywhere landing page to link directly to the User Login or Privacy Release page. For more information, see Displaying a custom Secure Release Anywhere landing page.
- Specify where a job should be released. Normally a release station is deployed near the printer or MFP. In many cases, MFPs include browsers installed within the firmware or device platform. Using the browser, these devices can be used as Secure Release Anywhere release stations. For more information, see Specifying output printer information.
- Use a basic web interface compatible with older browser technologies that cannot support the default modern and responsive release interface. For more information, see Displaying basic mode content for limited browsers.
- Specify the number of job rows to be shown on the screen to support smaller touch panels. For more information, see Limiting the number of jobs displayed on small screens.
- Specify a default language when the page loads. For more information, see Specifying the display language.

4.4.1.1 Base URL Port and HTTP Scheme Information

The Secure Release Anywhere web release interface can be accessed using SSL or non-SSL. To enable non-SSL communication, disable the option under the Print Delivery Station Settings in the PrinterOn Configuration Manager.

If using SSL, by default, only port 8181 is SSL-enabled. The URL should be configured using https://.

For example:

```
```
4.4.1.2 Displaying a custom Secure Release Anywhere landing page

By default, accessing the Secure Release Anywhere web page loads a page from which users can select whether to release jobs using a Privacy Release Code or by Authenticating. If you don’t want users to have the option, you can link directly either the Privacy Release page or User Login page.

To access the Privacy Release page, add `/publicRelease.html` to the URL. For example:

publicRelease.html?printerNumber=900123322

Note: For screens with limited display space, you can add `/publicReleaseBasic.html` to the URL to display a basic version of the page.

To access the User Login page, add `/userLogin.html` to the URL. For example:


Note: For screens with limited display space, you can add `/userLoginBasic.html` to the URL to display a basic version of the page.
4.4.1.3 Specifying output printer information

It is important to associate the Secure Release Anywhere web interface with the printer where jobs should be delivered. This is done by including the PrinterOn printer number in the request.

When specified, the Print Delivery Station will use this value to lookup the printer on the server and direct the job to the output destination configured.

To specify the output printer, add the `printerNumber` parameter to the URL and specify the PrinterOn printer number. For example:

```plaintext
```

4.4.1.4 Displaying basic mode content for limited browsers

By default, the web release interface will use modern HTML technology including advanced CSS and JavaScript to provide an optimal experience. The server attempts to detect the capabilities of the browser to adapt the browser’s capabilities.

In some browsers, it is not possible to use full CSS and JavaScript functionality. In these browsers, you can display a Basic version of the interface that disables most advanced JavaScript and CSS.

The display the basic version, add `/basic` to the URLs. For example:

```plaintext
https://172.12.12.12:8181/basic
```

4.4.1.5 Limiting the number of jobs displayed on small screens

In some browsers and panels where the size of the screen is limited, you may need to limit the number of print job rows that are displayed on the screen. In most cases, using a value of 2 is recommended.

**Note:** This only applies when using the basic mode for the web interface.

You can specify the number of rows using the `num` parameter. For example:

```plaintext
```
4.4.1.6 Specifying the display language

By default, the Secure Release Anywhere web page will provide users with options to select their desired language. In some cases, it may be desirable to specify the language to show when loading the page.

You can specify the language using the `lang` parameter and supplying the language code. For example:

```
```

Supported languages include:

<table>
<thead>
<tr>
<th>Language</th>
<th>Code</th>
<th>Language</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td>en_us</td>
<td>Brazilian Portuguese</td>
<td>pt_br</td>
</tr>
<tr>
<td>French</td>
<td>fr_fr</td>
<td>Danish</td>
<td>da_dk</td>
</tr>
<tr>
<td>German</td>
<td>de_de</td>
<td>Korea</td>
<td>ko_kr</td>
</tr>
<tr>
<td>Dutch</td>
<td>nl_nl</td>
<td>Japanese</td>
<td>ja_jp</td>
</tr>
<tr>
<td>Italian</td>
<td>it_it</td>
<td>Simplified Chinese</td>
<td>zh_zn</td>
</tr>
<tr>
<td>Spanish</td>
<td>es_es</td>
<td>Traditional Chinese</td>
<td>zh_tw</td>
</tr>
</tbody>
</table>

4.4.2 Bookmarking the Secure Release Anywhere URL for Samsung Smart UX

Every Samsung printer or MFP that includes the Samsung Smart UX can configured to act as a Secure Release Anywhere release station. Smart UX includes a browser from which users can access the Secure Release Anywhere URL.

To simplify the pull process for users, you can create a bookmark for the URL and add it to the Home page, so that it is easily accessible.

To add a bookmark to the Secure Release Anywhere URL to the Home Screen:

1. On the Smart UX panel, launch the browser.
2. Navigate to the PrinterOn Secure Release Anywhere URL:
   ```html
   http(s)://<PDS_IPaddress_or_DNS>:8181?printerNumber=<9012012322>
   ```
3. Create a bookmark for the URL by clicking ⭐.
4. In the **Bookmark this Page** dialog, validate that the connection and printer information is correct.

5. Tap the **Add To** menu, then select **Home Screen**.
4.4.3 Configuring the Ricoh device browser

Every Ricoh MFP configured with a browser can act as a Secure Release Anywhere release station. Users can access the Secure Release Anywhere URL from the browser to release their print job to the device.

Because some Ricoh browsers are limited, or displayed on small screens, you might need to modify the URL so that the PDS sends device-appropriate content.

To simplify the process for users, you can create a link the URL and add it to the device Home page, so that it is easily accessible.

**Note:** The Ricoh device browser MUST be installed to support Secure Release Anywhere.

4.4.3.1 Configuring the Secure Release Anywhere URL

At the MFP:

1. Select **User Tools**.
2. Select **Browser Settings**.
   
   **Note:** On some devices, you might need to select Extended Feature Settings > Browser Settings.

3. Select **Browser Default Settings**.
4. Select **Bookmarks** or **Favorites**.
   
   **Note:** If required, select Common Favorites.

5. Select **New Program**.
6. Create a new URL using one of the following formats:

<table>
<thead>
<tr>
<th>Browser/screen size</th>
<th>URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full feature browser, 10&quot; panel</td>
<td>http(s)://&lt;IPaddressOrDNS&gt;:8181/?printerNumber=&lt;300/900122322&gt;</td>
</tr>
<tr>
<td>Basic browser</td>
<td>For browsers versions that do not support CSS or JavaScript, point to the basic Secure Release Anywhere page:</td>
</tr>
<tr>
<td></td>
<td>http(s)://&lt;IPaddressOrDNS&gt;:8181/basic/?printerNumber=&lt;300/900122322&gt;</td>
</tr>
</tbody>
</table>
7. Save the URL.

### 4.4.3.2 Setting a Link on the Ricoh Home Screen

After creating a URL on the device, it is possible to create a link on the Home Screen of the MFP for users to quickly access the page.

1. Select **User Tools**.
2. Select **Edit Home**.
3. Select **Add Icon**, then **Select Icon to Add**.
4. Select **URL**, then select the newly created URL and the location to save the icon.

Users can now quickly access the URL from the Home Screen.

### 4.4.4 Configuring a Brother BSI (local network) Secure Release Anywhere release station

The PrinterOn Secure Release Anywhere feature supports Brother BSI by default. However, Brother BSI-enabled devices require a unique URL to communicate with the Print Delivery Station.

**Note:** The Brother BSI Secure Release Anywhere integration only supports PrinterOn Secure Release Codes.

#### 4.4.4.1 Creating the Brother BSI service URL

The Print Delivery Station provides access for the BSI workflow using a custom path and port:

- The PDS stores the Brother BSI-specific content in the /bsi folder.
- The PDS listens for Brother BSI requests on port 8182.
You must also specify the Printer Number of the destination printer, configured specifically for the Brother device, in the URL.

**Note:** Ensure that you specify the number of the destination printer, not the Printer Number of the Secure Release Anywhere printer pool.

For example:

```plaintext
http(s)://<adAddress>:8182/
bsi?type=pull&pid=<outputPONPrinterNumber>
```

### 4.4.4.2 Using Brother BSI devices with self-signed certificates

By default, a Print Delivery Station is configured to accept SSL communication only, and provides a self-signed certificate. However, Brother BSI-enabled devices only communicate with a self-signed certificate if the certificate is loaded into the printer/MFP.

There are three workarounds to this issue:

- Purchase and install a valid certificate.
- Upload the self-signed certificate into the printer/MFP.
- Disable SSL for BSI in the Print Delivery Station settings.

### 4.4.4.3 Configuring the Brother BSI for Secure Release Anywhere

To configure the Brother BSI device to access the Secure Release Anywhere URL:

1. Using a web browser, navigate to the Brother printer admin web page. For example:

   ```plaintext
   http://<ipAddress>
   ```

2. Log in to the Brother device as an administrator.
3. Click on **Administration Settings** or **Administrator**.

4. Select **Solution Settings** > **Solutions Application Entry**.

5. Select the **Menu Item** that you want to configure.

6. In the **Display Name** field, enter the name that users will see on the device.

7. In the **URL** field, enter the address of the Print Delivery Station managing the printer. For example:

   http(s)://172.16.23.32:8182/bsi?type=pull&pid=900333212322

8. Click **Submit** to save the changes.

### 4.4.5 Configuring the PrinterOn Network Print Valet

To configure the Print Valet, you need to complete the following tasks:

- Getting the IP address of the Print Valet device.
- Configuring the Network Print Valet.
- Configuring the PrinterOn Server.

#### 4.4.5.1 Getting the IP address of the Print Valet device

To get the IP address of the Print Valet device:

1. With the power plug disconnected, press and hold the **Flag** and **OK** keys.
2. Connect the power plug.
3. Continue to press and hold the **Flag** and **OK** keys until the unit displays the IP address of the device. For example:
4.4.5.2 Configuring the Network Print Valet

To configure the network Print Valet:

1. Connect the Print Valet to a Network port and Power. The device monitor should display the following default information: Service is Disconnected.

2. Set the Print Valet device with a IP address of the machine where your PDS is installed.
   a) With the power plug disconnected, press and hold the Flag and OK keys.
   b) Connect the power plug.
   c) Continue to press and hold the Flag and OK keys until the unit displays Config Mode.
   d) Press the Menu key until you reach Change Destination IP.
   e) Press the OK key, then press OK again. The first digit of the IP address will start flashing.
   f) Enter the IP address of the machine with PDS installed. Use the Clear key to enter the decimal points.
   g) When finished, press the Menu key until you reach screen Q.
   h) Save, then Exit and press OK.

4.4.5.3 Configuring the PrinterOn Server

To configure the PrinterOn Server:

1. In the Configuration Manager, click Advanced > Components.

2. Click the Configure button adjacent the Print Delivery Station component. The PDS component configuration appears.

Note: If an IP address is not obtained, the display will show an IP of 192.168.1.99.
3. Click the **Print Valet** tab and configure the settings as follows:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>Checked.</td>
</tr>
<tr>
<td>Ethernet Connection</td>
<td>Checked.</td>
</tr>
<tr>
<td></td>
<td>In the field below, enter the IP address of Print Valet device. For example: 172.16.100.57</td>
</tr>
<tr>
<td>Serial/USB Connection</td>
<td>Not checked.</td>
</tr>
<tr>
<td>Default Language</td>
<td>Any supported language.</td>
</tr>
<tr>
<td>Printer Association</td>
<td>From the list of printers associated with this PDS, choose one or more printers to be connect to the Print Valet.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

Once you have configured the PDS, you can check the Print Valet display. The following prompt should appear:

**Print Release Press OK**

**Note:** If you receive Error Code 110, check the correctness of the IP addresses and unplug the device from the Network switch then plug it in again.
Configuring workflows

The PrinterOn server allows users to print in a variety of ways, for example, using the PrinterOn Mobile App, or by emailing the print server directly. The **Workflows** tab lets you edit workflow-specific settings.

To configure workflows:

1. In the Configuration Manager, click **Workflows**. The Workflows tab appears.
2. Select the workflow you want to configure. The PrinterOn Server supports the following workflows:
   - **Web Print**: Users upload documents to the Web Print portal.
   - **Mobile**: Users submit jobs using one of PrinterOn’s mobile client apps.
   - **Email Print**: Users email documents as printable attachments directly to a PrinterOn printer.
   - **Google Cloud Print**: Users submit print jobs via the Google Cloud.
   - **PrinterOn Queue Management System (PQMS)**: Users print to Windows print queues that are mapped to PrinterOn printers.
   - **IPP and Native iOS printing**: Users print using either IPP printers that are mapped to PrinterOn printers, or using iOS native printing.
   - **Secure Release Anywhere**: Users print to a pool of printers and pull their print job down to any printer that is a member of the pool.
5.1 Configuring the Web Print workflow

The PrinterOn Server lets users submit print jobs using any connected web browser. Users upload their documents to the Web Print portal and can choose the printer to which to submit the job.

The Web Presentation settings let you customize the Web Print Workflow.

To configure the Web Print workflow:

1. In the Configuration Manager, click **Workflows > Web Print**.
2. Configure your **Web Presentation settings** as necessary.
3. Click **Apply Settings**.

5.1.0.1 Web Presentation settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Print Page</td>
<td>Provides a link to the Web Print portal. The default value is: <a href="http://127.0.0.1/cps">http://127.0.0.1/cps</a>.</td>
</tr>
</tbody>
</table>

You can modify this URL to display the DNS name or the IP address of the PrinterOn Server. This is configured in the PrinterOn web admin portal at www.printeron.com/administrators. For more information, see Updating the Service URL.

This link is provided as a shortcut for the PrinterOn administrators; however, end users can still access the Web Print portal regardless of this configuration option.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Web Print</td>
<td>When checked, the Web Print portal is accessible to all users. Disabling this feature disables the Web Print portal for all users. Note: You can also disable Web Print for individual printers, so that the printer is not listed among the available printers when users submit a print job through the Web Print portal. For more information, see Configuring printer-specific workflow options.</td>
</tr>
<tr>
<td>Languages</td>
<td>Specifies a list of the languages in which the Web Print portal can be displayed. The server can display the page in the following languages: English, French, Spanish, Italian, German, Dutch, Danish, Portuguese, Simplified Chinese, Traditional Chinese, Japanese, or Korean. By default, English is the only language in the list. You can modify the languages included in the list by clicking Manage Languages and adding or removing them as necessary. When more than one language is enabled, the user can choose in which language to display the page.</td>
</tr>
<tr>
<td>Job Submit Refresh Interval</td>
<td>Specifies the how often, in seconds, that the Web Print portal updates the status of a submitted print job.</td>
</tr>
<tr>
<td>Job Approval</td>
<td>When checked, the user must confirm the print job before the Web Print portal sends it to the printer.</td>
</tr>
<tr>
<td>Smart Printer Selection</td>
<td>When checked, the Web Print portal skips the printer selection page if the user only has a single printer available. By default, the user is prompted with a page to select their printer.</td>
</tr>
<tr>
<td>Department Sidebar View</td>
<td>When checked, the Web Print portal displays the department selection side bar, which allows users to filter which printers are displayed by selecting one or more departments.</td>
</tr>
<tr>
<td>Number of Printers Displayed Per Page</td>
<td>Specifies how many printers are displayed per page.</td>
</tr>
<tr>
<td>Number of Departments Displayed Per Page</td>
<td>Specifies how many departments are displayed per page in the Department sidebar.</td>
</tr>
</tbody>
</table>
5.2 Configuring the Mobile Print workflow

The PrinterOn Server supports mobile apps developed for iOS and Android. To allow these apps to communicate with the PrinterOn Server, you must define the Service URI, also called the Document API URI. This URI is the IP address that the apps use to communicate with your PrinterOn installation. Once this address is configured, Mobile Apps will be able to both search for printers and independently submit print jobs.

To configure the Mobile print workflow:

1. In the Configuration Manager, click Workflows > Mobile.
2. Check Override Document API URI.
   The Document API URI is the URL that the app uses to submit documents to the server.
3. Click the Document API URI drop-down and select the address provided. This address is determined automatically by the software based on your server’s IP address and should always be concluded with /cps.
4. Click Apply Settings.

5.2.0.1 Mobile print settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Server Discovery</td>
<td>The PrinterOn Server can be used to broadcast itself as well as its printers. Enable this option to allow the PrinterOn Mobile Apps to locate the PrinterOn Server automatically on the network. This option is useful if printers are organized in different servers on the network, and you would like to limit access to certain services.</td>
</tr>
<tr>
<td>Override Document API URI</td>
<td>When checked, the Document API URI is the URL returned by the server to the Mobile Apps when searching for printers. It is used by the App to submit documents to the server. By enabling this option, you can provide a value in the Document API URI.</td>
</tr>
</tbody>
</table>
Configuring workflows

5.3 Configuring the Email Print workflow

To configure your server to accept email print jobs, you will need to configure some settings for your mail service.

When configuring your mail service it is important to know prior to configuring what method your service will use to connect to the mail server. The PrinterOn Server supports the following email systems:

- Microsoft Exchange Web Services (EWS)
- IMAP4 mail protocol
- Microsoft Messaging APIs (MAPI)
- Lotus Notes/Domino API

The PrinterOn Enterprise Server uses the standard SMTP protocol for sending emails for both IMAP4 and MAPI installations.

**Note:** For information on incorporating email printing into your existing mail system deployment, see Configuring your mail server for PrinterOn email printing.

To configure your email print workflow:

1. In the Configuration Manager, click **Workflows > Email Print.**
2. To configure your inbound service settings, choose the Email Type used by your organization.

![Server Configuration (Inbound)](image)

The configuration panel for the selected service appears, allowing you to set service-specific settings:

- Exchange Web Services (EWS)
- IMAP4
- MAPI
- Domino (Available for Enterprise Edition only)

3. If you configured the server to use EWS, IMAP4, or MAPI, configure the SMTP settings used for outbound messages.

4. Configure any advanced email print settings, if necessary. For example, you can set the minimum size for an attachment, or auto-detect forwarded messages.

   **Note:** The Advanced Email Settings panel is displayed in Advanced view only.

5. Click **Apply Settings**.

### 5.3.1 Configuring Exchange Web Services (EWS) settings

Selecting EWS as your Email Type displays the EWS Configuration settings:

![EWS Configuration](image)
Using Exchange Web Services to connect to Exchange and provides a more modern alternative to MAPI. This option supports both MS Exchange server hosted internally and Office 365 cloud based email services.

### 5.3.1.1 EWS settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service URI</td>
<td>Specifies the EWS server’s IP address or hostname. The URI depends on which service you’re using:</td>
</tr>
<tr>
<td></td>
<td>• Office 365 mail services: <a href="https://outlook.office365.com/EWS/Exchange.asmx">https://outlook.office365.com/EWS/Exchange.asmx</a></td>
</tr>
<tr>
<td></td>
<td>• MS Exchange mail service: https://Your_Exchange_Server/EWS/Exchange.asmx</td>
</tr>
<tr>
<td>Mailbox Username</td>
<td>The username that will be used to connect to the Exchange server and to monitor the incoming mailbox. This account could also be the same account used to install and run the PrinterOn server services.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you’re using Office 365, the value must be the complete email address.</td>
</tr>
<tr>
<td>Mailbox Password</td>
<td>The password that will be used to connect to the EWS server and monitor the incoming mailbox.</td>
</tr>
<tr>
<td>Listener Port</td>
<td>Indicates the port the PrinterOn Server should connect to when communicating with the EWS server.</td>
</tr>
<tr>
<td></td>
<td>The default is port 80.</td>
</tr>
<tr>
<td>Response Address</td>
<td>This is the email address that will be used by the mail server when responding to email requests. When an email is sent to the default address, the PrinterOn server will automatically delete the message and not respond to the user.</td>
</tr>
<tr>
<td></td>
<td>Typically this should be set to an address such as: <a href="mailto:no-reply@print.company.com">no-reply@print.company.com</a></td>
</tr>
<tr>
<td>Accept requests to response address (Advanced view only)</td>
<td>By default all emails sent to the response address will be automatically deleted. Enabling this option will cause PrinterOn Server to respond to requests sent to this address.</td>
</tr>
<tr>
<td></td>
<td>This option is generally only used for diagnostic purposes.</td>
</tr>
<tr>
<td>Test</td>
<td>Clicking <strong>Test</strong> checks the configured settings to ensure that the PrinterOn Server can successfully connect to and communicate with the EWS server.</td>
</tr>
</tbody>
</table>
5.3.2 Configuring IMAP4 settings

Selecting **IMAP4** as your Email Type displays the IMAP4 Configuration settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Address</td>
<td>Specifies the IMAP4 server's IP address or hostname.</td>
</tr>
<tr>
<td>Server Port</td>
<td>Indicates the port on which the PrinterOn Server should connect when</td>
</tr>
<tr>
<td></td>
<td>communicating with the IMAP4 server. Default ports are:</td>
</tr>
<tr>
<td></td>
<td>• Non-SSL default port: 143</td>
</tr>
<tr>
<td></td>
<td>• SSL default port: 993</td>
</tr>
<tr>
<td>SSL/TLS</td>
<td>Select from one of three options for SSL. You may need to contact your</td>
</tr>
<tr>
<td></td>
<td>your server administrator to identify the type of SSL used by your server.</td>
</tr>
<tr>
<td></td>
<td>The configuration will automatically adjust the SMTP port based on the most</td>
</tr>
<tr>
<td></td>
<td>commonly used ports.</td>
</tr>
<tr>
<td></td>
<td>• <strong>None</strong>: SSL will not be used for this server.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Implicit SSL</strong>: Typically used with port 993, this type of SSL is often</td>
</tr>
<tr>
<td></td>
<td>referred to as IMAP-over SSL.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Explicit SSL</strong>: Typically used with port 143, this type of SSL is often</td>
</tr>
<tr>
<td></td>
<td>referred to as IMAP-TLS.</td>
</tr>
<tr>
<td>Strict SSL</td>
<td>If enabled the service will only connect to services when the SSL certificate</td>
</tr>
<tr>
<td></td>
<td>is valid and signed by a valid certificate authority. If your service is</td>
</tr>
<tr>
<td></td>
<td>configured for SSL but is using a self-signed certificate, disable this</td>
</tr>
<tr>
<td></td>
<td>option.</td>
</tr>
</tbody>
</table>
5.3.3 Configuring MAPI settings

Selecting MAPI as your Email Type displays the MAPI Configuration settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>The username that will be used to connect to the IMAP4 server and monitor the incoming mailbox.</td>
</tr>
<tr>
<td>Password</td>
<td>The password that will be used to connect to the IMAP4 server and monitor the incoming mailbox.</td>
</tr>
<tr>
<td>Response Address</td>
<td>The email address that will be used by the mail server when responding to email requests. When an email is sent to the default address, the PrinterOn server will automatically delete the message and not respond to the user. Typically this should be set to an address such as: <a href="mailto:no-reply@print.company.com">no-reply@print.company.com</a></td>
</tr>
<tr>
<td>Accept requests to response address (Advanced view only)</td>
<td>By default all emails sent to the response address will be automatically deleted. Enabling this option causes the PrinterOn server to respond to requests sent to this address. This option is generally only used for diagnostic purposes.</td>
</tr>
<tr>
<td>Test</td>
<td>Clicking Test checks the configured settings to ensure that the PrinterOn server can successfully connect to and communicate with the IMAP4 server.</td>
</tr>
</tbody>
</table>

To use Microsoft’s Messaging APIs (MAPI), you must have the MAPI subsystem installed on the machine where the PrinterOn server is installed. The MAPI subsystem is installed with Microsoft Outlook, although, you can also install it separately if you don’t have a copy of Microsoft Outlook.

Once you have MAPI installed, log on to the PrinterOn Server with the user account of the mailbox you’ll be using to connect to the Microsoft Exchange server to retrieve emails for printing. This user should be a local administrator on the machine and be able to log on to the PrinterOn server.

### 5.3.3.1 MAPI settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile Name</td>
<td>Select the Microsoft mail profile that was created after installing MAPI.</td>
</tr>
</tbody>
</table>
| Response Address      | The email address that will be used by the mail server when responding to email requests. When an email is sent to the default address, the PrinterOn server will automatically delete the message and not respond to the user.  
Typically this should be set to an address such as: no-reply@print.company.com |
| Override Default      | Enabling this option will allow the response address to be accessible with changes.                                                           |
| Accept requests to response address (Advanced view only) | By default all emails sent to the response address will be automatically deleted. Enabling this option will cause PrinterOn Server to respond to requests sent to this address.  
This option is generally only used for diagnostic purposes. |

### 5.3.4 Configuring Domino settings (Enterprise Edition only)

Selecting **Domino** as your **Email Type** displays the Domino Configuration settings:

![IBM Domino Configuration](image)

To use Lotus Domino with the PrinterOn Server, you must:
• Install the Lotus Notes client on the PrinterOn Server as a Single-User installation. A Single-User installation lets the PrinterOn Server access the Notes executable files and the Domino data files.
• Launch the Lotus Notes client and validate that the server can connect to the user’s mailbox.

5.3.4.1 Domino settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Address</td>
<td>Specifies the Lotus Domino server’s IP address or DNS name. This information is used by the Domino address book look-up feature to fetch the SMTP address of the recipient.</td>
</tr>
<tr>
<td>Password</td>
<td>The mailbox account password information that will be used to connect to the Lotus Domino server and monitor the incoming mailbox.</td>
</tr>
<tr>
<td>Response Address</td>
<td>The email address that will be used by the mail server when responding to email requests. When an email is sent to the default address, the PrinterOn server will automatically delete the message and not respond to the user.</td>
</tr>
<tr>
<td></td>
<td>Typically this should be set to an address such as: <a href="mailto:no-reply@print.company.com">no-reply@print.company.com</a></td>
</tr>
<tr>
<td>Accept requests to response address (Advanced view only)</td>
<td>By default all emails sent to the response address will be automatically deleted. Enabling this option will cause PrinterOn Server to respond to requests sent to this address.</td>
</tr>
<tr>
<td></td>
<td>This option is generally only used for diagnostic purposes.</td>
</tr>
<tr>
<td>Printer Name</td>
<td>This is an optional setting that will allow administrators to specify the destination PrinterOn printer name for all the incoming requests. If the value is not set, the server will use the Domino Address Book Look-up feature to fetch the SMTP address of the recipient.</td>
</tr>
<tr>
<td>Lotus Notes INI Path</td>
<td>This allows the administrator to specify the Lotus Notes (Notes.ini) configuration file path. This file can usually be found in the following location: C:\Program Files(x86)\IBM\Lotus\Notes</td>
</tr>
<tr>
<td></td>
<td>Clicking the Browse button should launch the appropriate directory location where this configuration file can be found.</td>
</tr>
<tr>
<td></td>
<td>Note: Depending on which version of Lotus Notes you’re using, you may need to specify the filename in the path as well. For example: C:\Program Files(x86)\IBM\Lotus\Notes\Notes.ini</td>
</tr>
</tbody>
</table>
5.3.5 Configuring the SMTP Server for outbound messages

When you select EWS, IMAP4, or MAPI as your Email Type, the PrinterOn Server uses SMTP to send messages to users about their print job.

5.3.5.1 SMTP settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Address</td>
<td>Specifies the SMTP server’s IP address or hostname.</td>
</tr>
</tbody>
</table>
### Port
Indicates the port on which the PrinterOn server should connect when communicating with the SMTP server.

The default SMTP port is 25.

### SSL/TLS
Select from one of three options for SSL. You may need to contact your server administrator to identify the type of SSL used by your server. The configuration will automatically adjust the SMTP port based on the most commonly use ports.

- **None**: SSL will not be used for this server.
- **Implicit SSL**: Typically used with port 993, this type of SSL is often referred to as IMAP-over SSL.
- **Explicit SSL**: Typically used with port 143, this type of SSL is often referred to as IMAP-TLS.

To only connect to services when the SSL certificate is valid and signed by a valid certificate authority, enable **Strict SSL**. If your service is configured for SSL but is using a self-signed certificate, disable this option.

### Username
The username that will be used to connect to the IMAP4 server and monitor the incoming mailbox.

### Password
The password that will be used to connect to the IMAP4 server and monitor the incoming mailbox.

### Sender Name
Indicate the name of the sender that will be shown in email responses sent from the server.

### Sender Address
Indicate the sender address to set when responding to the user. This is typically the same as the “Default Address” configured under the incoming mail server settings.

### Reply to Address
Indicate the reply-to address to set when responding to the user. This is typically the same as the “Default Address” configured under the incoming mail server settings.

### Test
Clicking **Test** checks the configured settings to ensure that the PrinterOn Server can successfully connect to and communicate with the SMTP server.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port</td>
<td>Indicates the port on which the PrinterOn server should connect when communicating with the SMTP server. The default SMTP port is 25.</td>
</tr>
<tr>
<td>SSL/TLS</td>
<td>Select from one of three options for SSL. You may need to contact your server administrator to identify the type of SSL used by your server. The configuration will automatically adjust the SMTP port based on the most commonly use ports.</td>
</tr>
<tr>
<td></td>
<td>- <strong>None</strong>: SSL will not be used for this server.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Implicit SSL</strong>: Typically used with port 993, this type of SSL is often referred to as IMAP-over SSL.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Explicit SSL</strong>: Typically used with port 143, this type of SSL is often referred to as IMAP-TLS.</td>
</tr>
<tr>
<td>Username</td>
<td>The username that will be used to connect to the IMAP4 server and monitor the incoming mailbox.</td>
</tr>
<tr>
<td>Password</td>
<td>The password that will be used to connect to the IMAP4 server and monitor the incoming mailbox.</td>
</tr>
<tr>
<td>Sender Name</td>
<td>Indicate the name of the sender that will be shown in email responses sent from the server.</td>
</tr>
<tr>
<td>Sender Address</td>
<td>Indicate the sender address to set when responding to the user. This is typically the same as the “Default Address” configured under the incoming mail server settings.</td>
</tr>
<tr>
<td>Reply to Address</td>
<td>Indicate the reply-to address to set when responding to the user. This is typically the same as the “Default Address” configured under the incoming mail server settings.</td>
</tr>
<tr>
<td>Test</td>
<td>Clicking <strong>Test</strong> checks the configured settings to ensure that the PrinterOn Server can successfully connect to and communicate with the SMTP server.</td>
</tr>
</tbody>
</table>
5.3.6 Configuring the Advanced Email Settings

The Advanced Email Settings let you configure some additional options for email print jobs.

![Advanced Email Settings panel]

**Note:** The Advanced Email Settings panel is displayed in Advanced view only.

### 5.3.6.1 Advanced email settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min. Attachment File Size</td>
<td>Specifies the threshold at which the PrinterOn Server processes or ignores attachments. This setting is useful when dealing with some attachments that are included as part of signatures of emails.</td>
</tr>
<tr>
<td>Ignore Empty HTML Attachments</td>
<td>When checked, the PrinterOn Server attempts to detect when an email contains HTML-based attachments that contain no visible content. The server attempts to read the attachment and ignores the file if it detects an empty file, or no values between the HTML tags.</td>
</tr>
<tr>
<td>ZIP Archive Support</td>
<td>When checked, the PrinterOn Server processes ZIP files attached to email messages. PrintAnywhere extracts the contents of the ZIP file and processes each file individually.</td>
</tr>
<tr>
<td>Ignore Requests To Invalid Printers</td>
<td>When checked, the PrinterOn Server doesn’t respond to requests submitted to unknown email accounts. The user is not notified that the destination printer address is invalid and the email is silently ignored.</td>
</tr>
<tr>
<td>Auto Detect Forwarded Messages</td>
<td>When checked, the PrinterOn Server attempts to detect when a message has been forwarded from a client. The client may wrap the original email message in an embedded message before forwarding it to the server. Generally this option should be left enabled unless you encounter a specific issue with your mail server.</td>
</tr>
</tbody>
</table>
5.4 Configuring the Google Cloud Print workflow

The PrinterOn Connector for Google Cloud Print (GCP) is an extension to the PrinterOn Server that allows users to print seamlessly from any of the GCP Client Applications to PrinterOn printers.

The GCP Connector helps bridge the gap between the existing Google Cloud Print workflows and the PrinterOn Server. Once the connector is configured, users can submit jobs to PrinterOn printers from Google clients such as ChromeOS or Chrome Browser.

The PrinterOn Server with the GCP connector greatly simplifies printing management in environments where users bring their own devices—smartphones, tablets, Chromebooks, and Notebooks—that do not connect exclusively to existing print infrastructure.

This unique approach extends the following advanced capabilities for jobs submitted through the Google Cloud Print workflows:

- LDAP/Active Directory Authentication
- User-based Access Control
- Print Management Integrations
- Guest Print Workflows

**Note:** As you add and configure your Google Cloud printers, you will be redirected to the Google Cloud Print website to enter your credentials and provide the PrinterOn Server access to your Google printers. Before continuing, see [Google Cloud Print authentication](#) to learn how to ensure that you are prepared to add Google Cloud Printers.

To configure the Google Cloud Print workflow:

1. In the Configuration Manager, click **Workflows > Google Cloud Print**.
2. Add your Google Cloud printers by providing a printer name and mapping it to an existing PrinterOn printer.
3. Configure the general settings for the printer.
4. Share the printer to make it available to Google Cloud users.
5. To rename a printer queue, select the printer in the list then click Rename.
6. To delete a printer queue from both the PrinterOn Server and the Google Cloud Printer services, click Delete Printer.
7. Click **Apply Settings**.
5.4.1 Google Cloud Print authentication

The PrinterOn Server uses Google's OAuth2 based system for identifying users and printers. This provides a secure method of linking Google printers and users to PrinterOn. During the setup process, you will be redirected to the Google Cloud Print website to enter your credentials and provide the PrinterOn Server access to your Google printers.

Before starting your Google Cloud Print setup:

- Create a Google Account to manage your printers and Google Cloud Print workflow.
- Ensure that pop-up windows are allowed for the PrinterOn Server. During the setup process, the Configuration Manager will load a pop-up window or tab and redirect you to the Google website.

5.4.2 Adding a Google Cloud printer

To add a Google Cloud Printer to your PrinterOn solution, you must create a map that links a Google printer to a PrinterOn printer.

To map a Google Cloud Printer to a PrinterOn printer:


2. Set the following values:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Printer Name</strong></td>
<td>The user-friendly Google Cloud Print printer name that will be assigned to this printer.</td>
</tr>
<tr>
<td><strong>Map to Printer</strong></td>
<td>The PrinterOn server printer that was previously created on the PrinterOn.com portal.</td>
</tr>
</tbody>
</table>
3. Click **Add Google Printer** to create the printer on the Google Cloud Print servers. The printer is added to the Google Cloud Print Printers list.

5.4.3 Configuring Google Cloud Print general settings

Once you add a new Google Cloud printer, you can configure some general print settings for it.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Proxy (Identifier)</strong></td>
<td>The Google Service identifier that uniquely identifies the instance of the PrinterOn server. The Google Cloud Print service allows a printer proxy (PrinterOn server GCP Connector) to register more than one physical/virtual printer. If the printers linked to the Google Cloud Account do not have an associated proxy-identifier value, then the PrinterOn server Application auto-generates a new value.</td>
</tr>
<tr>
<td><strong>Fetch Jobs Interval</strong></td>
<td>How often the PrinterOn Server restarts the connection with Google to receive new print jobs. The PrinterOn Server registers for notifications from Google regarding new print jobs. In some cases, this connection may become unstable or unresponsive. This value allows the software to adapt to various network types.</td>
</tr>
</tbody>
</table>

5.4.4 Sharing a Google Cloud printer

Once the Google Cloud Printer has been added, you must then share the printer so that users can see the printer in the GCP client. You can share the printer with individual users or groups of users, provided the users all have access to a GCP client.

To share a Google Cloud printer:

1. In the Select column of the Google Cloud Print screen, check the printer you would like to share.
2. Click **Share Printer**.
3. In the Share Printer dialog, select Yes to be redirected to the Google Cloud Print site.

![Share Printer](image)

4. Log in to the Google Cloud Print services and share the printer.

5.5 Configuring the PrinterOn Queue Management System (PQMS) workflow

The PrinterOn Print Queue Monitoring Service Connector is another extension to the PrinterOn Server that enables jobs submitted to the standard Windows Print Server queues to be delivered to remote printers through the PrinterOn Server infrastructure.

**Note:** PQMS is only available for PrinterOn Enterprise edition.

To configure the PQMS workflow:

1. In the Configuration Manager, click Workflows > PQMS.
2. Configure your PQMS settings as necessary (Advanced view only). In most cases, you should not need to change the default settings.
3. Map the local Windows printer queue to a PrinterOn printer. The PQMS integration supports the following printer mapping configuration types:
   - One-to-One: Each printer device queue can be mapped to a unique PrinterOn printer
   - Many-to-One: Multiple printer device queues can be mapped to the same PrinterOn printer.

   To map a print queue:
   a) Select the local printer queue that will be routed through the PrinterOn server.
   b) Select a PrinterOn Printer from the list.
4. Click Apply Settings.
5.5.1 Configuring the PQMS connector

The PDG PQMS Connector helps bridge the gap between the existing Windows Print Queue workflows and the PrinterOn Server. It allows print users to submit jobs using standard Windows workflows (for example, using File > Print) and leverage the capabilities of the PrinterOn Server to deliver the pre-rendered data content to printers located anywhere in the world.

**Note:** The PQMS Settings panel is displayed in Advanced view only.

### PQMS Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder to Monitor</td>
<td>Specifies the directory in which the PrinterOn Server stores print data.</td>
</tr>
<tr>
<td>Max Concurrent Jobs</td>
<td>Specifies the maximum number of print jobs to be processed by the PrinterOn Server at any given time. This setting helps avoid overloading the PrinterOn Server and reduces job delays during periods of heavy usage.</td>
</tr>
<tr>
<td></td>
<td>If you are using multiple servers, you can increase this value.</td>
</tr>
<tr>
<td>Retry Failed Job Attempts</td>
<td>The maximum number of job retries per print job before abandoning the request.</td>
</tr>
<tr>
<td></td>
<td>The default number of retries is 3.</td>
</tr>
<tr>
<td>Job Processing Timeout</td>
<td>The maximum amount of time the PQMS connector waits for confirmation after job submission before abandoning the job request and freeing up the print slot.</td>
</tr>
<tr>
<td></td>
<td>The default timeout is 5 minutes.</td>
</tr>
</tbody>
</table>
5.5.2 Mapping the Windows Print Queue to a PrinterOn printer

The Printer Mappings section lets you map the existing Local Windows Print Queues to PrinterOn Printers.

<table>
<thead>
<tr>
<th>Local Printer Name</th>
<th>PrinterOn Printer</th>
</tr>
</thead>
<tbody>
<tr>
<td>PrintWhere 5.2</td>
<td></td>
</tr>
<tr>
<td>Microsoft XPS Document Writer</td>
<td></td>
</tr>
</tbody>
</table>

5.6 Configuring IPP and Native iOS workflows

The PrinterOn Server includes an IPP connector that allows administrators to deliver print jobs generated by third-party IPP print servers and clients to designated printers located in remote locations. You can configure:

- native IOS printing
- IPP printing

5.6.1 Configuring Native iOS Printing

The PrinterOn Server can be configured to let iOS-based devices discover printers and submit print jobs to PrinterOn printers. It allows users to submit jobs to printers that are located both inside and outside the enterprise network.

This approach extends the following advanced capabilities for jobs submitted through the iOS device print workflow:

- LDAP/Active Directory Authentication
- User-based Access Control
- Print Management Integrations
- Guest Print Workflows
• Enabling Printing from Multiple Networks

**Note:** To enable Native iOS Printing for a specific PrinterOn printer, you must first enable discovery for that printer. To enable the printer discovery setting:

1. Navigate to the **Printers** tab.
2. Locate the printer in the printers list.
3. In the **Discovery** column, click the X.
4. Select **Synchronize** to save the settings and update all components within the PrinterOn server.

To configure the Native iOS printing workflow:

1. In the Configuration Manager, click **Workflows > IPP and Native iOS Printing**.
2. Configure the **Network and Broadcast Settings** as necessary.

3. Click **Apply Settings**.

### 5.6.1.1 Network and Broadcast Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Broadcast Interface</strong></td>
<td>This setting is specific to the PDG Discovery Connector integration. Please refer to the details included in the sections listed below for information on how to configure this setting and its potential implications.</td>
</tr>
<tr>
<td><strong>Default IPP Port</strong></td>
<td>The default port on which the IPP Listener service listens for print jobs from iOS devices. The default port is <strong>6310</strong>.</td>
</tr>
<tr>
<td>To enable port, check <strong>Enable</strong>.</td>
<td></td>
</tr>
<tr>
<td>To transfer the print data securely, check <strong>SSL</strong>. This setting is checked by default for the Default IPP Port.</td>
<td></td>
</tr>
</tbody>
</table>
5.6.2  Configuring IPP Printing

The PrinterOn Server includes an IPP connector that allows administrators to deliver print jobs generated by third-party IPP print servers and clients to designated printers located in remote locations.

To configure the Native iOS printing workflow:

1. In the Configuration Manager, click Workflows > IPP and Native iOS Printing.
2. Configure the IPP Printers settings as necessary.

3. Click Apply Settings.

5.6.2.1  IPP Printers settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Port 1,</td>
<td>Additional ports on which the IPP Listener service listens for print jobs, to be used by iOS devices when the default port is blocked.</td>
</tr>
<tr>
<td>Additional Port 2</td>
<td>(Advanced view only)</td>
</tr>
<tr>
<td></td>
<td>• To enable the port, check Enable.</td>
</tr>
<tr>
<td></td>
<td>• To transfer the print data securely, check SSL.</td>
</tr>
</tbody>
</table>
5.6.2.2 Configuring IPP printing on your Windows Server

To set up IPP Printing on your Windows Server:

1. Configure your Windows Server roles to support print services:
   a) In the Server Manager, click Server Roles, then check Print and Documentation Services.

   **Note:** In Windows Server 2008, you must also check the Printer Server role service.

2. Install the IPP Printing Client:
   a) In the Server Manager, click Features, then check IPP Printing Client.

3. Reboot the server.

5.6.2.3 Connecting an IPP printer in Windows

You can use the following steps to connect Windows to PrinterOn using IPP. You’ll need the IP address of the server hosting the PrinterOn software.

**Note:** The specific panels in Control Panel may vary depending on which version of Windows you are running.
To connect an IPP printer to a Windows:

1. Enable IPP printing:
   a) Click Control Panel > Programs and Features, then select Turn Windows Features On or Off.
   b) In the features list, expand Print and Document Services and verify that Internet Printing Client is checked.
2. Return to the Control Panel home page, then open Devices and Printers.
3. On the Devices and Printers screen, click Add a Printer.
4. In the Add Printer dialog, choose Network, then click The printer I want isn’t listed
5. Choose Select a shared printer by name and enter the IP address of the machine where the PDG is located. Include the port number used by the PDG. For example: http://172.16.100.101:6310/generated-printer-1
   If necessary, you can validate that the port is open by using Telnet
6. Click Next. Windows attempts to connect to the PrinterOn printer using IPP.
7. Select the printer driver that you want to use.

5.6.2.4 Supporting IPP over HTTPS

If you intend to print using IPP over HTTPS, you’ll need to install a valid self-signed SSL certificate on the PrinterOn server, and the server hosting the PDG, if it is installed on another server.

**Note:** Only install SSL certificates from servers that you trust.

To install a certificate:

1. Log in as an administrator.
2. Right-click on Internet Explorer, and click Run as administrator.
3. In Internet Explorer, browse to the following URL:
   https://PDG_Server_IP_Address/
4. Because there is no certificate installed in the server, you’ll receive a certificate error. Click on the error.
5. Click View Certificates.
6. In the Certificates window, click Install Certificate....
7. Select Place all certificates in the following store, then click Browse.
8. Select Trusted Root Certification Authorities, then click OK.
9. Click **Next**, then click **Finish**.

10. A security warning will appear informing you that you are adding a certificate from a source that cannot be validated. Click **Yes** to trust this SSL certificate.
Configuring general settings

From the Home tab, you can access a number of general settings and details about your server.

This tab contains several subtabs:

- **Overview**: Provides system information and an overview of system health.
- **General Settings**: Lets you configure cross-component settings.
- **Services**: Lets you view and change the status of the PrinterOn services.
- **Licensing**: Lets you view and manage your license information.
- **Serial Numbers**: Lets you view serial number information for server components and add additional PDS and PDH instances or PrintAnywhere Servers to your service.

### 6.1 Viewing system information

The Overview tab is mostly informative, and provides high-level details about your server. This information can help you quickly identify when there are issues. Additionally, when issues do occur, knowledge about your system is often necessary to help diagnose the problem.

To view system information:

1. In the Configuration Manager, click **Home > Overview**.
2. Review the information in the panels:

- **Server Overview**: Provides information about your PrinterOn Server software version, as well as basic printer and print job metrics. Click **PrinterOn Administration Page** to open the PrinterOn.com web admin portal at www.printeron.com/administrators.

- **Usage Overview**: Provides an overview of the system usage, detailing how many jobs have been processed, and how many pages have been saved.

**Note**: The server calculates the number of pages saved as follows:

- If a job is submitted and held for release but the user never releases the job, all pages in the job are considered saved. This usually is when the printer has been configured for secure release.

- If duplex is used when printing, each physical piece of paper saved is counted as a saved page.
  
  For example, when printing a 4-page document with duplex selected, the system considers that 2 pages are saved, since only 2 physical pages are used. When printing a 3-page document with duplex, only 1 page is saved, since 2 physical pages are still used.

- If a job is printed as Color, then the savings are tallied as **# of Color Pages Saved**.

- If a job is printed as Black and White, then the savings are tallied as **# of B&W Pages Saved**.

- **System Health**: Provides an overview of the current components and remote servers managed by this Configuration Manager. Click the links to view and configure the components.

- **System Information**: Provides an overview of the Windows Server currently being used.

**Note**: This information represents the server where the parent Configuration Manager is installed. When installing all components on multiple servers, you should load this page in the Configuration Manager for each server.

### 6.1.1 Viewing version information for all installed server components

In addition to seeing the server software version, you can also view the specific version for each component installed as part of the PrinterOn Server installation.
To view component version information:

1. In the Configuration Manager, click **Home > Overview**.
2. In the **Server Overview** panel, click the value for **Server Version**. The Installed Components Versions dialog appears.

![Installed Components Versions](image)

### 6.1.2 Exporting server and system information

You can export the system and server information displayed on the **Overview** tab to a text file that you can

To export system information:

1. In the Configuration Manager, click **Home > Overview**.
2. Locate the **System Health** panel, then click **Export System Information**. A text file with a summary of the content of this tab is created and displayed in your browser.

### 6.1.3 Creating a package of diagnostic information

In order to diagnose an issue with your PrinterOn Server, you may need to send PrinterOn Support the log files for all your server subcomponents. You can quickly create a package of this information from the **Overview** tab.

To create a package for PrinterOn support:

1. In the Configuration Manager, click **Home > Overview**.
2. Locate the **System Health** panel, then click **Download Support Package**. The Configuration creates a ZIP file with comprehensive server information and logs for all managed components.
6.2 Configuring general cross-component settings

The **General Settings** tab lets you configure some of the most common configuration values from a single location. The options in this section are applied to all components and servers.

To configure job management settings:

1. In the Configuration Manager, click **Home > General Settings**.
2. In the **Debug Logging** panel, specify the logging level to use across all components.
3. In the **Job Management** panel, set cross-component workflow options. These settings allow you to set some general limits to control the impact of printing on your network bandwidth.
4. In the **Proxy Settings** panel, define the server proxy settings for the Central Print Services, if you are using a proxy server.
5. In the **Printer Synchronization Settings** panel (available in Advanced view only), specify how services and printers are synchronized.
6. In the **Advertised Capabilities** panel (available in Advanced view only), define which features your PrinterOn service supports. These values are then sent to client applications that want to print using the service, such as the PrinterOn Mobile App, to help them optimize their behavior.
7. Click **Apply Settings**.

6.2.1 Setting debug logging levels

The Debug Logging panel of the General tab lets you set cross-component logging levels. Higher levels of logging are most useful when troubleshooting.
In general, to reduce the impact on server performance, you should set the logging to **Information** (the default) or lower, and adjust it only when necessary to troubleshoot an issue.

### 6.2.1.1 Logging levels

<table>
<thead>
<tr>
<th>Log Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>All logging is disabled.</td>
</tr>
<tr>
<td>Fatal</td>
<td>Only records non-recoverable or fatal errors.</td>
</tr>
<tr>
<td>Error</td>
<td>Records all errors.</td>
</tr>
<tr>
<td>Warning</td>
<td>Records warning messages (recoverable errors or unexpected conditions).</td>
</tr>
<tr>
<td>Information</td>
<td>Records all informational messages (default).</td>
</tr>
<tr>
<td>Debug</td>
<td>Records detailed troubleshooting logs that are useful for debugging.</td>
</tr>
<tr>
<td>Trace</td>
<td>Records more detailed troubleshooting logs than Debug.</td>
</tr>
<tr>
<td>All</td>
<td>Records all log information, providing the most detailed logs.</td>
</tr>
</tbody>
</table>
6.2.2 Configuring Job Management settings

The Job Management panel of the General tab lets you set cross-component workflow options. These settings allow you to set some general limits to control the impact of printing on your network bandwidth.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Size Limit</td>
<td>The maximum size of a document that will be accepted by the server. Users are notified that their document is too large when submitting a document larger than the configured value.</td>
</tr>
<tr>
<td>Pending Release Job Expiry (PDS)</td>
<td>The maximum length of time that a job is held by the PDS without being released before the PDS deletes the job.</td>
</tr>
<tr>
<td>Pending Download Job Expiry (PDH)</td>
<td>The maximum length of time that a job is held by a PDH without being downloaded by a PDS before the PDH deletes the job. This setting only applies if you have deployed a Print Delivery Hub component along with your server.</td>
</tr>
</tbody>
</table>
6.2.3 Configuring proxy settings for the Central Print Services

The Proxy Settings panel of the General tab lets you define the server proxy settings, if you are using a proxy server.

![Proxy Settings Panel](image)

**Note:** The proxy settings you define here are only used by the CPS. In most deployments, this is sufficient, since all communication with the PrinterOn Directory flows through the CPS. However, if you have implemented a Hybrid Direct deployment, in which each component communicates directly with the PrinterOn Directory, you must define the proxy settings for PAS and PDS individually.

To configure the proxy settings for an individual component:

1. In the Configuration Manager, click Advanced > Components, then click the Configure button adjacent to the component you want to set proxy settings for.
2. Click the Proxy tab, and configure the settings as necessary.
6.2.3.1 Proxy Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>When checked, a proxy server is used.</td>
</tr>
<tr>
<td>Proxy Server URI</td>
<td>The URL or IP address of the proxy server with which to communicate.</td>
</tr>
<tr>
<td>Proxy Port</td>
<td>The network port number with which the proxy server has been configured to communicate.</td>
</tr>
<tr>
<td>Username</td>
<td>The user name required to authenticate against the proxy server, if required.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For NTLM Proxies, ensure that the Windows Domain name is added to the Username. This will automatically cause the server to use NTLM proxy options.</td>
</tr>
<tr>
<td>Password</td>
<td>The password required to authenticate against the proxy server, if required.</td>
</tr>
</tbody>
</table>

6.2.4 Configuring printer synchronization settings

The **Printer Synchronization Settings** panel of the General tab lets you specify how services and printers are synchronized.

**Note:** The Printer Synchronization Settings panel is displayed in Advanced view only.
6.2.4.1 Printer Synchronization Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synchronize By Default</td>
<td>When checked, the component is updated when synchronizing printers with the PrinterOn Directory. Disable this setting only if you want to manually control synchronization with the PrinterOn Directory.</td>
</tr>
<tr>
<td>Automatic Printer Synchronization</td>
<td>When checked, the component is automatically synchronized with the central printer list.</td>
</tr>
<tr>
<td>Synchronization Interval</td>
<td>The interval, in minutes, that the components is synchronized the central printer list.</td>
</tr>
</tbody>
</table>

6.2.5 Configuring service capabilities

The Advertised Capabilities panel of the General tab lets you advertise to client applications such as the PrinterOn Mobile App, what capabilities the service supports. The client app queries the PrinterOn Server to determine service capabilities and limitations and optimizes its behavior based on the response.

These settings are strictly informative, and are intended to provide a hint to client applications what they can expect from the PrinterOn service. However, advertising a capability does not guarantee that the feature is enabled in the relevant PrinterOn component. You should ensure that the values you configure here match the relevant feature configuration for your server.

**Note:** To view the Advertised Capabilities panel, you need to turn on Advanced view.
### 6.2.5.1 Advertised Capabilities settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Preview Enabled**            | When checked, informs the client app that server provides print preview data. The mobile app can only generate preview data for certain file formats (typically image formats and pdf). When server preview is available, the server provides preview data for other formats that the mobile app cannot generate locally.  

Currently, this setting is still in Beta and is disabled by default.  

Before enabling this setting, ensure that the Preview feature is properly configured in the PAS component settings:  

1. Click Advanced > Components, then click the Configure button adjacent to the PrintAnywhere Server.  

2. In the PAS configuration, click Job Settings, then locate the Preview Settings panel. |
| **Secure Release Anywhere Enabled** | When checked, informs the client app that the server supports Secure Release Anywhere feature, which allows users to print to a pool of printers and release the job to any of the printers in the pool.  

Secure Release Anywhere is an additional service that you can add to your PrinterOn service; it is not available by default. To enable Secure Release Anywhere for your service, contact PrinterOn. |
| **Directory Search Enabled**   | When checked, informs the client app that Directory Search is enabled on the server. Directory Search allows the mobile app to search your private PrinterOn Directory for printers on your network. This setting is enabled by default.  

Ensure that this Directory Search Enabled setting matches the value set in the CPS component settings:  

1. Click Advanced > Components, then click the Configure button adjacent to the Central Print Services.  

2. In the CPS component configuration, click Basic, then locate the Directory Search Enabled setting. |
### Setting | Description
--- | ---
**Doc API Enabled** | When checked, informs the client app that the PrinterOn service supports Document API printing, which is used by the [Mobile workflow](#), [Google Cloud Print workflow](#), and [iOS Native Print workflow](#). This setting is enabled by default.

Although this setting indicates whether Document API printing is enabled for the PrinterOn service as a whole, Document API printing support is currently set on a per printer basis, as part of the [Workflow options](#). If Document API printing is not set the same way across all printers, then you should set this setting to reflect the majority of your printers.

**Company Name** | Informs the client app of your company name.

**Max File Size** | Informs the client app what the maximum accepted file size is for a submitted print job, in MB. The default advertised maximum job size is 50 MB.

Ensure that the file size you set matches the [Max Job File Size](#) defined in PAS component settings:

1. Click [Advanced > Components](#), then click the [Configure](#) button adjacent to the PrintAnywhere Server.

2. In the PAS component configuration, click [Job Settings](#), then locate the [Max Job File Size](#) setting in the [Incoming Job Settings](#) panel.

**Deployment Mode** | Informs the client app that the PrinterOn service is deployed in the selected mode.

Ensure that the deployment mode you advertise matches the [Deployment Mode](#) defined in the [Deployment Mode Configuration](#) panel of the [Home > Licensing](#) tab.
6.3 Starting, stopping, or restarting the PrinterOn services

The Services tab allows you to quickly see the status of the component services installed with your PrinterOn Server.

To start, stop, or restart a PrinterOn service:

1. In the Configuration Manager, click Home > Services.

2. Click the appropriate button adjacent to the service that you want to start, stop, or restart.

6.4 Managing your PrinterOn license

From the Licensing tab, you can:

- review your license information
- update your PrinterOn Server license
- download your PrinterOn Server license
- modify your server deployment mode

6.4.1 Updating your PrinterOn license

The PrinterOn Server uses the information in your PrinterOn license file (PrinterOnConfig.txt) to determine what server features you can access. Your license will have a specified expiry date, after which you’ll have no access to the PrinterOn service.
If you change the conditions of your license by, for example, adding additional printers, or extending the term of your existing license, you must update your license in the Configuration Manager before the changes take effect.

**Note:** You MUST update your license before the term of the license expires to continue operation. The server will stop operation after the license expires.

To update your license file:

1. In the Configuration Manager, click **Home** > **Licensing**.
2. Locate the buttons at the bottom of the page.
3. Click **Update License**. The Upload A New License dialog appears.
4. Enter the path to your updated license file, then click **Upload**.
6.4.2 Viewing your license information

You can quickly review your current license information from the Configuration Manager.

To view license information:
1. In the Configuration Manager, click **Home > Licensing**.
2. Review the content in the following panels:
   - **License Details**: Provides information about what version and edition of the server you are permitted to install. This panel also specifies the expiry date of your license.
   - **License Features**: Provides information about which features of the PrinterOn Server you have permission to use.

6.4.2.1 License Details

<table>
<thead>
<tr>
<th>Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>The version of the server license. This value is <strong>not</strong> the version of the server software.</td>
</tr>
<tr>
<td>Edition</td>
<td>The edition of the PrinterOn Server that is associated with the license, for example, Express or Enterprise.</td>
</tr>
<tr>
<td>Start Date</td>
<td>The date on which your PrinterOn Server license was created.</td>
</tr>
<tr>
<td>End Date</td>
<td>The date on which your PrinterOn Server license expires.</td>
</tr>
<tr>
<td>Note:</td>
<td>You MUST update your license before the term of the license expires to continue operation. The server will stop operation after the license expires.</td>
</tr>
<tr>
<td>Site UID</td>
<td>A unique identifier used to set up your server. This ID is used during the installation to link your service to the PrinterOn Directory</td>
</tr>
<tr>
<td>Administrator Email</td>
<td>The email address of the administrator who created and manages the server license on the PrinterOn website.</td>
</tr>
</tbody>
</table>
6.4.3 Downloading your PrinterOn license

To download your license file:
1. In the Configuration Manager, click Home > Licensing.
2. Locate the buttons at the bottom of the page and click Download License.

6.4.4 Downloading a custom PrinterOn license

If you intend to install a Print Delivery Station on a remote server, you can simplify the setup by creating and downloading a custom license. A custom license lets you provide some additional details—such as the parent server URI or a PDS serial number—that are not typically included in the license file.

With this information, the installer is able to pre-populate some configuration settings.

Before you download a custom PrinterOn license, you should complete steps 1-5 of the Before you begin section in Installing and configuring a remote PDS.

To update your license file:
1. In the Configuration Manager, click Home > Licensing.
2. Locate the buttons at the bottom of the page.
3. Click **Download Custom License**. The Select PDS Servers dialog appears.

![Select PDS Servers](image)

4. In the **Parent Configurator URI** field, enter the IP address and port of your central PrinterOn Server machine on which you manage all your PrinterOn services. The default port is 8057.

This setting is optional:
- If you provide a value for this setting, it is added to the custom license file and is used to automatically link the remote server to the parent upon installation, so you don’t have to link to the Parent manually.
- If you leave the setting blank, the remote server is not linked upon installation; however, you can link it manually at any time.

5. Choose one or more PDS serial numbers to include in the license by moving an available serial number on the left to the list on the right.

Including multiple serial numbers allows you to use the same custom license for multiple remote installations.

6. Click **OK**.

7. Once downloaded, copy the license to the remote server(s) on which you intend to install a PDS instance. When prompted for the license file during the PDS installation, select this custom license file.

### 6.4.5 Modifying the server deployment mode

By default, the PrinterOn Server supports several deployment modes.

To change the deployment mode for your PrinterOn services:

1. In the Configuration Manager, click **Home > Licensing**, and locate the **Deployment Mode Configuration** panel.
2. Choose the **Deployment Mode** from the drop-down. You can deploy the PrinterOn Server in one of the following modes:
   - On-Premise
   - On-Premise with Cloud Config
   - Hybrid
   - Hybrid Direct
   
   Click on a deployment for more information.

3. In the **Internal Service URI** field, specify the address used by the subcomponents to communicate with the Central Print Services in a distributed deployment. The Internal Service URI should be the following value:
   
   \(<\text{PrinterOn\_Server\_IP}>/\text{cps/rest}\)
   
   4. Click **Apply Settings**.

### 6.4.5.1 On-Premise

The On-Premise deployment mode provides a fully isolated deployment with no external dependencies. All data is managed locally and all printer configuration is managed and stored in a local database.
6.4.5.2 On-Premise with Cloud Config

The On-Premise with Cloud Config deployment mode provides a secure deployment that can operate with no persistent Internet connections. All data is managed locally, but printer configuration is managed using the PrinterOn Directory.

This deployment mode allows printers to be pre-configured and backed up using the PrinterOn Directory. No document data or job information is sent to the PrinterOn Directory; the Directory stores only printer information.

The On-Premise with Cloud Config deployment mode also supports PrinterOn’s global driver distribution tools and automatic encryption key exchange between the Print Server and Release Stations.
6.4.5.3 Hybrid

In a Hybrid deployment, all communication with the PrinterOn Directory is proxied through a single Central Print Services instance. Each subcomponent communicates with the address specified in the Services Manager URI.
6.4.5.4 Hybrid Direct

In a Hybrid Direct deployment, all communication with the PrinterOn Directory occurs directly from the component to the PrinterOn Directory. This deployment mode is useful when using isolated components that cannot communicate with a single central server to be proxied.

6.5 Managing components

The Serial Numbers tab lets you add new components and manage which components are active.

6.5.1 Adding component instances

Your PrinterOn service can have multiple instances of Print Delivery Stations (PDS), Print Delivery Hubs (PDH), and PrintAnywhere Servers. To identify each instance, PrinterOn uses serial numbers. Each time you create a PDS, PDH, or PrintAnywhere Server, it receives a unique serial number.

To add instances of a component:

1. Click Home > Serial Numbers.
2. Scroll to the bottom of the page and click the button for the component that you want to add.

3. In the Add dialog, enter the **Server Description** for the PDS. The server description is used to identify the PDS, so it should be meaningful.

4. Click **Add**.

### 6.5.2 Changing the serial number of an active component

To change the serial number of a component:

1. In the Configuration Manager, click **Home > Serial Numbers**, and locate the **Serial Numbers In Use** panel.
2. Locate the component you want to change, then click the adjacent **Change** button.
3. In the **Choose a New Serial Number** dialog, in the **Serial Number** drop-down, choose a serial number of an inactive component, or select **New Serial Number** to create a new instance.
4. If you selected **New Serial Number**, specify a **Serial Number Label**.
5. Click **Apply Settings**.

### 6.5.3 Deleting unused serial numbers

Your PrinterOn license specifies how many instances of each component you are allowed to have. If you have an instance that is not in use, you can delete the component for that instance to free up the serial number so you can create a new instance.

To delete the serial number:

1. In the Configuration Manager, click **Home > Serial Numbers**, and locate the **Serial Numbers Not In Use** panel.
2. Locate the component you want to change, then click the adjacent **Delete** button.
Configuring authentication settings

The Authentication tab lets you specify the authentication method you want to use with your PrinterOn solution, and configure method-specific settings.

To configure the authentication method:

1. In the Configuration Manager, click **Authentication**. The Authentication tab appears.
2. In the **Selected Authentication Method** drop down, select the authentication method that you want to implement. You can choose from the following authentication methods:

- **Inactive**: Collects credentials, but does not validate them against a server. The values provided by the users are typically passed by the PrinterOn Server to third-party print management systems for tracking purposes.

- **Skip Login Screen**: No authentication is used.

- **LDAP/AD**: Authenticates users using the Lightweight Directory Access Protocol (LDAP) to communicate with an Active Directory (AD).
  When selected, you must configure the LDAP/AD settings. For configuration details, see [Configuring LDAP/AD authentication](#).

- **PrinterOn AAA Login (Custom)**: Uses a designated web service to perform user authentication.
  When selected, you must configure the LDAP/AD settings. For configuration details, see [Configuring PrinterOn AAA Login authentication](#).

- **PrinterOn ACL**: Authenticates the user’s login information against PrinterOn’s user database during printing.
  When selected, you must configure the LDAP/AD settings. For configuration details, see [Configuring PrinterOn ACL authentication](#).

- **Remote Authentication (SSO)**: Access is permitted based on authentication with a designated web server/service.

  **Note**: To use Remote Authentication/single sign on, your web server must authenticate the user and pass their identification to the PrinterOn Server with the REMOTE-USER HTTP header.

3. Configure the settings specific to the selected authentication method as described in the sections below.

4. Click **Apply Settings**.

### 7.1 Configuring LDAP/AD authentication

The PrinterOn Server can be configured to use the Lightweight Directory Access Protocol (LDAP) to communicate with an Active Directory (AD) or any other directory services to authenticate users. The LDAP/AD configuration allows you to use multiple LDAP servers for authentication, which provides redundancy while authenticating users if one of those servers is offline.
When multiple servers are used:

- The PrinterOn Server searches and validates user credentials by connecting to all configured LDAP simultaneously.
- The PrinterOn Server uses the results of the first successfully located/authenticated user.

Each server is independently configured and managed. You must configure an LDAP/AD profile for each LDAP server you add. You can then select the profile to configure the server-specific authentication settings.

To configure the authentication behavior for an LDAP/AD server:

1. On the Authentication tab, select LDAP/AD as your Authentication method. The LDAP/AD Settings panel appears.

2. In the LDAP/AD Server Profile drop-down, choose which LDAP Server you want to configure.

   Note: You must configure a server profile for each LDAP server you add to your solution. For more information, see Creating and managing LDAP/AD profiles.

3. Define your User Rules and Printer Access logic. For more information, see Configuring user rules and printer access.

4. To permit guests without credentials to print, check Guest Login Enabled, then click Manage Guest Settings to define the behavior. For more information, see Managing Guest LDAP settings.
5. Specify the **Trusted Application Behavior** *(Advanced view only)* as necessary. This setting defines permissions for print jobs submitted to the server by Google Cloud Print users.

You can choose from the following values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow All</td>
<td>Accepts all print requests. Anyone who has been authenticated by the GCP service to print to the published queues is able to submit jobs to the PrinterOn printers.</td>
</tr>
<tr>
<td>Reject All</td>
<td>Rejects all print requests. Disables submission of print jobs through the Google infrastructure to PrinterOn printers.</td>
</tr>
<tr>
<td>Authenticated</td>
<td>Accepts print requests submitted by print users who can be identified in the Active Directory. If the AD includes information pertaining to Google Cloud Accounts, then the administrator can control access to printers.</td>
</tr>
<tr>
<td>Authenticated and Guest</td>
<td>Accepts print requests submitted by print users who can be identified in the Active Directory or who are Guest users in the context of Printer.</td>
</tr>
</tbody>
</table>

6. To require the PrinterOn Server to use LDAP/AD credentials for mobile app users, check **Web Authentication Enabled for Mobile** *(Advanced view only).*

   **Note:** You should typically check this option. You should only disable this option if web-based authentication is configured through PrinterOn’s services to ensure that the mobile users are prompted to authenticate.

7. Click **Apply Settings**.

### 7.1.1 Creating and managing LDAP/AD profiles

The PrinterOn Server supports configuring and using multiple LDAP/AD servers at the same time. Each server is independently configured and managed, which provides redundancy while authenticating the user if one of those servers is offline. You must configure an LDAP/AD profile for each LDAP server you add.

The **LDAP/AD Server Profiles** drop-down list provides access to all configured LDAP servers. The settings below the list apply to the selected server.
Servers are identified by their profile name, which you configure in the LDAP/AD Profile Details page. You should make sure each server has a unique name so you can easily identify which LDAP server you configuring.

7.1.1.1 Adding an LDAP/AD server profile

To add an LDAP/AD server profile:
1. In the LDAP/AD Settings panel, click Add. The LDAP/AD Profile Details page appears, with some default settings values provided.
2. Configure the LDAP server connection information as necessary.
3. Once you have confirmed the profile is correctly configured, click Apply Settings.

7.1.1.2 Deleting an LDAP/AD server profile

To delete an LDAP/AD server profile:
1. In the LDAP/AD Settings panel, select the server profile to remove from the LDAP/AD Server Profiles drop-down.
2. Click Delete.

7.1.1.3 Editing an LDAP/AD server profile

To edit an LDAP/AD server profile:
1. In the LDAP/AD Settings panel, select the server to modify from the LDAP/AD Server Profiles drop-down.
2. Click Edit. The LDAP/AD Profile Details page appears.
3. Configure the LDAP server connection information as necessary.
4. Once you have confirmed the profile is correctly configured, click Apply Settings.
7.1.2 Configuring LDAP/AD server profiles

LDAP/AD server profiles are configured on the LDAP/AD Profile Details page.
# Configuring authentication settings

## 7.1.2.1 LDAP/AD Profile settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>When checked, enables the profile.</td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the configuration profile.</td>
</tr>
<tr>
<td>Mode</td>
<td>The mode of LDAP authentication. The mode can be one of:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Advanced</strong>: Validates the user's login and password against your LDAP server. This authentication method also allows the PrinterOn Server to look up other user attributes such as a user's email address, network login, or even a custom attribute field. The supplied Bind DN and Bind Password information is used to locate and authenticate users.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Basic</strong>: Validates that the user credentials exist and are valid against a given LDAP server. Instead of retrieving the user's email address from the LDAP server, it is composed using their login ID and a specified domain name. This authentication method binds the user to the LDAP server using simple authentication, and assumes that your LDAP server uses (or extends) the standard schema. If you have a custom LDAP deployment, this authentication may not work without further modification.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: With Basic Authentication, User Lookup integration for email printing is not possible.</td>
</tr>
<tr>
<td>LDAP/AD Server URI</td>
<td>The IP address or DNS name of the LDAP/AD server to be used for authentication.</td>
</tr>
<tr>
<td>Enable SSL</td>
<td>When checked, the LDAP/AD server uses SSL. Enable this option if your LDAP server requires SSL connections.</td>
</tr>
<tr>
<td>Search DN(s)</td>
<td>The distinguished names (DN) representing the branch from which the search for the users occurs. If you selected <strong>Advanced</strong> LDAP mode, searches look for users in this branch and below of the LDAP tree. This field supports multiple Search DNs. Separate multiple DNs with a semi-colon (for example, ou=OrganizationalUnit;dc=domain).</td>
</tr>
</tbody>
</table>
## Configuring authentication settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Administrator Bind DN**      | The distinguished name (DN) representing the login used to bind the LDAP server for searches. This option is used to search for users and user information in the LDAP/AD server. It can be represented in two ways:  
  - server\username  
  - cn=display name,ou=OrganizationalUnit,dc=domain  
  If your LDAP server allows anonymous searches, leave this entry blank. |
| **Administrator Password**     | The password for the login given in **Administrator Bind DN** above. If your LDAP server allows anonymous searches, leave this entry blank. |
| **Domain Name to Append to User ID** | The domain name used in conjunction with the user’s ID to create their email address. The domain name is appended to the user’s ID to make a valid email address. For example, if the user ID is *jsmith* and you set the domain name to *myorganization.com*, then the email address is:  
  jsmith@myorganization.com |
| **Bind Users**                 | When checked, users are authenticated and bound to the LDAP Server. Any requests received are not trusted and require full authentication.         |
| **Prepend Windows Domain Name to User UD** | When checked, a domain name or other qualifier is prepended to the user ID when submitted with the print job. This user ID is transmitted throughout the workflow and communicated with any third-party print management systems to assist in reporting and user tracking. |
| **Follow LDAP Referrals**      | When checked, LDAP referrals are followed when searching for users on an LDAP/AD server. This option should generally be checked, unless your LDAP/AD server specifically requires that referrals be ignored. |
| **E-mail Address Wildcard Search** | When checked, wild cards can be used in searching. |
| **Prepend “smtp:” to E-Mail Address Searching** | When checked, smtp: is prepended to email addresses. Some LDAP/AD environments contain multiple user IDs for each user. When performing a user lookup using a supplied email address, prepending smtp: to the user ID assists in differentiating between users.  
  This setting should be enabled when using user email in an AD environment. |
Enable Configuration Manager Access

When checked, the LDAP/AD profile is used as a PrinterOn Administrator profile, allowing you to designate a set of users who can administer the PrinterOn Server. These users can log into Configuration Manager using their standard credentials, rather than logging in through the built-in Root user account.

If you want to use LDAP/AD for authentication when logging into Configuration Manager, you **must** enable this setting.

For more information about how to configure the Configuration Manager to authenticate against an LDAP/AD server, see Using LDAP/AD for Configuration Manager authentication.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Configuration Manager Access</td>
<td>When checked, the LDAP/AD profile is used as a PrinterOn Administrator profile, allowing you to designate a set of users who can administer the PrinterOn Server. These users can log into Configuration Manager using their standard credentials, rather than logging in through the built-in Root user account. If you want to use LDAP/AD for authentication when logging into Configuration Manager, you <strong>must</strong> enable this setting. For more information about how to configure the Configuration Manager to authenticate against an LDAP/AD server, see Using LDAP/AD for Configuration Manager authentication.</td>
</tr>
<tr>
<td>User ID Attribute</td>
<td>The LDAP/AD server attribute field containing the user login IDs. This attribute is appended to the Base DN in order to do user lookup in the Directory.</td>
</tr>
<tr>
<td>User Email Attribute</td>
<td>The LDAP/AD server attribute field containing the user's email address. This attribute is appended to the Base DN in order to fetch the user’s email address once they are validated against the Directory.</td>
</tr>
<tr>
<td>User Display Name Attribute</td>
<td>The LDAP/AD server attribute filed containing the full display name.</td>
</tr>
<tr>
<td>User First Name Attribute</td>
<td>The LDAP/AD server attribute field containing the user’s first name.</td>
</tr>
<tr>
<td>User Surname Attribute</td>
<td>The LDAP/AD server attribute field containing the user’s surname or last name.</td>
</tr>
<tr>
<td>User Phone Number Attribute(s)</td>
<td>The LDAP/AD server attribute field containing the user’s phone number.</td>
</tr>
</tbody>
</table>
7.1.3 Configuring user rules and printer access

User rules allow you to control which users can access and discover printers. On your LDAP/AD server, you can organize your users into Organizational Units (OUs) and Groups. You can then create user rules that link those OUs or Groups to PrinterOn printer departments (logical groupings of PrinterOn Printers).

**Note:** For more information about creating and managing Printer Departments, see Managing printer departments.

For example, you could organize all members of your Marketing team into the Marketing OU, then create a printer department called Marketing, which contains all marketing team’s printers. You can then create a user rule that limits access to the Marketing printer department to those users who are part of the Marketing OU. Every user who is part of the Marketing OU can access and print to the printers in associated department.

User rules also impact the discovery and search capabilities from the various workflows, including the Web Print and Mobile workflows. When searching for printers using the PrinterOn mobile app, or automatically discovering devices using PrinterOn Discovery, users are only presented with those printers to which they have been granted access.

User rules also apply when using technologies such as Apple AirPrint devices. Due to its implementation constraints, the PrinterOn Server cannot limit what printers are visible to iOS devices. However, it can restrict a user's ability to print to only those printers to which they have access. Although users can see all the printers that have been enabled for iOS users, they can only submit print jobs after successfully authenticating.

7.1.3.1 Configuring access control

To configure access control:

1. In the LDAP/AD Settings panel, from the User Rules and Printer Access dropdown, select either Organizational Unit or Group.

**Note:** Rules must be based on either Organizational Units (OUs) or Groups; there cannot be a mix of both.
2. Click **Manage User Rules**. The User Rule page appears.

3. In the **User Rule To Manage** panel, select the rule you want to modify, or select **Create New Rule** to create a new one.

4. In the **Rule Settings** panel, define the **Rule Name**. You can modify the value to change the name of an existing rule.
   - If you are creating a rule for an Organizational Unit, configure the following settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Organization Unit (OU)</strong></td>
<td>A list of the automatically located OUs in the currently active LDAP configuration. You can use an existing OU to quickly configure a rule, or you can manually enter a fully qualified OU.</td>
</tr>
<tr>
<td><strong>Recursive</strong></td>
<td>When checked, CPS traverses the OU tree to match users that may be in sub-units of the parent OU as well. In the example below, if MainDept is configured, only <em>User1</em> and <em>User2</em> will be valid if Recursive is not checked. <em>User3</em> and <em>User4</em> will be valid if Recursive is enabled.</td>
</tr>
</tbody>
</table>

   - MainDept
     - User1
     - User2
   - SubDept
     - User3
     - User4
Configuring authentication settings

- If you are creating a rule for a Group, configure the following settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group</td>
<td>A list of the automatically located Groups in the currently active LDAP configuration. You can use an existing Group to quickly configure a rule, or you can manually enter a fully qualified Group/CN.</td>
</tr>
</tbody>
</table>

5. In the **Linked Printer Departments** panel, check the printer departments that you want to link to the rule.

6. Click **Apply Settings**.

### 7.1.4 Managing Guest LDAP settings

The PrinterOn Server can control how Guest Users are identified when reporting and integration with output/print management solutions.

To configure the LDAP guest workflow:

1. In the LDAP/AD Settings panel, check **Guest Login Enabled**.
2. Click **Manage Guest Settings**.
3. In the LDAP Guest Settings dialog, specify the **Guest Behavior**. You can choose one of the following behaviors:
   - **Do Nothing**: The job owner name for all guest jobs is set to GuestUser.
   - **Default User ID**: The job owner name for all guest job submissions is set to the value you specify in the **Guest User ID** field. The Guest User ID is used for all Guest Users and is the same for all workflows. This value is also delivered to third-party solutions, and appears in the PrinterOn Reports.
   - **Prompt**: The user is prompted to supply the name to use as the job owner. When you select **Prompt**, you can define the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prepend Guest User ID</td>
<td>All guest jobs are prepended by the value set in this field. If left blank, nothing is prepended to the ID that the user defines.</td>
</tr>
<tr>
<td>Ensure User ID is unique</td>
<td>When checked, the PrinterOn Server verifies that the username supplied by the guest user does not match any existing usernames within the LDAP/AD structure.</td>
</tr>
</tbody>
</table>

4. Click **Apply Settings**.
7.2 Configuring PrinterOn AAA Login authentication

The PrinterOn AAA Login authentication method uses a designated web service to perform user authentication. When enabled, all other authentication methods are deactivated.

**Note:** To use this authentication method, you must integrate with PrinterOn’s Job Accounting API. For more information, see Click Apply Settings.

To configure the authentication behavior for an AAA Login:

1. On the Authentication tab, select AAA Login (Custom) as your Authentication method. The Custom User Authentication Settings panel appears.

2. In the User Authentication URL field, specify the URL of the web service performing the authentication. The PrinterOn Server redirects users to this URL during login.

   **Note:** This authentication scheme must be configured in conjunction with PrinterOn’s hosted configuration interface.

3. Click Apply Settings.

7.3 Configuring PrinterOn ACL authentication

The PrinterOn Access Control Login (ACL) authentication method authenticates the user’s login information against PrinterOn’s user database during printing. You can manage users in the PrinterOn user database at the PrinterOn.com web admin portal at www.printeron.com/administrators.
When enabled, all other authentication methods are deactivated.

To configure the authentication behavior for PrinterOn ACL Login:
2. To permit guests without credentials to print, check Guest Login Enabled.
3. Click Apply Settings.

7.3.1 Managing users

You manage PrinterOn users from the PrinterOn web administration site.
2. On the Home page, choose Manage Access Control Lists.
3. In the **New ACL Name** field, specify the name of your Access Control list, then click **New ACL**. The ACL is added to the list above.

Each printer can have a unique list of users. Users can be repeated to allow access to multiple printers, or you can choose to group printers by departments.

4. Select your ACL in the list, then click **Manage Printers**.

5. Group printers by user groups if required to allow similar users to all have access to the same printers.

6. Click **Save**.

7. Select your ACL in the list, then click **Manage Users**.
8. Add individual user email addresses. When users are added, they receive an automated message requesting them to create a password with PrinterOn. This password is used to authenticate print requests.

**Note:** Print jobs submitted via email must be sent from the address specified here.

9. Click **Save**.
Integrating user lookup extensions

The Integration tab contains advanced integration capabilities that you can configure to allow PrintAnywhere Server to identify users. You can choose between the following integration extensions:

- **User Lookup**: The PrintAnywhere server uses the user’s email address to query an LDAP/AD server to determine the user’s domain account user ID.

  If you select User Lookup, you’ll need to configure the lookup rules for both identified and unidentified users. For more information, see Configuring User Lookup integration.

- **User ID from Email Address**: The PrintAnywhere server extracts the user ID from the user’s email address. No additional configuration is required.

### 8.1 Configuring User Lookup integration

User Lookup integration is typically used when also integrating your service with a third-party print management server. With User Lookup integration, the PrintAnywhere server searches for user account information in an LDAP/AD server.

When a user (typically an email print user) submits a job to PrintAnywhere, the PrintAnywhere server uses the user’s email address to query an LDAP/Active Directory server to locate the user’s domain account name. The PrintAnywhere server then associates the print job with the domain account.

This information also allows you to define behavior for identified and unidentified users.
To configure user lookup integration:

1. In the Configuration Manager, click **Authentication > Integration**.
2. In the **Integration Type** drop-down, select **User Lookup**. The User Lookup and User Lookup Rules panels appear.
3. **Configure the User Lookup settings**.
4. **Configure the User Lookup Rules**. You can define different user lookup rules for each type of user to specify how the PrintAnywhere processes jobs in each case.
5. Click **Apply Settings**.

### 8.1.1 Configuring the User Lookup settings

To configure the User Lookup Settings:

1. In the User Lookup panel, select **Enable User Lookup**.
2. Click **Edit** to define the Service API configuration. The User Lookup Settings dialog appears.
3. Configure the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain Filter</td>
<td>A semicolon-separated list of email domain(s) for which the PrintAnywhere server will search the Active Directory/LDAP server. For example: printer.com;printeron.net Users submitting jobs from email addresses from the specified email address domains are looked up in the Active Directory/LDAP server, and if found, treated as Identified users. Users whose email domains are not included in the list are treated as Unidentified users.</td>
</tr>
<tr>
<td>API Lookup URL</td>
<td>The URL of the server that is hosting the user lookup API. Typically this is the CPS server installed with your PrinterOn Server. The default URL is: <a href="http://localhost/cps/cpsapi">http://localhost/cps/cpsapi</a></td>
</tr>
<tr>
<td>API Username</td>
<td>A valid username configured in the CPS server for use with the API. The <strong>username</strong> must be configured on your CPS server prior to using the API.</td>
</tr>
</tbody>
</table>
4. Click **Test** to test the configuration.
5. When you have confirmed the lookup settings are correctly configured, click **Apply Settings**.

### 8.1.2 Configuring the behavior for identified and unidentified users

Users may be classified as either Identified or Unidentified:

- **An Identified User** is one that can be located using the User Lookup API. To be classified as an Identified User, the API must successfully respond and provide a valid username for the user. When a user is identified, the job owner information for the print job is set to the retrieved username.
- **An Unidentified User** is any user for which the server cannot locate a username associated with the user's email address.

You can define different user lookup rules for each type of user to specify how the PrintAnywhere processes jobs in each case.

When configuring behavior for a type of user, you can also configure behavior specific to either Guest printers or non-Guest printers. For example, you may choose to reject jobs submitted by identified users to Guest printers, but to accept jobs submitted by unidentified users.
To configure the processing behavior for each user type:

1. In the User Lookup Rules panel, click the Identified Users sub panel.
2. For Guest printers, from the Release Action Mode drop-down, specify how the server processes jobs from the specified user type to this printer type.

**Note:** When configuring job release behavior, you must ensure your Print Delivery Station is capable and configured to handle managed job behavior.

You can specify one the following behaviors:

<table>
<thead>
<tr>
<th>Release Action Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>No overriding action is taken for jobs submitted for this user type; jobs are processed and released as configured for the specific printer.</td>
</tr>
<tr>
<td></td>
<td>No authentication is performed.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This option disables Web-Based authentication, if enabled in CPS or PrinterOn’s Administration Web Dashboard.</td>
</tr>
<tr>
<td>Default – Enable Web Authentication</td>
<td>No overriding action is taken for jobs submitted for this user type; jobs are processed and released as configured for the specific printer.</td>
</tr>
<tr>
<td></td>
<td>However, users must authenticate themselves before the job is printed. Users will receive an email with a link to the Authentication Server to allow them to provide their credentials.</td>
</tr>
<tr>
<td>Automatic Release (Override)</td>
<td>Jobs are automatically released from the Print Delivery Station to the configured Print queue.</td>
</tr>
<tr>
<td></td>
<td>This is the most common configuration when integrating with a third-party print management solution.</td>
</tr>
<tr>
<td>Hold in PDS (Override)</td>
<td>Jobs are held by the Print Delivery Station. Users must use a PrinterOn job release solution to access the print jobs.</td>
</tr>
<tr>
<td>Reject Jobs</td>
<td>Jobs will be rejected by the server if they are from the specified user type.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For Unidentified Users, you should choose this setting if you only wish to access jobs from users in your LDAP or AD server.</td>
</tr>
</tbody>
</table>
3. Specify additional behavior for identified users:
   • Whether to return a Release Code to the user.
   • Whether to set the job owner to the PrinterOn generate Privacy Release Code

4. Repeat Steps 2 and 3 for **Non-Guest Printers**.

5. Click the **Identified Users** sub panel and repeat Steps 2-4.

6. In the **Default Failure Action Mode**, specify the behavior of the PrintAnywhere server if it is unable to communicate with the lookup service. If you specify a value of **Off**, all print jobs are rejected.

7. Click **Apply Settings**.
Advanced clustering and document processing scalability

You can improve your PrinterOn service’s performance and resilience by adding additional PrintAnywhere Processing Server or Status Server components to your deployment and configuring them as clusters. Enabling and configuring basic clustering with the PrinterOn server is simple and can be completed with minimal effort and time. The solution has been designed to minimize configuration and maintenance.

**Note:** Advanced clustering of PrintAnywhere servers is only available for PrinterOn Enterprise Edition.

Creating a server cluster for document processing provides the following benefits

- Provides additional server capacity and performance.
- Optimizes server utilization by distributing documents across multiple PrintAnywhere components.
- Provides additional redundancy.
- Simplifies maintenance.

### 9.1 PrintAnywhere Server clustering overview

The PrinterOn Server offers two forms of clustering depending on your deployment needs and requirements:

- Document processor clustering, which increases job processing capacity.
• Advanced redundancy clustering, which provides backup service that helps to simplify service upgrades and to maintain service continuity should issues occur with physical hardware.

9.1.1 Document processor clustering

Basic clustering involves attaching a second PrintAnywhere Processing Server to the primary server’s Status Server. The Processing Server is responsible for converting/rendering documents supplied by the user. The Status Server is responsible for distributing jobs across available Processing Servers.

9.1.2 Server redundancy clustering

Server Redundancy Clustering involves installing and associating a second PrintAnywhere Status Server to the primary PrintAnywhere Server’s Status Server. The Status Server is responsible for managing incoming job requests and distributing jobs across available Processing Servers to be printed.

9.1.3 Clustering requirements

PrinterOn supports deploying the necessary Document Processing Clustering components on the same physical server as your primary PrinterOn Server using separate virtual machines. This approach allows the deployment to minimize additional costs and yet can still provide the same performance as a separate physical server.

To deploy a cluster, you’ll need to meet the following requirements:

• You must have an additional virtual machine prepared with the necessary applications for processing documents.
• The host physical server must have sufficient memory to allocate the minimum recommended memory to each virtual machine.
• Each virtual machine must be addressable on the network, since the Status Server must be able to respond and communicate with each Processing Server and the Processing Server must be able to independently resolve and communicate with the Status Server.
9.1.4 Print job processing in a clustered deployment

When configuring your service for clustering or diagnosing issues, it is useful to understand the behavior of the servers. The following provides a brief overview of the clustering behavior.

- The Status Server delivers jobs to Processing Servers in the order they appear in the Configuration Utility.
- The Status Server delivers new jobs to the least busy server each time a new job arrives. As a result, in a low volume deployment with clustering enabled, the first Processing Server in the list will receive the bulk of the jobs.
- The Processing Server reports its capabilities to the Status Server during a synchronization process. This process:
  - Informs the Status Server which applications and formats are supported by each configured Processing Server.
  - Allows the Status Server to determine whether a Processing Server is running.
  - Occurs every 2 minutes, allowing the Status Server to update its state information when idle.
- Each time a job is submitted or completed, the Processing Server informs the Status Server of its current state, allowing the Status Server to maintain an up to date state of all Processing Servers.
- If a configured Processing Server is not available when the Status Server is started, the Status Server continues to check its status every 2 minutes. When the Processing Server starts, the Status Server automatically detects it and starts delivering print jobs to that server.
- If all Processing Servers in a cluster are unavailable, the Status Server rejects incoming jobs.

9.2 Creating and configuring a server cluster

To create a PrintAnywhere server cluster, you’ll need to complete the following tasks:

1. **Add a new PrintAnywhere Server instance to your PrinterOn server** for each new PrintAnywhere component you intend to install. Adding a new instance creates a new PrintAnywhere serial number. When you install a PrintAnywhere component on a remote server, you’ll choose a serial number to assign to that component.
2. **Install each new PrintAnywhere Server component** on a remote server. Each time you install a PrintAnywhere Server, you’ll connect it to one of the serial numbers you received when adding a new instance to your PrinterOn service.
3. **Add your PrintAnywhere servers to a cluster.**

**Note:** Because each PrintAnywhere Server is installed on a remote server, you must also ensure that the Internal Service URI value is correctly configured. The Internal Service URI is used by the subcomponents to communicate with the Central Print Services in a distributed deployment.

### 9.2.1 Adding a new PrintAnywhere Server to your PrinterOn service

To set up a cluster of PrintAnywhere servers, you must have multiple PrintAnywhere servers. Each PrintAnywhere server you deploy must have a unique serial number. You can add a new PrintAnywhere Server to your service and receive the serial number you need.

Once you have a serial number for each PrintAnywhere Server instance you intend to deploy, you can copy the updated license file to your remote servers, install the PrintAnywhere component software on each server, and then configure your server cluster(s).

To add a PrintAnywhere Server instance:

1. Click **Home > Serial Numbers**.
2. Scroll to the bottom of the page and click **Add PrintAnywhere Server**.

3. In the Add PrintAnywhere Server dialog, enter the **Server Description**. The server description is used to identify the PrintAnywhere Server, so it should be meaningful.

4. Click **Add**. The PrinterOn Server generates a new serial number for an additional PrintAnywhere Server instance.

   Each time you add a new PrintAnywhere instance, the PrinterOn Server adds the new serial number to your license file. When complete, download your updated license and copy it to each server you intend to install a PrintAnywhere Server on.
9.2.2 Installing the PrintAnywhere component on the remote server(s)

**Note:** Before you install the PrintAnywhere software on a remote server, ensure that you have downloaded your license file on the parent PrinterOn server and copied it to the server on which you are installing the PrintAnywhere component. The installer needs the license files to allow you to associate the installed software with one of your PrintAnywhere Server serial numbers.

To install a PrintAnywhere component:

1. Run `PSIM.exe` to launch the PrinterOn Installation Wizard. The wizard guides you through the installation of the PrinterOn software.
2. Click **Next** at the Welcome screen, then accept the License Agreement to proceed with the installation.
3. On the License Summary File screen, browse to your PrinterOn license file and select it, then click **Next**.

**Note:** Ensure that your license file contains multiple PrintAnywhere serial numbers.
4. On the Setup Type screen, choose **Custom**, then click **Next**.

5. In the Select Features screen, select only **PrintAnywhere**, then click **Next**.

6. Follow the installation wizard until you get to the Serial Numbers screen.

7. On the Serial Numbers screen, select the serial number for the PrintAnywhere instance you are installing on the remote host, then click **Next** to install the PrintAnywhere Server.

8. When the installation is complete, click **Finish**, and then reboot the computer.
9. If you choose, you can connect this server to a parent configuration server. For more information, see Connecting remote servers to a parent Configuration Manager.

9.2.3 Adding servers to a cluster

To connect servers:

1. In the Configuration Manager, click Advanced > Clustering.
2. From the Select A Server drop-down, select a server to configure. The drop-down lists all connected servers.

9.2.3.1 Adding Processing Servers

Processing servers increase the capacity of the solution. By default, the local Processing Server should be connected.

To add a processing server:

1. In the Configuration Manager, click Advanced > Clustering.
2. Click Add Processing Server. The Processing Server Information dialog appears.
3. To add a Processing Server that is already managed by the Configuration Manager:
   a) In the Select A Server drop-down, select a known server from the list.
   b) Configure the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Host Name</td>
<td>When checked, the server’s hostname is used for communication. Otherwise, the IP address is used. Note: When operating, the server performs a reverse DNS lookup to validate the IP address provided. You should ensure that the IP address is valid and routable between servers.</td>
</tr>
<tr>
<td>Reciprocate Connection</td>
<td>Copies this configuration to all other Processing Servers managed by the Configuration Manager.</td>
</tr>
</tbody>
</table>

4. To add a Status server that is not managed by the Configuration Manager:
   a) In the Select A Server drop-down, select Manual Entry.
   b) Configure the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>When checked, the server is enabled.</td>
</tr>
</tbody>
</table>
5. Click **Add**.

### 9.2.3.2 Adding Status Servers

Status Servers increase add redundancy to the solution as well as capacity. The local Status Server is NOT added to the list. Status Servers share job information during job processing. Add incoming jobs are received by a Status Server before being directed to the least busy Processing Server.

To add a Status Server:

1. In the Configuration Manager, click **Advanced > Clustering**.
2. Click **Add Status Server**. The Status Server Information dialog appears.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Machine Host Name</td>
<td>The network hostname or IP address of the server running the Processing Server that you are adding to the cluster.</td>
</tr>
<tr>
<td>Request Port</td>
<td>The network port number on which the Processing Server listens for requests.</td>
</tr>
<tr>
<td>Server Serial Number</td>
<td>The serial number of the Processing Server that is being connected to the Status Server. Each Server should have a unique serial number; this value must match the value on the destination server. For information on acquiring additional PrintAnywhere Serial numbers, see <a href="#">Creating and configuring a server cluster</a>.</td>
</tr>
</tbody>
</table>
3. To add a Status Server that is already managed by the Configuration Manager:
   a) In the **Select A Server** drop-down, select a known server from the list.

   ![Status Server Information](image)

   b) Configure the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use Host Name</strong></td>
<td>When checked, the server’s hostname is used for communication. Otherwise,</td>
</tr>
<tr>
<td></td>
<td>the IP address is used.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>When operating, the server performs a reverse DNS lookup to validate the IP</td>
</tr>
<tr>
<td></td>
<td>address provided. You should ensure that the IP address is valid and routable</td>
</tr>
<tr>
<td></td>
<td>between servers.</td>
</tr>
<tr>
<td><strong>Reciprocate Connection</strong></td>
<td>Copies this configuration to all other Status Servers managed by the</td>
</tr>
<tr>
<td></td>
<td>Configuration Manager.</td>
</tr>
</tbody>
</table>
4. To add a Status server that is not managed by the Configuration Manager:
   a) In the Select A Server drop-down, select Manual Entry.

   ![Status Server Information](image).

   b) Configure the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>When checked, the server is enabled.</td>
</tr>
<tr>
<td>Machine Host Name</td>
<td>The network hostname or IP address of the server running the Status Server</td>
</tr>
<tr>
<td></td>
<td>that you are adding to the cluster.</td>
</tr>
<tr>
<td>Request Port</td>
<td>The network port number on which the Status Server listens for requests.</td>
</tr>
<tr>
<td>Server Serial Number</td>
<td>The serial number of the Status Server that is being connected to the</td>
</tr>
<tr>
<td></td>
<td>Processing Server.</td>
</tr>
</tbody>
</table>

   Each Server should have a unique serial number; this value must match the value on the destination server. For information on acquiring additional PrintAnywhere Serial numbers, see Creating and configuring a server cluster.

   5. Click Add.
Adding a Print Delivery Hub

PrinterOn’s Print Delivery Hub (PDH) is intended to provide a simple and reliable solution to deliver print jobs to printers and MFPs that are distributed across numerous disparate and isolated networks. The PDH acts as a centralized distribution server, coordinating the delivery of print jobs between PrinterOn’s print servers and clients and PrinterOn’s print release station software.

Note: The Print Delivery Hub component is only available for PrinterOn Enterprise Edition.

When deploying a cloud printing solution, printers and MFPs can be distributed globally. However, users still want access these devices much like any other local device. The PDH offers a solution for enabling these print devices without the need for significant network reconfiguration. The Print Delivery Hub provides access to these devices while maintaining a high degree of security.

The PDH server accepts and holds print jobs generated and transmitted by PrinterOn’s clients until they are retrieved for downloading and release by PrinterOn’s Print Deliver Station (PDS) component. The PDS software initiates the communication from within the network and behind the firewall. The PDS can also be configured to communicate using commonly available ports such as 80 and 443. This combination minimizes the network configuration required to deliver print jobs from one network to another.

The PDH is based on the industry standard Internet Printing Protocol (IPP). PrinterOn has extended and enhanced the protocol with a number of PrinterOn extensions for improved print job data security (encryption), data compression, and collection of print job
metadata that is used for print job tracking and integration with print management and other cost recovery solutions.

10.1 System capacity

A single PDH can handle up to 5,000 PDS servers concurrently and at least 100,000 print jobs per day. Please note that one PDS may provide access to multiple printers or MFPs.

Increasing the number of PDH servers used (either in a single cluster or in a two cluster setup) allows for a larger number of PDSs to be handled concurrently.

10.2 Network layout

Without using any PDH servers, the PrinterOn system sends print jobs directly to a PDS. Print jobs can also be sent through PrinterOn’s hosted PDH service, which is typically used with PrinterOn hosted and managed services.

For On-Premise deployments that require print jobs to be delivered to printers installed in disparate networks (that is, network segments in separate physical locations, possibly different cities, states, or countries), it may not be possible for the PrinterOn server or the PrintWhere driver to deliver print jobs directly to the PDS. In these cases, you can deploy a PDH service to provide simplified access to remote printers and MFPs connected to PDS servers. In this arrangement, print jobs are delivered to the PDH. PDS servers communicate with the PDH to detect and download the print jobs.

The PDH service can be installed in a central network operating center and must be accessible over the network to the PrintAnywhere Server, desktop PrintWhere clients, and PDS servers. Because the PDH is the only service in this network configuration that requires incoming network traffic access, changes to the network should be minimal.

10.3 Common deployment scenarios

The PDH can be deployed as a single server, or within a cluster of PDH servers. Deploying multiple PDH instances in either a one-cluster or two-cluster configuration can increase the availability of the printing service, increase overall capacity, and allow for part of the system to be disabled for maintenance purposes.
Note that clients such as PrintAnywhere and the PrintWhere Universal Print Driver can be configured to communicate with a PDH server and also configured to communicate directly to a PDS. This configuration option is managed on a per-printer basis. The software first attempts to communicate directly to PDS (which provides a performance advantage). If the software is unable to contact the PDS, it uses the configured PDH as an alternate route to deliver print jobs.

10.3.1 Single server deployment

The simplest way to enable printers and MFPs in separate networks is to deploy a single dedicated PDH. The server is deployed and configured so that it is accessible by both the PrinterOn Enterprise server and the remote print locations.

Each PrinterOn virtual printer is configured to deliver print jobs to the Print Delivery Hub and each Print Delivery Station will be configured to download print jobs from the PDH.

10.3.2 Two node redundant deployment

In this example, two PDH servers are configured to operate as a single system. This deployment allows for future growth by adding additional nodes to either server to expand the number of peers in the cluster. In this configuration, print jobs are duplicated on each server. By replicating the servers, the overall service is more resilient to hardware failures that may occur on either server.
Please note that both PDH servers must be configured to ensure the cluster is addressable via a single DNS entry. A load balancer must also be configured to distribute network traffic between the servers. The load balancer distributing traffic to the PDH nodes would have to direct traffic away from the node being taken down for maintenance and redirect that traffic to the remaining nodes.

10.3.3 Multiple redundant PDH clusters

This configuration is an expansion of the previous example. Additional PDH cluster peers can be added to each PDH cluster to increase overall capacity. Each cluster peer shares a common storage subsystem where print job data and metadata files are stored. The common storage subsystem is typically a network shared file system.

Each peer in the cluster can be deployed either on a distinct virtual machine on a single physical server or on a separate physical server.
10.4 Configuring Internet communications

The **Internet Communication** tab contains the main settings controlling incoming and outgoing communications used by the PDH software.

To configure Internet communication for a PDH:

1. In the Configuration Manager, click **Advanced > Components**.
2. Click the **Configure** button adjacent the **Print Delivery Hub** component. The PDH component configuration appears.
3. Click **Internet Communication**.

4. Configure the settings in the following panels:
   - **Licensing**
   - **Web Services Manager**
   - **Network and Broadcast Settings**
   - **Thread Pool**
   - **Print Delivery Station Communication**
   - **XMPP Notifications**

5. Click **Apply Settings**.

### 10.4.1 Network Identification and Access

PrinterOn print clients, such as PrintAnywhere and PrintWhere, and PDS deployments are designed to access the PDH service as a single entity. As a result, when deploying a multi-node setup, care must be taken to ensure the cluster is addressable via a single DNS entry and that load balancers accept traffic for that name and forward the traffic appropriately to each PDH server in the cluster.
10.4.2 Configuring PDH licensing and the Web Services Manager

The **Licensing** and **Web Services Manager** panels allow you to specify the PDH serial number required to activate the PDH, and the URL or the Web Services Manager connection information.

![Licensing and Web Services Manager panels](image)

10.4.2.1 Licensing and Web Services Manager settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial Number</td>
<td>This is the serial number of PDH license and can be obtained from PrinterOn under the Software tab once you log in as an administrator. This is required to activate the Print Delivery Hub.</td>
</tr>
<tr>
<td>Services Manager URL</td>
<td>The URL of the Web Services Manager. The Services Manager controls how the components of the server communicate to retrieve printer information and license information.</td>
</tr>
</tbody>
</table>

10.4.3 Configuring Network and Broadcast Settings

The **Network and Broadcast Settings** panel defines the ports used by the PDH. The PDH listens on the configured ports for requests from Print Delivery Stations. You can set up to three ports, and specify whether which ports are enabled, and which ports are configured to use SSL.

![Network and Broadcast Settings](image)

By default, the **Default IPP Port** is configured to be port 631, which is the port typically assigned to the Internet Printing Protocol (IPP).
Often, Print Delivery Stations are deployed in locations whose networks may offer limited or controlled access to the Internet. To provide reliable communication, you can configure and enable up to two additional ports.

Typical installations use port 80 and port 443, as these are the most commonly accessible. Port 443 is usually configured to use SSL. Enabling ports 80 and 443 provides the highest accessibility for remote PDS deployments.

If you check SSL for a port, you must also configure the PDH SSL tab. For more information, see Configuring SSL settings for your PDH.

10.4.4 Configuring Thread Pool settings

The **Thread Pool** panel shows the configuration parameters for the worker thread pool used by PDH for handling incoming communication traffic.

<table>
<thead>
<tr>
<th>Thread Pool (per Communication Port)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min Threads</td>
</tr>
<tr>
<td>Max Threads</td>
</tr>
<tr>
<td>Socket Backlog</td>
</tr>
<tr>
<td>Socket Shutdown Delay (ms)</td>
</tr>
<tr>
<td>Idle Time (ms)</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>50</td>
</tr>
<tr>
<td>50</td>
</tr>
<tr>
<td>0</td>
</tr>
<tr>
<td>5000</td>
</tr>
</tbody>
</table>

**Note:** Only administrators who have a good understanding of networking and server management should modify the settings in this panel. PrinterOn has chosen default values that should satisfy the requirements of most installations.

The **Min Threads** and **Max Threads** settings control the size of the thread pool used for each of the communication ports enabled in the Network and Broadcast panel. A connection is used while print client software such as PrintAnywhere queries for printer status and availability and while a print job is being transmitted. These worker threads are also used between PDHs in peer and cluster communications.

Threads are returned to the pool when the operations are complete. The default values should satisfy most installation requirements. Installations that handle a heavy traffic load may benefit from increasing the Max Threads setting.
### 10.4.4.1 Thread Pool settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min Threads</td>
<td>The initial number of threads allocated by the software. This setting helps prevent thread starvation at startup time.</td>
</tr>
<tr>
<td>Max Threads</td>
<td>The upper limit to the number of simultaneous connections each port can accommodate.</td>
</tr>
<tr>
<td>Socket Backlog</td>
<td>The number of &quot;half-open&quot; sockets each port can support. Half-open sockets are those that are in the first stages of establishing a communication channel between the print client and the PDH server.</td>
</tr>
<tr>
<td></td>
<td>The default value of 50 should be suitable for most installations. Network setups that experience large latencies (100 ms or more) between PDH and print clients might benefit from a larger <strong>Socket Backlog</strong> value, such as 100.</td>
</tr>
<tr>
<td>Socket Shutdown Delay</td>
<td>The amount of time the PDH server keeps the socket open after transmitting the final data and before fully closing the socket. The delay period helps to ensure an orderly teardown of the socket.</td>
</tr>
<tr>
<td></td>
<td>As with the <strong>Socket Backlog</strong> parameter, setups that experience large latencies (100 ms or more) might benefit from a larger <strong>Socket Shutdown Delay</strong>. If print clients are experiencing errors such as unexpected socket termination, increasing this value to 500 ms might improve the communication process.</td>
</tr>
<tr>
<td>Idle Time</td>
<td>The socket timeout period used by the threads in the thread pool.</td>
</tr>
<tr>
<td></td>
<td>While waiting for a response from the IPP client software, if no data packet is received for this amount of time, it is assumed that the client has disconnected ungracefully. In that case, the socket is closed and the worker thread is recycled back into the thread pool, ready to service another communication request.</td>
</tr>
</tbody>
</table>
10.4.5 Configuring Print Delivery Station Communication settings

The **Print Delivery Station Communication** panel provides additional configuration and control over how Print Delivery Stations (PDS) and other printer agents access and communicate with a Print Delivery Hub (PDH).

### 10.4.5.1 Print Delivery Station Communication settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enhanced Client Authentication Policy</td>
<td>The type of authentication required in order to connect to PDH and download print jobs. The available options are <strong>Always</strong>, <strong>Optional</strong>, and <strong>Never</strong>.</td>
</tr>
<tr>
<td>Password</td>
<td>A password that ensures communication between Print Delivery Hub and Print Delivery Station is secure. The <strong>Password</strong> value entered in PDH must be entered into the corresponding <strong>Password</strong> field in the Print Delivery Station Configuration Settings.</td>
</tr>
<tr>
<td>Accept Jobs For Any Print Delivery Station</td>
<td>When checked, the PDH accepts any print jobs destined for any Print Delivery Station. Having this option enabled is the simplest method to deploy a PrinterOn Service. When unchecked, each agent must register their PrinterOn printers with the PDH server. The PDS and PDH software performs the registration automatically when configured to do so; the PDS registers its associated printers when it checks for pending jobs to download. The PDH server rejects any jobs destined for a printer that is not registered with the server. It is generally recommended to enable this option when initially deploying your service to simplify the configuration and management process.</td>
</tr>
</tbody>
</table>
10.4.6 XMPP notifications

The XMPP panel controls settings pertaining to the optional XMPP Server integration feature. When enabled, this feature causes PDH to connect to an XMPP Server—using the connection details specified in panel—to publish print job availability information.

Installation, configuration and administration of the XMPP Server are beyond the scope of this document. Corresponding XMPP Notification settings must be entered into the Agent.

10.5 Configuring PDH job storage

The Job Storage tab contains the settings controlling where print job data files are stored and certain rules for accepting print jobs and purging them if they have been abandoned.

To configure job storage settings for a PDH:

1. Log in to the Configuration Manager.
2. Click Advanced > Components.
3. Click the Configure button adjacent the Print Delivery Hub component. The PDH component configuration appears.
4. Click Job Storage.

5. Configure the settings in the following panels:
   - Print Processing
   - Unclaimed job Handling
   - Advanced Network Settings
6. Click Apply Settings.
## 10.5.1 Configuring Print Processing settings

The **Print Processing** panel controls settings regarding job data storage and rules used to determine whether to access or reject new jobs.

### 10.5.1.1 Print Processing settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Print Job Directory</strong></td>
<td>Where the print job data and metadata files are stored. When implementing a PDH cluster this storage location must be available to all PDH peers. This is typically a network storage location accessible to all nodes in a cluster.</td>
</tr>
<tr>
<td><strong>Enforce Job Size Limit</strong></td>
<td>When checked, the <strong>Job Size Limit</strong> is enforced and applied to new jobs.</td>
</tr>
<tr>
<td><strong>Job Size Limit</strong></td>
<td>When <strong>Enforce Job Size Limit</strong> is enabled, PDH rejects incoming print jobs whose size exceeds the specified limit.</td>
</tr>
<tr>
<td><strong>Reject Duplicate Jobs</strong></td>
<td>When checked, duplicate print jobs are immediately rejected by the system. Print jobs are identified by Job ID number (as defined by the Internet Printing Protocol (IPP) RFC.) The cause of duplicate print jobs is usually an unreliable network connection that causes the software that transmitted the print job to miss the acknowledgment that the print job had been received properly. When that happens, the print client software can re-transmit the print job.</td>
</tr>
<tr>
<td><strong>Accept Jobs from PrinterOn Clients Only</strong></td>
<td>When checked, incoming print jobs from non-PrinterOn Clients are not accepted. Otherwise, the PDH server will accept IPP compliant print jobs from any IPP print client.</td>
</tr>
</tbody>
</table>
10.5.2  Configuring Unclaimed Job Handling settings

The **Unclaimed Job Handling** panel controls the feature whereby unclaimed print jobs are automatically purged from PDH if they have remained on the server beyond the specified interval.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use Print Job Data Compression</strong></td>
<td>How print job data compressions is managed by PDH. There are three options:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Optionally</strong>: Indicates that the PDH supports compression and the submitting client can optionally compress new prints jobs prior to submitting to PDH. Release station clients, such as PDS, can choose to download the print data in a compressed or uncompressed state depending on the capabilities of the print device.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Never</strong>: PDH reports to the sending client that compression is not supported. Release station software, such as PDS, will receive all jobs in an uncompressed state when downloading jobs.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Always</strong>: PDH reports to the sending client that compression is supported. Release station software, such as PDS, will receive all jobs in a compressed state when downloading jobs.</td>
</tr>
</tbody>
</table>

For best compatibility, this setting should be set to **Optionally**.

**10.5.2.1  Unclaimed Job Handling settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Purge Unclaimed Jobs</strong></td>
<td>When checked, PDH automatically deletes jobs that have not been downloaded by a PDS client.</td>
</tr>
<tr>
<td><strong>Job Retention Period</strong></td>
<td>The length of time that the PDH server stores print jobs before it deletes them.</td>
</tr>
</tbody>
</table>
10.5.3 Advanced Network Settings

The **Advanced Network Settings** panel provides additional advanced network configuration options, generally intended for an advanced or customized deployment.

### 10.5.3.1 Advanced Network Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Server Download Buffer Size</strong></td>
<td>The size of the download buffer. This setting correlates to the TCP Window Size, and is provided to help address network scenarios, such as high bandwidth and also high latency. Too high a value here wastes memory and can decrease throughput if the network suffers too many packets that need to be retransmitted.</td>
</tr>
<tr>
<td><strong>Enable Download Pacing Feature</strong></td>
<td>When checked, the PDH monitors the amount of data waiting in its (internal) transmit buffer. When the transmit buffer gets 75% full, PDH slows the rate at which more data is loaded into the buffer. When the transmit buffer goes back below the configured threshold, the PDH increases the rate at which data is provided to the buffer. The goal is to prevent PDH from buffering the entire print job data payload in memory, reducing memory usage by PDH. The Download Pacing Feature is enabled by default and is expected to be useful in nearly every situation. To allow the PDH Admin to troubleshoot situations where print job data download speeds appear to be highly variable, the feature can be disabled as a diagnostic aid.</td>
</tr>
</tbody>
</table>
10.6 Logging

The Logging tab contains the settings pertaining to application and debug logging. Log files are created as required and are automatically deleted. The PDH server will automatically delete older log files to ensure the total size of all log files stays within the Total Size Limit setting.

When a new log file is created, the log file name is created using the time the file was created as a unique filename. Log file names take the form:

ListeneryyyyMMddhhmmss.sss.log

where:

- **Listener**: the base name for all PDH log files
- **yyyy**: year
- **MM**: month (January = 01)
- **dd**: day (first of the month = 01)
- **hh**: hour (24-hour clock)
- **mm**: minute
- **ss.sss**: second (including milliseconds)

To configure logging settings for a PDH:

1. Log in to the Configuration Manager.
2. Click Advanced > Components.
3. Click the Configure button adjacent the Print Delivery Hub component. The PDH component configuration appears.
4. Click Logging.

![Debug Logging Configuration](image-url)
5. Configure the Debug Logging settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log Level</td>
<td>The level of detail to use for logging across all components. Higher levels of logging are most useful when troubleshooting.</td>
</tr>
<tr>
<td>Output Directory</td>
<td>The folder where the log files are written.</td>
</tr>
<tr>
<td>Maximum File Size</td>
<td>The maximum file size of an individual log file. When a log file’s size reaches the Maximum File Size value a new log file will be automatically created.</td>
</tr>
<tr>
<td>Total Size Limit</td>
<td>The total size of all the log files that can exist at any one time. If creating a new log file causes the total storage used by the system to exceed this limit, the oldest log file is automatically deleted.</td>
</tr>
</tbody>
</table>

6. Click **Apply Settings**.

### 10.7 Configuring SSL settings for your PDH

The **SSL** tab allows you to configure the PDH to support SSL. Enabling SSL for your PDH server provides additional security for print jobs delivered through the server. When SSL is enabled and configured for the PDH, clients submitting print jobs to the PDH server use a secure SSL channel. Print Delivery Station deployments downloading print jobs to be printed also use SSL.

To configure SSL settings for a PDH:

1. Log in to the Configuration Manager.
2. Click **Advanced > Components**.
3. Click the **Configure** button adjacent the **Print Delivery Hub** component. The PDH component configuration appears.
4. Click SSL.

5. Configure the settings in the following panels:
   - SSL Certificate Keystore
   - Enter SSL Information

6. Click Apply Settings.

10.7.1 SSL Certificate Keystore

If any port is configured to use SSL, the SSL Certificate Keystore panel becomes active, allowing you to set details for the SSL Certificate.

PDH uses a standard format file for storing SSL Certificates, known as a keystore. As defined by Oracle (Sun), the keystore file can contain multiple certificates.
10.7.1.1 SSL Certificate Keystore settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keystore File</td>
<td>The full path and file name for the keystore file used to store the SSL Certificate.</td>
</tr>
<tr>
<td></td>
<td>• Click the Browse button (…) to select an existing file.</td>
</tr>
<tr>
<td></td>
<td>• Click <strong>Create</strong> to create a new keystore file or a new key within an existing keystore file. It is recommended that the PDH SSL Certificate be stored in its own keystore file, not the cacerts file in the underlying JRE installation. When you click <strong>Create</strong>, a dialog box appears prompting you for required and optional data used when generating an SSL Certificate.</td>
</tr>
<tr>
<td>Keystore Passphrase</td>
<td>The passphrase (or password) for the overall keystore file. The default value is password. If using an existing keystore file, you must specify the correct passphrase here.</td>
</tr>
<tr>
<td>Key Name</td>
<td>The key (or certificate) name used to identify the certificate that PDH is to use.</td>
</tr>
<tr>
<td>Key Passphrase</td>
<td>The passphrase (or password) for the certificate that PDH is to use. The default value is password.</td>
</tr>
</tbody>
</table>

10.7.2 Entering SSL Information

The **Enter SSL Information** panel lets you provide the information associated with your certificate.
10.8 Configuring scalability behavior

The **Scalability** tab lets you configure the behavior of PDH to use clustering to deploy a system that is both fault-tolerant and scalable. The **Scalability** settings only come into effect when you create a PDH cluster. To create a cluster, you must add peer nodes on the **Cluster Peers** tab. For more information, see Adding Cluster Peers. By default, PDH is configured to operate as a standalone server.

Cluster Peers are PDH nodes that share a common storage subsystem where print job data and metadata files are stored. The common storage subsystem is typically a network shared file system. Each peer can create, read, write, or delete any print job on the common storage subsystem when accepting print jobs from print clients and making them available for download by Print Delivery Station deployments. When a PDH node creates, updates, or deletes a job, that PDH node sends each configured peer a message detailing the update. The messages between Cluster Peers are called Peer Notification messages.

A maximum of two PDH clusters can be defined for a particular PDH installation. When Remote Hub Replication is enabled, print jobs are automatically copied between PDH clusters. The PDH node that receives the print job from the print client transmits a message to the Remote Hub alerting that cluster of the newly received print job. The PDH node that received this update copies the print job to its own Print Request Directory (which may be shared with other Cluster Peers.) Update messages between PDH clusters are called Replicate Job messages.

The maximum number of PDH nodes comprising a PDH setup is limited to nine. Take care to ensure that each PDH node is assigned a unique Peer ID number.

At software startup and, optionally, at configurable intervals thereafter, the software ensures the entire job list is fully synchronized between all active PDH nodes.

To configure Scalability settings for a PDH:
1. Log in to the Configuration Manager.
2. Click **Advanced > Components**.
3. Click the **Configure** button adjacent the **Print Delivery Hub** component. The PDH component configuration appears.
4. Click **Scalability**.

5. Configure the settings in the following panels:
   - **Cluster Security**
   - **Cluster Configuration**
   - **Remote Hub Replication**
   - **Remote Hub Synchronization**

6. Click **Apply Settings**.

10.8.1 Configuring Cluster Security and Cluster Configuration
10.8.1.1 Cluster Security and Cluster Configuration settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enhanced Cluster Authentication Policy</td>
<td>How cluster authentication is enforced. This setting has the following possible values:</td>
</tr>
<tr>
<td></td>
<td>• Never – Authentication between cluster peers is not enforced.</td>
</tr>
<tr>
<td></td>
<td>• Optional – Authentication between cluster peers is validated if a password is supplied.</td>
</tr>
<tr>
<td></td>
<td>• Always – Authentication between cluster peers is always validated.</td>
</tr>
<tr>
<td>Cluster Communication Password</td>
<td>The password that should be used when cluster peers communicate. Each cluster peer should have the same password configured.</td>
</tr>
<tr>
<td>Peer ID For This Computer</td>
<td>The PDH node number for this instance of the software. You must ensure that each PDH instance is assigned a unique ID number.</td>
</tr>
</tbody>
</table>

10.8.2 Configuring Remote Hub Replication

When Remote Hub Replication is enabled, print jobs are automatically copied between PDH clusters. The PDH node that receives the print job from the print client transmits a message to the Remote Hub alerting that cluster of the newly received print job. The PDH node that received this update copies the print job to its own Print Request Directory (which may be shared with other Cluster Peers.) Update messages between PDH clusters are called Replicate Job messages.
10.8.2.1 Remote Hub Replication settings.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>When checked, Remote Hub Replication is enabled.</td>
</tr>
<tr>
<td>Pacing Delay</td>
<td>The amount of time to wait between Replicate Job messages during software startup or during cluster resynchronization, when enabled. This delay interval helps prevent network saturation between PDH nodes. The default value of 50 ms is usually sufficient for most environments. If your service experiences significant load, and print jobs between PDH clusters are significantly different, increasing this value to 75 or 100 is recommended.</td>
</tr>
<tr>
<td>Remote Hub URI</td>
<td>The address of the remote PDH cluster as specified via the Scheme, Address and Port fields.</td>
</tr>
</tbody>
</table>

10.8.3 Configuring Remote Hub Resynchronization

When enabled, this feature causes the entire job list held in memory to be replicated with the other PDH Cluster. During normal operation, a PDH cluster will automatically inform its paired cluster that jobs have arrived, been downloaded, or deleted. Resynchronization occurs at a set time interval to ensure that both clusters are mirrored and compensate for any variations.

10.8.3.1 Remote Hub Resynchronization settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>When checked, Remote Hub Synchronization is enabled.</td>
</tr>
<tr>
<td>Resynchronization Interval</td>
<td>The amount of time between resynchronization events. The timer starts after the software has started running. Decreasing the time frame between resynchronization will require additional network resources.</td>
</tr>
</tbody>
</table>
10.8.4 Adding Cluster Peers

The Cluster Peers tab lets you add Peer PDH nodes to your cluster, to your configure network settings for communicating with PDH Peer instances.

A cluster peer, also referred to as a node, is a fully functional Print Delivery Hub Server. A PDH Peer is intended to provide increased reliability, maintainability and performance. For a multi-node setup, care must be taken to ensure the cluster is addressable via a single DNS entry and that load balancers accept traffic for that name and forward the traffic appropriately to each and any PDH server in the cluster.

Having more than one node in a single cluster has a few benefits:

- It allows the cluster to handle more simultaneous connections (from PrinterOn Print Delivery Station software).
- It makes the cluster more resilient to failure of an individual node due to system failures.
- It also allows an administrator remove, disable, or update individual nodes without impacting the overall cluster.

To add a cluster peer:

1. Log in to the Configuration Manager.
2. Click Advanced > Components.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use One-Shot Resynchronization</td>
<td>When checked, a single resynchronization message is used to update the other PDH Cluster regarding the entire list of jobs known to this PDH node. Otherwise a separate Replicate Job message is transmitted for each job known to this PDH node.</td>
</tr>
</tbody>
</table>

One-shot synchronization sends a single, large update message to a paired cluster. A large message is more susceptible to transmission failure on a congested network segment, but is generally faster than using separate Replicate Job messages for each known job. Smaller update messages are more reliably transmitted and received, but have a higher overhead due to establishing a new connection for each update. This means the resynchronization process takes longer to complete.

If the network between PDH clusters is high quality and high performance, enabling this option is recommended.
3. Click the **Configure** button adjacent the **Print Delivery Hub** component. The PDH component configuration appears.

4. Click **Cluster Peer**. The Cluster Peers tab displays a list of all the peers in the cluster. By default, there are no peer nodes, since the PDH is configured to operate as a standalone server.

5. Click **Add**. The **Add Cluster Peer** panel appears.

6. Configure the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enabled</strong></td>
<td>Allows you to enable or disable communication to the Peer.</td>
</tr>
<tr>
<td><strong>Scheme</strong></td>
<td>Allows you to specify http:// or https://.</td>
</tr>
<tr>
<td><strong>Address</strong></td>
<td>Allows you to configure the address of the Peer. You can use a DNS name or an IPv4 Address.</td>
</tr>
<tr>
<td><strong>Port</strong></td>
<td>Allows you to specify the port number. Note that the port number specified is used to notify Cluster Peers of updated job information. Port 631 is recommended, as it is required in each PDH deployment.</td>
</tr>
</tbody>
</table>
7. To test the connection to the peer node, click **Test**.
8. Click **Save**.

## 10.9 Proxy Configuration

The **Proxy** tab allows you to configure HTTP Proxy settings.

To configure logging settings for a PDH:

1. Log in to the Configuration Manager.
2. Click **Advanced > Components**.
3. Click the **Configure** button adjacent the **Print Delivery Hub** component. The PDH component configuration appears.
4. Click **Proxy**.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Proxy Enabled</strong></td>
<td>When checked, the use of an HTTP Proxy is enabled.</td>
</tr>
<tr>
<td><strong>Proxy Address</strong></td>
<td>Specify the DNS name or IPv4 address of your proxy server.</td>
</tr>
<tr>
<td><strong>Proxy Port</strong></td>
<td>Specify the port number that should be used to communicate with the proxy.</td>
</tr>
</tbody>
</table>
6. Click **Apply Settings**.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User Name</strong></td>
<td>The login/username to use when authenticating against the proxy server.---If your proxy does not require Authentication parameters, you can enter any values here and they will be ignored. PDH supports Basic Authentication and NTLM Authentication. For NTLM Authentication, the User Name usually includes a Domain followed by a User ID, as in domain\userID. (Note the single backslash.)</td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>The password to use when authenticating against the proxy server.</td>
</tr>
</tbody>
</table>
Configuring your mail server for PrinterOn email printing

The PrinterOn server has been designed to provide email-based printing capabilities as part of an overall Enterprise printing platform. PrinterOn recognizes that deployment and configurations within an organization may vary significantly and has developed a solution that is flexible and adaptable to your specific requirements.

In addition, the PrinterOn server has been designed to be as unobtrusive as possible, allowing for a deployment that requires minimal changes to your existing installation. This chapter outlines a number of deployment options to let select the deployment that best suits your needs.

11.1 Maintaining email security

The PrinterOn Server only performs basic validation of the email address and domain. It is typically the responsibility of the upstream email server and configured SPAM software to ensure the validity of the incoming email addresses prior to being delivered to the PrinterOn server.

The PrinterOn server integration for email printing is one where the Enterprise Server simply acts as a mail client, much like Outlook or any other mail client. Like these clients, they assume the mail server is providing a level of security prior to delivering the messages. This approach allows the PrinterOn server to be flexible while using existing SPAM or virus investments.
11.2 Recommended message routing configurations

The PrinterOn server monitors a single mailbox to receive and process email print requests. To facilitate receiving email print requests, different routing configurations are available depending on the number of printers supported within your installation.

The simplest deployment option is to create a mailbox on your existing mail server to receive print email print requests. In this deployment scenario, the PrinterOn server will act as a simple mail client and monitor for new email messages in the mailbox.

However, the recommended scenario is to separate email printing and the PrinterOn server from your corporate mail server. In this scenario, you install a mail server, such as the free Windows based hMailServer (www.hmailserver.com) directly on the PrinterOn server.

This mail server is dedicated for receiving and processing all email print requests. All email print messages are routed directly to this mail server to be processed by the PrinterOn server. If your organization uses Microsoft Exchange, you may consider configuring an Internal Relay Domain to direct messages to a subdomain such as print.company.com.

11.2.1 Configuring a printing-specific email subdomain

Regardless of where the mail server is located, it is typically beneficial to segregate email print jobs from other email traffic within your network. In addition to making it easier for users to identify print locations, segregating email traffic offers additional flexibility in how and where your email print jobs are processed.

PrinterOn recommends that you configure a subdomain within your existing domain structure to support email printing. For example, if your company domain is www.companyxyz.com, you might set up your email printing subdomain as
@print.companyxyz.com. By adding this subdomain for printing, you also have the option of deploying a separate email server dedicated to email printing.

For example, your primary corporate email may be managed by a server for all messages routed to @companyxzy.com. You may then install a dedicated mail server (possibly a low-cost or free alternative such as hMailserver) on the PrintAnywhere server itself.

Mail received at the @print.companyxyz.com subdomain can be routed to this mail server for handling only email print jobs. This approach also aligns with the use of email server catch-alls, as emails received by the mail server should be intended for email printing.

11.3 Creating a printing-dedicated mailbox

To allow seamless emailing printing, the PrinterOn server establishes a connection to the internal mail server using standard connection protocols (IMAP4, MAPI, EWS, and Notes Domino). With this type of integration, the PrinterOn server uses a single mailbox on the mail server to scan for new email print jobs to be printed.

When email printing is enabled on multiple printers, only one mailbox on the mail server is scanned for new mail. This means you need to configure a way for all the emails to all printers to be delivered to that mailbox without changing the email address associated with each printer. You can do this mailbox configuration in several ways, depending on the specific environment:

• In non-ActiveSync environments with small numbers of printers, you can create aliases on a single mailbox.

• When creating aliases is not possible or inconvenient, such as in Microsoft Exchange ActiveSync environments and non-ActiveSync environments with many printers, you can:
  • create a distribution group for each printer, and add the mobile print mailbox to it.
  • set up automatic email forwarding to the mobile print mailbox.

11.3.1 Setting up a mailbox alias in non-ActiveSync environments

When supporting a small number of printers, the simplest configuration option is to associate multiple email addresses with a single mailbox on your mail server. This option involves the least amount of configuration for the mail server administrator.
PrinterOn provides two email addresses for every PrinterOn enabled printer. The first is a 12-digit numeric email address such as 300234123432@company.com. The other is a configurable alpha-numeric address such as boardroom-printer@company.com. The numeric address is guaranteed to be unique and will never change throughout the lifespan of the printer listing in the PrinterOn database. The alpha-numeric address is configurable in the Configuration Manager and may be modified in the future.

When configuring a small number of printers, you can retrieve the address from PrinterOn’s web admin portal site and add these as optional addresses for your email print mailbox. Users can then submit print jobs to these addresses and all emails will be routed to the common mailbox.

11.3.2 Creating a mailbox when aliases cannot be used

If you are enabling email printing and also using Microsoft’s ActiveSync to allow mobile devices to connect to your Exchange server, the email alias deployment option described above may not meet all your requirements. Microsoft’s ActiveSync does not support the same capabilities when connecting with some iOS and Android devices. In these cases, all emails are delivered to the default email address configured for the mailbox, as opposed to the address entered by the user. The Hide from Exchange Address lists option is ignored.

There are two ways to workaround this issue:

- Create a distribution group for each printer, and add the mobile print mailbox to it.
• Set up automatic email forwarding to the mobile print mailbox.

These mailbox configurations are supported for both ActiveSync and non-ActiveSync environments.

11.3.2.1 Creating distribution groups and lists

To create a distribution group in Microsoft Exchange:

1. Create one main mobile print mailbox. This mailbox can be named anything, for example, printeronmailbox@mycompany.com.

2. Ensure this mailbox is completely created by logging in to the mailbox at least once using the Outlook client or OWA access.

3. For each printer email address, create a new distribution group in the Exchange server.

4. Each Alias should reflect the printer name as created at PrinterOn.com.
   For example, boardroom-printer@company.com

5. Once the group is created, modify the Distribution Group properties as necessary.

6. Go to the Members tab and click Add.
7. Select the main mobile print mailbox that was created in Step 1.

When completed, email messages are copied to the main print mailbox while the original recipient and sender information remain unchanged.

11.3.2.2 Setting up mail forwarding rules

To configure automatic mail forwarding:

1. Create individual user mailboxes for each printer and one for a main mobile print mailbox.
   This main mobile print mailbox can be named anything, for example printeronmailbox@mycompany.com.
2. Ensure each mailbox is completely created by logging in to the mailbox at least once using a service like Outlook.
3. For each mailbox, on the Exchange server, access the Delivery Options.
   a) In the Delivery Options, check **Forward to;**, then browse for the central PrinterOn mailbox created in Step 1.
b) Leave the option Deliver message to both forwarding address and mailbox unchecked.

When completed, messages are copied to the main print mailbox and the original recipient and sender information is preserved.

11.4 Configuring email catch-alls

Email catch-alls are an important part of the PrinterOn email printing solution. The PrinterOn email plugin monitors a single mail folder for incoming messages. By using the mail server’s catch-all capabilities, users can simply forward emails to the mail server using the printer’s name in the email address. The catch-all directs all unknown emails to the mailbox monitored by the PrinterOn server.

How you configure an email server’s catch-all feature varies from server to server.

11.4.1 Setting up a catch-all in Exchange 2010

For information about setting up a catch-all in Microsoft Exchange 2010, see the Knowledge Base article at the following location:

11.4.2 Setting up a catch-all in hMailServer

The hMailServer (http://www.hmailserver.com) provides a simple configuration to support catch-alls. To configure catch-alls with the hMailServer review the following steps.

**Note:** Before setting up the catch-all, you must first configure the PrinterOn server email print mailbox.

To set up a catch-all in hMailServer:

1. Launch the hMailServer administrator interface.
2. Click **Domains**, then click the domain configured for email printing.
3. Click **Advanced**.
4. In the **Catch-all address** fields, enter the email address and domain of the PrinterOn mailbox.
5. Click **Save**.

11.4.3 Setting up a catch-all in Lotus Domino

The Lotus Domino server provides a simple configuration to support catch-all using the **Group** feature. When you create a new Group in the Domino Directory, you can specify the
registered users to be added to the group. There is no limit to the number of Domino user accounts that you can attach to a group.

Notes:
- Make sure that you have Editor or Author access with GroupCreator privileges.
- Before setting up the catch-all, you must first configure the PrinterOn server email print mailbox.

To set up a catch-all in Lotus Domino:
1. From the Domino Administrator or Web Administrator, click People & Groups.
2. Select Domino Directories > Groups, then click Add Group.
3. On the Basics tab, configure the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Name</td>
<td>A descriptive name for the group.</td>
</tr>
<tr>
<td>Group Type</td>
<td>The type of group. Set to Mail Only to define the group as a mailing list.</td>
</tr>
<tr>
<td>Mail Domain</td>
<td>The Domino domain associated with the group’s email address.</td>
</tr>
<tr>
<td>Internet Address</td>
<td>The email address for the group. This should be the printer’s email address as defined on the PrinterOn.com PrintSpot; each printer must have a mail account created.</td>
</tr>
<tr>
<td>Members</td>
<td>The users of the mailing list. The PrinterOn mailbox must be added as a member.</td>
</tr>
</tbody>
</table>
Configuring your mail server for PrinterOn email printing

Note:

- **Internet Address** must be the printer's email address as defined on the PrinterOn.com PrintSpot. Each printer must have a mail account.

- The **Members** list must include the mailbox to be monitored by the PrinterOn server.
Many administrators and service providers leverage centralized notification and monitoring tools. PrinterOn’s own Public Cloud services leverage monitoring tools such as Nagios, which is configured to monitor key metrics for a variety of systems. These tools provide notifications to IT support based on configured thresholds and service metrics.

The following information is provided as a reference only; each implementation and service design inherits certain custom characteristics. The following should be used as a guideline for your own monitoring service and should be adapted to your specific needs.

The tables below describe certain thresholds that may be used to initiate an automated notification to support staff. The values provided do not always indicate a problem or fault; they are sometimes indicative of possible future problems or may simply indicate that the server status or logs should be reviewed manually.
### 12.1 PrintAnywhere Status Server

<table>
<thead>
<tr>
<th>Monitoring Metric</th>
<th>Thresholds and Action(s)</th>
<th>Frequency recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory</td>
<td>• &gt; 100MB Allocated</td>
<td>• Check 5 min interval</td>
</tr>
<tr>
<td></td>
<td>• Clear PrintAnywhere JobRecords Folder</td>
<td>• Memory consistent across 2 intervals</td>
</tr>
<tr>
<td></td>
<td>• Restart Service</td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>• &gt; 50% utilization</td>
<td>• Check 5 min interval</td>
</tr>
<tr>
<td></td>
<td>• Restart Service</td>
<td>• Memory consistent across 2 intervals</td>
</tr>
<tr>
<td>Process Failure</td>
<td>• Allow Auto-restart up to 2 times</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Subsequent failures require service cleanup and log review</td>
<td></td>
</tr>
</tbody>
</table>

### 12.2 PrintAnywhere Processing Server

<table>
<thead>
<tr>
<th>Monitoring Metric</th>
<th>Thresholds and Action(s)</th>
<th>Frequency recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory</td>
<td>• &gt; 250MB Allocated</td>
<td>• Check 5 min interval</td>
</tr>
<tr>
<td></td>
<td>• Clear PrintAnywhereStorage Folder</td>
<td>• Memory consistent across 2 intervals</td>
</tr>
<tr>
<td></td>
<td>• Restart Service</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Restart Server</td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>• &gt; 50% utilization</td>
<td>• Check 5 min interval</td>
</tr>
<tr>
<td></td>
<td>• Restart Service</td>
<td>• Consistent CPU usage across 2 checkpoints</td>
</tr>
<tr>
<td></td>
<td>• Clear PrintWhere Spool Directory</td>
<td>• CPU spikes for up to 4 minutes generally accepted</td>
</tr>
<tr>
<td></td>
<td>• Restart Server</td>
<td></td>
</tr>
</tbody>
</table>
12.3 PrintAnywhere PASPort Server

<table>
<thead>
<tr>
<th>Monitoring Metric</th>
<th>Thresholds and Action(s)</th>
<th>Frequency recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Failure</td>
<td>• Allow Auto-restart up to 1 time&lt;br&gt;The Processing Server contains complex server management tools to attempt to self-heal the print subsystem.&lt;br&gt; If the Processing Server cannot fix itself, the Print Subsystem it will shut itself off.&lt;br&gt; • After auto-shutoff review logs for re-registration notifications&lt;br&gt; • Restart Server and re-install PrintWhere</td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>• &gt; 100MB Allocated&lt;br&gt; • Restart Service&lt;br&gt; • Restart Server</td>
<td>• Check 5 min interval&lt;br&gt; • Memory consistent across 2 intervals</td>
</tr>
<tr>
<td>CPU</td>
<td>• &gt; 50% utilization&lt;br&gt; • Restart Service&lt;br&gt; • Restart Server&lt;br&gt; • &gt; 5 messages pending in the managed mailbox inbox&lt;br&gt; • Restart Service&lt;br&gt; • Clear Monitored Mailbox of messages.</td>
<td>• Check 5 min interval&lt;br&gt; • Consistent CPU usage across 2 checkpoints&lt;br&gt; • CPU spikes for up to 4 minutes generally accepted</td>
</tr>
<tr>
<td>Process Failure</td>
<td>• Allow Auto-restart up to 1 time&lt;br&gt; • After auto-shutoff review logs for re-registration notifications</td>
<td></td>
</tr>
</tbody>
</table>
### 12.4 CPS Tomcat

<table>
<thead>
<tr>
<th>Monitoring Metric</th>
<th>Thresholds and Action(s)</th>
<th>Frequency recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory</td>
<td>• &gt; 200MB Allocated</td>
<td>• Check 5 min interval</td>
</tr>
<tr>
<td></td>
<td>• Restart Service</td>
<td>• Memory consistent across 2 intervals</td>
</tr>
<tr>
<td>CPU</td>
<td>• 50% utilization</td>
<td>• Check 5 min interval</td>
</tr>
<tr>
<td></td>
<td>• Restart Service</td>
<td>• Memory consistent across 2 intervals</td>
</tr>
<tr>
<td>Process Failure</td>
<td>• Allow Auto-restart up to 2 times</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Subsequent failures require service cleanup and log review</td>
<td></td>
</tr>
</tbody>
</table>

### 12.5 PWCRoute.exe

<table>
<thead>
<tr>
<th>Monitoring Metric</th>
<th>Thresholds and Action(s)</th>
<th>Frequency recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory</td>
<td>• &gt; 250MB Allocated</td>
<td>• Check 5 min interval</td>
</tr>
<tr>
<td></td>
<td>• Restart Processing Server Service</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Clear PrintWhere Spool Directory</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Restart Sever</td>
<td>• Memory consistent across 2 intervals</td>
</tr>
<tr>
<td>CPU</td>
<td>• &gt; 50% utilization</td>
<td>• Check 5 min interval</td>
</tr>
<tr>
<td></td>
<td>• Restart Service</td>
<td>• Memory consistent across 2 intervals</td>
</tr>
<tr>
<td>Process Failure</td>
<td>N/A</td>
<td></td>
</tr>
</tbody>
</table>
## 12.6 Windows Print Spooler

<table>
<thead>
<tr>
<th>Monitoring Metric</th>
<th>Thresholds and Action(s)</th>
<th>Frequency recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory</td>
<td>• &gt; 768MB Allocated&lt;br&gt;• Restart Service&lt;br&gt;• Restart Server</td>
<td>• Check 5 min interval&lt;br&gt;• Memory consistent across 2 intervals</td>
</tr>
<tr>
<td>CPU</td>
<td>• &gt; 50% utilization&lt;br&gt;• Restart Service</td>
<td>• Check 5 min interval&lt;br&gt;• Memory consistent across 2 intervals</td>
</tr>
<tr>
<td>Process Failure</td>
<td>• Allow Auto-restart up to 2 times&lt;br&gt;• Subsequent failures require service cleanup and log review</td>
<td></td>
</tr>
</tbody>
</table>
Troubleshooting problems

To address an unexpected issue with the Enterprise server, determining where and what component is at fault is a critical part of the process. The following is intended to provide assistance with this process. The process will involve investigating major components or the communication between them.

13.1 High Level Overview

A few key symptoms and information may assist in reducing the problem space significantly. The Enterprise system may be divided into 3 primary divisions:

- **Submission & Job Reception**: Includes API clients, CPS and PrintAnywhere Status Server.
- **Job Processing/Printing**: Includes primarily the PrintAnywhere server, and may be impacted by access to end point printers or services.
- **Job Delivery**: Includes PDS, PDH and HotSpot printers. Impacts submission from the PrintAnywhere Server.

In addition to these 3 items the overall configuration may be the cause of an issue. That overall configuration and the information that binds the systems together will also be discussed below.
13.2 Key Troubleshooting Data Points

Two key data points may be used to help assist and rapidly divide the problem space into smaller pieces:

- Job Reference ID
- User Messages

These do not always identify the root cause of the issue but do aid with a rapid assessment of where to review.

13.2.1 Job Reference ID

Once a job has been accepted by the PrintAnywhere Server, a Job Reference ID is attached to the job, specifically the Status Server subcomponent. The presence or absence of a Job Reference ID provides a major clue where to start investigating issues.

<table>
<thead>
<tr>
<th>If a Job Reference ID...</th>
<th>It is highly likely that...</th>
<th>Troubleshooting should focus on...</th>
</tr>
</thead>
</table>
| was not returned          | • The job did not get submitted to the Status Server  
                           | • The problem resides in CPS  
                           | • The problem resides in the data submitted with the request including:  
                           | • Missing required parameters  
                           | • Missing or corrupt data file  
                           | • Invalid API format         | • CPS & Tomcat logs  
                           | • Status Server logs         |
| was returned              | • The job was received by the PrintAnywhere Server  
                           | • The problem resides within the PrintAnywhere Server  
                           | • The problems may include:  
                           | • Invalid printer information  
                           | • Communication issues amongst PrintAnywhere components  
                           | • Issues printing specific documents | • Status Server logs  
                           | • Processing Server logs      |
13.2.2 User Messages

Once a job has been accepted by the service, specifically PrintAnywhere, all messages will be returned with a code prefix that helps identify the component that reported the message.

For Example:

- PAS0108 – Returned from PrintAnywhere
- PWC0100 – Returned from PrintWhere

This information can be used to quickly isolate whether the issue was caused by PrintAnywhere, PrintWhere communication, or other components.

Generally, the User Message contains the message ID from the component that originated the message. For example, an issue may originate in communication between PrintWhere and the destination device, or in PrintAnywhere when handling a document. The message prefix will help isolate this information. For example:

- PAS0002: The job has been processed.
- PWC4510: Unable to contact the printer.

<table>
<thead>
<tr>
<th>Messaging Prefix</th>
<th>Base reporting component</th>
</tr>
</thead>
<tbody>
<tr>
<td>PAS</td>
<td>PrintAnywhere</td>
</tr>
<tr>
<td>PWC</td>
<td>PrintWhere</td>
</tr>
<tr>
<td>PTS</td>
<td>Configuration and Licensing</td>
</tr>
<tr>
<td>FCS</td>
<td>Print Delivery Station</td>
</tr>
</tbody>
</table>
Adding printers in hybrid deployments

If you have a hybrid deployment and wish to add more devices or additional print management queues, you can do so from the PrinterOn web admin portal. Your ability to add new printers to your deployment is determined by your license. From the homepage of the PrinterOn web administration portal, you can confirm how many printer listings are currently added, as well as the total permitted by your license.
14.1 Adding printers

To add more printers or additional print management queues in a hybrid deployment:

2. Click the Printers icon.
3. Click Add a Printer to your PrintSpot.
4. Click the Required Settings tab and configure the required settings as necessary.
5. Click the Optional Settings tab and configure the optional settings as necessary.
6. Click the Payment & Authorization tab and configure the payment and authorization settings as necessary.
7. Click Save.

14.1.1 Configuring required settings

Required Settings are divided into the following groups:

- Basic printer configuration settings
- Web, PrintWhere, and Email Print settings

Note: If this link is not displayed, please review your license information. If you have already reached your permitted number of printers, you can not add any more without changing the terms of your license agreement.
### 14.1.1.1 Basic printer configuration settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Print driver</strong></td>
<td>The printer driver used to process any jobs sent to the printer. By default, a Generic PCL6 driver is specified. If your device does not support the default print driver, choose an alternate driver from the drop-downs. Printer drivers are sorted by manufacturer. First, select the printer driver manufacturer from the upper list, then select the printer driver from the lower list. If your specific printer model is not available, please choose an appropriate universal driver from your manufacturer. When sending print jobs to a managed pull queue, ensure that all devices within the pull group support the driver.</td>
</tr>
<tr>
<td><strong>Manufacturer</strong></td>
<td>The manufacturer of the printer, as shown to the user.</td>
</tr>
<tr>
<td><strong>Model</strong></td>
<td>Printer driver information that is presented to the user when viewing printer details. This value does not need to match the actual printer model.</td>
</tr>
<tr>
<td><strong>Printer Model Name</strong></td>
<td>The printer model name. This field is only used when you specified Samsung as the Printer Driver manufacturer and Samsung Universal EMU V2 as the printer driver, and allows the PrinterOn to optimize output for specific Samsung printer models. If you don’t know the specific model, select <strong>UnsupportedMono</strong> or <strong>UnsupportedColor</strong>.</td>
</tr>
<tr>
<td><strong>Descriptive Printer Label</strong></td>
<td>A descriptive label that describes the printer to users. The value should be unique and descriptive. <strong>Note:</strong> PrinterOn does not enforce uniqueness on this value, but recommends that you set this value to a simple and easy-to-understand label for the printer.</td>
</tr>
<tr>
<td><strong>External ID</strong></td>
<td>The external ID for this printer. When integrating with Samsung embedded agents or software, <strong>External ID</strong> specifies the MAC address of the printer.</td>
</tr>
</tbody>
</table>
### 14.1.1.2 Web, PrintWhere, and Email Print settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PrinterOn Name</strong></td>
<td>A unique printer queue name used throughout the software to both identify and organize printers.</td>
</tr>
<tr>
<td></td>
<td>This value is combined with the email domain to create the email address for the printer, to which users can email print jobs. For example: <a href="mailto:warehouse-printer-1@emailprint.com">warehouse-printer-1@emailprint.com</a></td>
</tr>
<tr>
<td></td>
<td>PrinterOn recommends using your internal naming convention when available.</td>
</tr>
<tr>
<td><strong>Department</strong></td>
<td>The Printer Department to which the printer belongs. The drop-down list only lists existing departments.</td>
</tr>
<tr>
<td><strong>Default Printer Language</strong></td>
<td>The default language for the printer, which the server uses to respond to email print jobs.</td>
</tr>
<tr>
<td><strong>PrinterID</strong></td>
<td>A unique QR code for the printer. Click the QR Code button to generate the QR code.</td>
</tr>
<tr>
<td><strong>PrintWhere</strong></td>
<td>When checked, workflows including mobile apps, GCP and iOS Native Print are allowed to be submitted to the printer.</td>
</tr>
<tr>
<td><strong>Document API</strong></td>
<td>When checked, the Document API URI is the URL returned by the server to the Mobile Apps when searching for printers. It is used by the App to submit documents to the server.</td>
</tr>
<tr>
<td></td>
<td>By enabling this option, you can provide a value in the Document API URL.</td>
</tr>
<tr>
<td><strong>Doc API URL</strong></td>
<td>Specifies a Document API URI that is used when you enable the Document API setting. This value overrides the value configured on the PrinterOn Directory.</td>
</tr>
<tr>
<td><strong>Email Domain</strong></td>
<td>The email domain that should be appended to the printer name when advertising email print addresses to users.</td>
</tr>
<tr>
<td><strong>Email Printing</strong></td>
<td>When checked, email print is enabled for this queue. If disabled, users receive a message indicating the service is disabled.</td>
</tr>
<tr>
<td></td>
<td><strong>Print Body of Email</strong>: When checked, the body of an email is printed when receiving email print jobs. If disabled, only attachments are printed.</td>
</tr>
</tbody>
</table>
14.1.2 Configuring optional settings

Required Settings are divided into the following groups of settings:
- Job and User Information settings
- Release settings and Advanced Integration Options
- Output Options
- Print Delivery Station settings

### 14.1.2.1 Job and User Information settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Identifier</td>
<td>Specifies whether the user is asked to provide Job Owner information that will be included with a print job.</td>
</tr>
<tr>
<td></td>
<td>If you select <strong>Optional</strong> or <strong>Required</strong>, in the adjacent text box, specify the text displayed to request the user’s name.</td>
</tr>
<tr>
<td></td>
<td>If authentication will be used, you should enable this setting.</td>
</tr>
<tr>
<td>Computer Name</td>
<td>Specified whether the computer name is submitted with the request.</td>
</tr>
<tr>
<td>Client UID</td>
<td>Used in combination with custom integrations of third-party solutions to request user information.</td>
</tr>
<tr>
<td></td>
<td>If you select <strong>Optional</strong> or <strong>Required</strong>, in the adjacent text box, specify the text displayed to request the Client UID.</td>
</tr>
<tr>
<td></td>
<td>When the adjacent <strong>Secured</strong> check box is enabled, the server does not save the Client UID.</td>
</tr>
<tr>
<td>Session Meta Data</td>
<td>Used in combination with custom integrations of third-party solutions to request user information.</td>
</tr>
<tr>
<td></td>
<td>If you select <strong>Optional</strong> or <strong>Required</strong>, in the adjacent text box, specify the text displayed to request the session metadata.</td>
</tr>
<tr>
<td></td>
<td>When the adjacent <strong>Secured</strong> check box is enabled, the server does not save the session metadata.</td>
</tr>
</tbody>
</table>
### 14.1.2.2 Release settings and Advanced Integration Options

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Anonymity Level**    | Defines what information is reported from PDS to the reporting server. Typically, reported information includes print job results and some page metrics, such as page counts and formats.  
Select one of the following values:  
- **None**: No anonymity is applied.  
- **Optional**: The PDS uses the Anonymity Level configured for the printer in the PrinterOn Directory. No local overriding rules are applied.  
- **Anonymous**: Suppresses Job Name and Job Owner.  
- **Minimal**: Includes basic job details, such as page count and job size.  
- **Anonymous + Minimal**: Combines options from both Anonymous and Minimal. |
| **Privacy Release Code** | Indicates if users must provide a release code to retrieve their print jobs. You should typically set this value to **Required** or **Optional** when using a PrinterOn Print Valet or embedded agent that supports entering a release code. |
| **Releasing Print Jobs** | How print jobs are released. There are two options:  
- **Automatically when they arrive**: When selected, print jobs are automatically released to the printer or print queues without being held.  
  When integrating with most print/output management solutions, you should select this option.  
- **Using a PrinterOn Solution or HotSpot printer**: Print jobs are released using a PrinterOn solution. Users must supply a Release Code or other identifying information to access their print jobs.  
  If jobs are to be held for secure release through a PrinterOn agent, you should select this option. |
| **Enable 3rd Part Integration** | When checked, lets you set the following settings to define release settings for your third-party Print Management Integrations: |
14.1.2.3 Output Options

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cover Pages</td>
<td>When checked, a cover page is added to each print job, identifying the sender and the time the job was submitted.</td>
</tr>
<tr>
<td>Color printing</td>
<td>Defines whether color printing is supported. This setting allows users searching for printers to limit their search to those printers that support color.</td>
</tr>
<tr>
<td></td>
<td>If you have a color printer but wish to discourage users from printing in color, select <strong>Does not support color</strong>.</td>
</tr>
<tr>
<td>PJL Encoding</td>
<td>Specifies the Printer Job Language encoding. If your printer needs to support double byte characters, set this to UTF-8, and check the <strong>Override Encoding Specification</strong>.</td>
</tr>
<tr>
<td>Max. page count</td>
<td>The maximum number of pages a print job may use. Print requests exceeding this limit will be accepted. The maximum page count includes the cover page.</td>
</tr>
<tr>
<td>Max. printed size</td>
<td>The maximum data size of a print job. Print requests exceeding this limit will be accepted.</td>
</tr>
</tbody>
</table>
14.1.2.4 Print Delivery Station settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplexing</td>
<td>Defines the duplexing configuration.</td>
</tr>
<tr>
<td></td>
<td>If you prefer to let the printer control duplexing, select <strong>Not Managed</strong>.</td>
</tr>
<tr>
<td>Paper sizes</td>
<td>The paper sizes are available for the printer and manage what paper-selection options the user can choose when they print.</td>
</tr>
</tbody>
</table>

**Allow Printing Directly to PDS**
- **Description**: When checked, indicates that print jobs are sent to the PDS server.
  
  **Note**: Only select this option if the PDS is accessible from the main server. In some cases, print jobs can only be delivered to a PDS using an intermediate Print Delivery Hub (PDH).

**Server Address**
- **Description**: The fully qualified network address of the Print Delivery Station server. Select a scheme to indicate whether SSL will be used. Usually this is simply the local server.
  
  **Note**: As a best practice, you should specify an explicit port along with the server address to improve print performance. The server automatically selects the specified port, if supplied. Otherwise, it scans ports 80, 443, and 631, as well as SSL and non-SSL connections, which can slow delivery.

**Print Directly to PDS Only**
- **Description**: When checked, all print jobs are printed directly to the PDS, and are not sent to a PDH. This setting only applies if a PDH is available. In most cases, you should enable this setting.

**Use an alternate/local Print Delivery Hub to host print jobs**
- **Description**: When checked, indicates that a Print Delivery Hub server is available for printing. This option should be specified if a PDS is accessible directly by the server. In some cases, this option may be used if multiple PDS servers are deployed for the same printer, for redundancy.

  Configuring both a PDS and PDH server can assist desktop printing using PrintWhere for roaming users who may move between networks regularly and cannot always contact PDS.

  When checked, you must specify the fully qualified network address of the PDH server.
14.1.3 Configuring the Payment & Authorization settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Guests will be charged for printing</strong></td>
<td>When checked, users are charged a fee for each print job sent to this printer. When you enable this setting, additional settings appear, letting you define the specific payment details, such as currency, cost per page, and others.</td>
</tr>
<tr>
<td><strong>Requires Authentication to Print</strong></td>
<td>When checked, users are prompted for their credentials when scanning the QR code via the PrinterOn mobile apps.</td>
</tr>
<tr>
<td><strong>Redirect to authorize user, track pages or bill customer</strong></td>
<td>When checked, users are redirected to a specified URL for authorization. When you enable this setting, additional settings appear, letting you define the User Authentication URL, Web Authorize URL, and Mobile Authorize URL. To supply a URL, check the adjacent check box, then enter the URL in the text field.</td>
</tr>
</tbody>
</table>

### 14.2 Configuring printer location settings

You can set a unique address and GPS co-ordinates set for each printer listing within the PrinterOn directory.

To configure printer location settings:

2. Click the **Printers** icon.
3. In the list of printers, locate the printer you want to define location information for, then click **Set Address** from the **Options** list.
4. Configure the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address1, Address2, City, Zip/Postal Code, Country, State/Province</td>
<td>The physical address for the printer. Mobile app users looking for a PrinterOn enabled printer can search on any value of the address to locate a printer. The mobile app also displays the address in the Printer Details.</td>
</tr>
<tr>
<td>Latitude, Longitude</td>
<td>The GPS coordinates for the location of the printer. The GPS coordinates are used to display the printer location on a map when users attempt to locate a printer using the PrinterOn Mobile app.</td>
</tr>
<tr>
<td></td>
<td>Click <strong>Get Geo Coordinates</strong> to get the latitude and longitude of the address you provided.</td>
</tr>
<tr>
<td>Show map in searches.</td>
<td>When checked, the printer location will be displayed in a map in searches by users using the PrinterOn Mobile Apps.</td>
</tr>
</tbody>
</table>

### 14.3 Updating the Service URL

The Service URL (shown in the **Site Summary** box on the web admin portal homepage) is an important factor in supporting API submissions. API submissions refer to submissions made by mobile apps, native iOS, IPP, Google Cloud Print, and any custom submission applications you may have created based on PrinterOn APIs.

You can update the Service URL from the PrinterOn.com web admin portal.

To configure the Service URL:

1. Log in to the PrinterOn.com web admin portal at [www.printeron.com](http://www.printeron.com/)
   *administrators*.
2. Click the **Service Details** icon.
3. Locate the **Account Profile** section, at the bottom of the page.
4. In the **Service URL** field, enter the IP or DNS address for the server hosting your PrinterOn software. You must append /cps to the end of the address. For example: http://print.company.com/cps

**Note:** In a multi-server environment, this value should reflect the address users will visit to complete a web submission. This is most likely a load-balanced address.
5. Click **Update**.

### 14.4 Configuring MAC address information for Samsung printers

When integrating with Samsung embedded agents or software, it is necessary to configure the MAC address of the printer.

To configure the MAC address:

2. Click the **Printers** icon 📦.
3. In the list of printers, locate the printer you want to define location information for, then click **Required Settings**.

4. Locate the **External ID** field and enter the MAC address of the printer.
5. Click **Save**.
Advanced configuration settings

Beginning with version 3.2.1, you can display the Configuration Manager in two views:

- **Basic view**: Displays commonly configured settings.
- **Advanced view**: Displays all Basic view settings plus additional advanced settings. Advanced settings are those that are only rarely configured or are specific to a particular deployment.

By default, the Configuration Manager opens in Basic view. You can toggle between the two views using the *Show Advanced Settings* switch on the *Settings* menu. As you turn Advanced view on and off, the interface is updated in real time.

This chapter provides a list of Advanced settings. In most cases, you won’t need to configure these settings.

To view these settings, you must turn on the *Show Advanced Settings* toggle.

To show or hide advanced settings:

1. In the Configuration Manager, click the *Settings* button.
2. Click *Show Advanced Settings* to toggle advanced settings on or off.
## A.1 Advanced settings list

The following table lists all settings that only appear in the Configuration Manager in Advanced view.

<table>
<thead>
<tr>
<th>Location</th>
<th>Advanced Settings</th>
</tr>
</thead>
</table>
| **Home > General Settings** | • Printer Synchronization Settings panel  
• Advertised Capabilities panel |
| **Workflow > Web Print** | Advanced settings in the Web Presentation panel:  
• Job Submit Refresh Interval  
• Job Approval  
• Smart Printer Selection  
• Department Sidebar View  
• Number of Printers Displayed Per Page  
• Number of Departments Displayed Per Page |
| **Workflow > Email Print** | • Accept Request to response address setting (all email types)  
• Advanced Email Settings panel (all email types) |
| **Workflow > PQMS** | PQMS Settings panel |
| **Workflow > IPP and Native iOS Printing** | Advanced settings in the Network Broadcast Settings panel:  
• Additional Port settings |
| **Authentication > Authentication** | Advanced settings in the LDAP/AD Settings panel:  
• Trusted Application Behavior  
• Web Authentication Enabled for Mobile |
| | Advanced settings in the LDAP/AD Profile Details panel:  
• Mode  
• Follow LDAP Referrals  
• Prepend “smtp:” to E-Mail Address Searching  
• Enable Configuration Manager Access  
• User Display Name Attribute  
• User First Name Attribute  
• User Surname Attribute  
• User Phone Number Attribute(s) |
<table>
<thead>
<tr>
<th>Location</th>
<th>Advanced Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printers &gt; Printers &gt; Configure</td>
<td>• Labels section</td>
</tr>
<tr>
<td></td>
<td>• Advanced settings in the Job and User Information section:</td>
</tr>
<tr>
<td></td>
<td>• Client UID</td>
</tr>
<tr>
<td>Printers &gt; Secure Release</td>
<td>• Session Meta Data</td>
</tr>
<tr>
<td>Anywhere Pools &gt; Configure</td>
<td>• Advanced settings in the Releasing Print Jobs section:</td>
</tr>
<tr>
<td></td>
<td>• Always use numbered release codes</td>
</tr>
<tr>
<td></td>
<td>• Auto-generate release codes</td>
</tr>
<tr>
<td></td>
<td>• All Third-Party Integration settings</td>
</tr>
<tr>
<td></td>
<td>• Advanced settings in the Finishing Options section:</td>
</tr>
<tr>
<td></td>
<td>• PJL Encoding</td>
</tr>
<tr>
<td></td>
<td>• Override Encoding Specification</td>
</tr>
<tr>
<td>Settings (⚙️) &gt; Settings</td>
<td>• Authentication Settings panel</td>
</tr>
</tbody>
</table>
Creating a printer configuration profile

A configuration profile is a CSV text file that defines the configuration properties for multiple printers. Configuration profiles simplify the printer creation and configuration process when you have a large number of printers.

A printer configuration profile defines a number of settings, including:

- Printer Name
- Printer Description/Location Settings
- Print Workflows Options
- Print Driver Settings
- Printer Capabilities

To further simplify the process, you can use printer configuration profiles in conjunction with printer templates. For certain properties, if values are left blank, the server applies the value found in the specified template.

Once you have created a CSV file, you can import that file into the Configuration Manager to create or update printers. For more information on importing a CSV file, see Importing a printer configuration profile into the Configuration Manager.
B.1 Optimizing performance

Importing a printer configuration profile is resource intensive. For optimal performance, before you attempt to use a configuration profile to create or update multiple printers, you should consider the following system requirements:

- You should have at least 4 GB of RAM available on your server.
- **Set your log level** to a value of **Warning** or lower. Higher logging levels can result in too many messages and can slow performance.
- **Disable the printer synchronization settings** for both PDG and PDS. Printer synchronization drastically increases the time it takes to import and apply the settings. You should disable both the **Synchronize By Default** and **Automatic Printer Synchronization** settings.
- **Increase the memory allocation for Apache Tomcat**. Tomcat should have an **Initial memory pool** value of 256 MB, and a **Maximum memory pool** value of 1024 MB.

Adhere to the following limitations:

- Creating printers: Maximum 5000 printers per operation
- Updating printers: Maximum 300 printers per operation

B.1.1 Changing the memory pool for Tomcat

To maximize the performance of a bulk printer creation or update operation, you can increase the memory pool allocated to Apache Tomcat.

To change the memory pool for Tomcat:

1. Navigate to `C:\Program Files (x86)\PrinterOn Corporation\Apache Tomcat\bin\` and open `tomcat8w.exe`. The Central Print Services Properties dialog appears.
2. Click the **Java** tab.
3. In the **Initial memory pool** field, set a value of 256 MB.
4. In the **Maximum memory pool** field, set a value of 1024 MB.
5. Click **OK**.
B.2 Structure of a printer configuration profile

The basic rules to keep in mind while entering values into the printer configuration profile are as follows:

- A CSV file provides fields/columns separated by commas. You can use any spreadsheet program, such as Microsoft Excel, to create the file, then save it as a CSV file when you are ready to import it.

  **Note:** To ensure that the Configuration Manager can successfully import and read the content of your CSV file, you should make sure that the file is encoded as UTF-8.

- Fields with embedded commas are enclosed by double-quotes. For example, consider the following entry: 1223,”This is a, comma”, abcd. In this entry, “This is a, comma” is a single field.

- Fields with line breaks must also be enclosed by double-quotes.

B.2.1 CSV Headers

The first row of the printer configuration profile is reserved for specifying CSV field header information. This header row describes how each entry is structured so that the PrinterOn Server can successfully apply the settings for each printer.

The header row lets you define which configuration values you’re setting for imported printers, and in what order they are specified for each entry. You can list the headers in any order, but you must make sure that values entered for each imported printer are provided in the same order.
B.2.2 CSV Data Types

Configuration data can be one of the following types:

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Required (R)</td>
<td>Required data MUST be supplied for each entry in the CSV file. If a required field is not supplied, the CSV entry will not be processed and an appropriate error will be provided in the final Portal Creation report.</td>
</tr>
<tr>
<td>Template Alternative (TA)</td>
<td>Data that may optionally be supplied in the CSV file. If a TA setting is not defined in the CSV file, the server configures the setting to the value from the template printer (specified by templatePrinterId). If a value supplied for a Template Alternative setting is invalid or uses an incorrect syntax, the import fails. The server does not replace invalid values with the template value.</td>
</tr>
</tbody>
</table>

B.3 Printer configuration profile settings

The section below lists each header with a description and its supported values. Each entry is a distinct comma-separated data point.

<table>
<thead>
<tr>
<th>Header</th>
<th>Description and link to UI setting</th>
<th>Supported values</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>action</td>
<td>Indicates whether a new printer is created, an existing printer is modified, or an existing printer is deleted.</td>
<td>• 0: Updates a printer&lt;br&gt;• 1: Creates a printer&lt;br&gt;• 3: Deletes a printer</td>
<td>R</td>
</tr>
<tr>
<td>createPds</td>
<td>Indicates whether to create a new PDS or to associate the printer with an existing PDS.</td>
<td>• 0: Associates with an existing PDS</td>
<td></td>
</tr>
<tr>
<td>templatePrinterId</td>
<td>The PrinterOn ID of the Template Printer. If the createPrinter value is 0, this field represents the ID of the printer to update.</td>
<td>A valid PrinterOn Printer ID</td>
<td>R</td>
</tr>
<tr>
<td>printerName</td>
<td>The name of the printer. If the createPrinter value is 0, this field is used to update the printer name.</td>
<td>Any valid Printer name</td>
<td>R</td>
</tr>
<tr>
<td>printerDescription</td>
<td>A descriptive label/Location Information</td>
<td>Front Office Later</td>
<td>R</td>
</tr>
<tr>
<td>departmentName</td>
<td>Printer Department Name&lt;br&gt;Note: The value will be use to specify the printer department for Enterprise printers. Should generally be left empty for Express printers.</td>
<td>An existing printer department</td>
<td>TA</td>
</tr>
<tr>
<td>streetAddress</td>
<td>The street address of the printer location.</td>
<td>Any street address</td>
<td>TA</td>
</tr>
<tr>
<td>streetAddress2</td>
<td>The street address of the printer location.</td>
<td>Any street address</td>
<td>TA</td>
</tr>
</tbody>
</table>
### Header

<table>
<thead>
<tr>
<th>Header</th>
<th>Description and link to UI setting</th>
<th>Supported values</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>city</td>
<td>The city the printer is located in.</td>
<td>Any city name</td>
<td>TA</td>
</tr>
<tr>
<td>state</td>
<td>The state/province (PrinterOn ID) the printer is located in.</td>
<td>See State/Province codes.</td>
<td>TA</td>
</tr>
<tr>
<td>country</td>
<td>The country (PrinterOn ID) the printer is located in.</td>
<td>See Country Codes.</td>
<td>TA</td>
</tr>
<tr>
<td>postalCode</td>
<td>The postal code of the printer location.</td>
<td>A valid postal code</td>
<td>TA</td>
</tr>
<tr>
<td>gpsLatitude</td>
<td>The GPS latitude value.</td>
<td>Any valid GPS value</td>
<td>TA</td>
</tr>
<tr>
<td>gpsLongitude</td>
<td>The GPS longitude value.</td>
<td>Any valid GPS value</td>
<td>TA</td>
</tr>
<tr>
<td>externalId</td>
<td>The external ID for this printer, typically the MAC address of the printer.</td>
<td>A valid MAC address</td>
<td>TA</td>
</tr>
<tr>
<td>printerModel</td>
<td>The printer driver information that is shown to the user when viewing printer details.</td>
<td>A printer driver</td>
<td>TA</td>
</tr>
<tr>
<td>printerModelName</td>
<td>The printer model name, used to optimize output for Samsung printer models.</td>
<td>Any valid printer model name</td>
<td>TA</td>
</tr>
<tr>
<td>printWhereEnable</td>
<td>Indicates whether the printer supports the PQMS workflow.</td>
<td>• 0: Disabled</td>
<td>TA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1: Enabled</td>
<td></td>
</tr>
<tr>
<td>docApiEnable</td>
<td>Indicates whether the printer supports mobile, GCP, and IPP/iOS Native Print workflows.</td>
<td>• 0: Disabled</td>
<td>TA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1: Enabled</td>
<td></td>
</tr>
<tr>
<td>emailDomain</td>
<td>The email domain of the printer.</td>
<td>• 0: Disabled</td>
<td>TA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1: Enabled</td>
<td></td>
</tr>
<tr>
<td>emailPrintingEnable</td>
<td>Indicates whether the printer supports the Email Print workflow.</td>
<td>• 0: Disabled</td>
<td>TA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1: Enabled</td>
<td></td>
</tr>
<tr>
<td>printEmailBody</td>
<td>Indicates whether the body of an email is printed when receiving email print jobs. If disabled, only attachments are printed.</td>
<td>• 0: Disabled</td>
<td>TA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1: Enabled</td>
<td></td>
</tr>
<tr>
<td>enableAdvanceIntegration</td>
<td>Enable advance integration features</td>
<td>• 0: Disabled</td>
<td>TA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1: Enabled</td>
<td></td>
</tr>
<tr>
<td>printManagementService</td>
<td>Print Management Service</td>
<td>See Print Management Service IDs.</td>
<td>TA</td>
</tr>
<tr>
<td>additionalIntegrationInfo</td>
<td>Additional Integration information. Valid only when printManagementService is set to 27 (Equitrac) or 55 (SecuPrint).</td>
<td>See Additional Integration Info IDs.</td>
<td>TA</td>
</tr>
<tr>
<td>injectPjltHeader</td>
<td>Indicates whether the server injects a PJL Header container, if none exists.</td>
<td>• 0: Disabled</td>
<td>TA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1: Enabled</td>
<td></td>
</tr>
<tr>
<td>injectPjlForPassthrough</td>
<td>Indicates whether the printer processes and modify PJL headers.</td>
<td>• 0: Disabled</td>
<td>TA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1: Enabled</td>
<td></td>
</tr>
<tr>
<td>pdsOutputType</td>
<td>The URL scheme for the output destination, such as local://, tcp://, or https://.</td>
<td>A valid URL scheme</td>
<td></td>
</tr>
</tbody>
</table>
B.3.1 Sample printer configuration profile

The following sample illustrates the contents of a configuration profile defined in a spreadsheet, which can later be saved as CSV and imported into the Configuration.
Creating a printer configuration profile

Manager. For more information, see Importing a printer configuration profile into the Configuration Manager.

Note that undefined values for Template Alternative settings can be left blank or omitted altogether. The PrinterOn Server handles empty entries as described in CSV Data Types.

B.3.2 CSV ID reference

B.3.2.1 Country Codes

PrinterOn uses the ISO standard two-letter abbreviations to represent specific countries. When supplied, PrinterOn will associate the newly created printer with the supplied country ID.

Note: These values are Template Alternative values and are not required.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Argentina</td>
<td>AR</td>
<td>France</td>
<td>FR</td>
<td>Mexico</td>
<td>MX</td>
</tr>
<tr>
<td>Australia</td>
<td>AU</td>
<td>Germany</td>
<td>DE</td>
<td>Pakistan</td>
<td>PK</td>
</tr>
<tr>
<td>Brazil</td>
<td>BR</td>
<td>Great Britain</td>
<td>GB</td>
<td>Spain</td>
<td>SP</td>
</tr>
<tr>
<td>Canada</td>
<td>CA</td>
<td>Indonesia</td>
<td>ID</td>
<td>Thailand</td>
<td>TH</td>
</tr>
<tr>
<td>China</td>
<td>CN</td>
<td>Italy</td>
<td>IT</td>
<td>United States</td>
<td>US</td>
</tr>
</tbody>
</table>
| ...      | ...  | ...        | ...  | ...        | ...

For a complete list of country codes, you can search the ISO database here.
B.3.2.2 State/Province codes

PrinterOn uses the ISO standard codes for state/provinces to represent specific regions. When supplied, PrinterOn will associate the newly created printer with the supplied region code.

**Note:**

- These values are Template Alternative values and are not required.
- Not all states and provinces are represented within the State/Province Identifier field. PrinterOn Only supports specifying state/province for the US, Canada, China, and Australia. In other regions, the state/province code should match the country code. For example, Germany would be set as country=DE, state/province=DE.

The following is a small subset of state/province identifiers for reference.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Alabama</td>
<td>AL</td>
<td>Alberta</td>
<td>AB</td>
<td>Beijing</td>
<td>11</td>
<td>New South Wales</td>
<td>NSW</td>
</tr>
<tr>
<td>California</td>
<td>CA</td>
<td>Manitoba</td>
<td>MB</td>
<td>Fujian</td>
<td>35</td>
<td>Northern Territory</td>
<td>NT</td>
</tr>
<tr>
<td>Illinois</td>
<td>IL</td>
<td>New Brunswick</td>
<td>NB</td>
<td>Guangxi</td>
<td>45</td>
<td>Queensland</td>
<td>QLD</td>
</tr>
<tr>
<td>Maine</td>
<td>ME</td>
<td>Ontario</td>
<td>ON</td>
<td>Hong Kong</td>
<td>91</td>
<td>South Australia</td>
<td>SA</td>
</tr>
<tr>
<td>Massachusetts</td>
<td>MA</td>
<td>Quebec</td>
<td>QC</td>
<td>Shandong</td>
<td>37</td>
<td>Tasmania</td>
<td>TAS</td>
</tr>
<tr>
<td>Michigan</td>
<td>MI</td>
<td>Saskatchewan</td>
<td>SK</td>
<td>Shanghai</td>
<td>31</td>
<td>Victoria</td>
<td>VIC</td>
</tr>
<tr>
<td>New York</td>
<td>NY</td>
<td>Yukon Territory</td>
<td>YT</td>
<td>Yunnan</td>
<td>53</td>
<td>Western Australia</td>
<td>WA</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
</tbody>
</table>

For a complete list of state/province codes, you can search the ISO database [here](#), then select the country to view the subdivision codes.

B.3.2.3 Print Management Service IDs

These IDs are used to configure the type of third-party integration service to apply to the printer. Leave blank if none is required, otherwise, specify the numeric ID.

<table>
<thead>
<tr>
<th>Third-Party Integration</th>
<th>ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
</tr>
<tr>
<td>Samsung BCPS</td>
<td>5</td>
</tr>
</tbody>
</table>
### B.3.2.4 Additional Integration Info IDs

Some print management systems can be used with additional integrations. The following table lists supported secondary integrations and the primary integration(s) (specified using the `printManagementService` value) with which they can be used.

<table>
<thead>
<tr>
<th>Third-Party Integration</th>
<th>ID</th>
<th>Valid Primary Third-Party Integration</th>
</tr>
</thead>
<tbody>
<tr>
<td>SecuPrint</td>
<td>35</td>
<td>Samsung Secure Release Code (38)</td>
</tr>
<tr>
<td>Samsung Secure Release</td>
<td>36</td>
<td>SecuPrint (35)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Samsung Secure Release Code (38)</td>
</tr>
<tr>
<td>Litech</td>
<td>37</td>
<td>Samsung Secure Release Code (38)</td>
</tr>
<tr>
<td>Samsung Secure Release Code</td>
<td>38</td>
<td></td>
</tr>
<tr>
<td>Samsung SecuThru Pro</td>
<td>40</td>
<td>SecuPrint (35)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Samsung Secure Release Code (38)</td>
</tr>
</tbody>
</table>
PrinterOn Server components glossary and overview

C.1 Central Print Service

Central Print Services (CPS) is the primary entry point for all requests submitted to the PrinterOn Enterprise Server. CPS is responsible for providing a centralized interface for all Enterprise printing including end-user web printing, mobile application printing as well as for 3rd parties who develop integrations to the Enterprise Server for custom print services. CPS is a Java Servlet based solution that is hosted by Apache Tomcat as its Servlet Container. CPS implements PrinterOn Document and Directory Search APIs to facilitate submission of print jobs.

In addition to providing print service access, CPS also provides a web-based administrative console allowing administrators to manage their service and control how jobs are received and submitted to the underlying print subsystem.

C.2 PrintAnywhere

The PrintAnywhere Server provides job management and print processing of documents as part of PrinterOn’s print services. The PrintAnywhere Server comprises a number of software services that facilitate the receiving and printing of documents and the delivery of the processed documents to a PrinterOn enabled printer.
For information on creating a PrintAnywhere cluster, see Advanced clustering and document processing scalability.

C.2.1 Web Plugins

PrintAnywhere’s web plugins are the interfaces by which PrinterOn’s Central Print Services (CPS) solution delivers print jobs to the PrintAnywhere server for processing. These plugins are required when installing PrinterOn’s CPS solution. These plugins are available as part of the installation, as either a Java Servlet or ISAPI based interface.

C.2.2 PrintAnywhere Status Server

The PrintAnywhere Status Server is responsible for managing all incoming and in-process print requests. All print jobs received via email, the web or from mobile apps are first received by the Status Server. The Status Server is responsible for delivering requests to available Processing Servers and managing the jobs while they are being processed.

You can cluster multiple Status Servers to provide greater redundancy in a multi-server environment. For more information, see Adding Status Servers.

C.2.3 PrintAnywhere Processing Server

The PrintAnywhere Processing Server is responsible for converting a document received by the server into a printer-usable format. The Processing Server integrates with applications installed on the server and the PrinterOn PrintWhere Driver to render documents.

You can deploy multiple Processing Servers as part of a PrintAnywhere cluster to increase capacity and redundancy. For more information, see Adding Processing Servers.

C.3 PrinterOn PrintWhere Driver Server Edition

The PrinterOn PrintWhere driver is installed as part of the Processing Server. It is a key component of the overall printing process and is integrated into the Processing Server as part of a PrintAnywhere deployment.
The PrintWhere Driver is managed by the Processing Server using an internal API system. The Processing Server encapsulates communication between PrintAnywhere and the PrintWhere driver using a subcomponent of PrintAnywhere named the PrintWhere Bridge (PWCBridge.exe).

C.4 Print Delivery Gateway

The Print Delivery Gateway Software (PDG) serves as a protocol gateway to PrinterOn Enterprise printers, allowing users to submit jobs using a number of different methods, including:

- IPP and Native iOS (iPhone, iPad, other iOS devices), powered by **PDG iOS Connector**
- Google Cloud Print (Smartphones, Tablets, NetBooks, Chrome Browser, etc...), powered by **PDG GCP Connector**
- Standard Windows Printer Queues (Print Servers Integration), powered by **PDG PQMS Connector**

The PDG acts as a bridge that supports multiple print workflows, allowing IT Administrators to streamline the deployment, management, and administration of Enterprise printers, while simultaneously retaining the native printing experience unique to each platform.

C.5 Print Delivery Station

The role of the Print Delivery Station (PDS) is to provide a bridge between the PrinterOn delivery infrastructure and the physical printer or print queue. PDS communication is based on the IPP specification and provides extensions to the protocol for advanced functionality, such as encryption.

The simplest description of PDS is an IPP print server that supports various connection protocols to printers or print queues.

- IPP is based on HTTP and uses custom HTTP headers for metadata delivery and a structured binary body to deliver print data.
- PDS implements an IPP listener to receive print jobs from PrintWhere.
- Print jobs received by PDS can be delivered to their destination automatically or manually, based on the PrinterOn configuration.
• The process of receiving jobs and delivering them to their destination remains the same regardless of whether PDS is configured to hold for user input prior to delivering to their destination.

For more information on adding configuring PDS settings, see Managing and configuring Print Delivery Stations (PDS).

C.6 Print Delivery Hub

For Enterprise deployments delivering print jobs to printers installed in disparate networks, it may not be possible to deliver print jobs from a PrinterOn Enterprise Server or the PrinterOn PrintWhere universal driver directly to the PDS. In other cases, leveraging a simple and rapid deployment of print devices, such as Ricoh HotSpot printers, will benefit from the centralized installation of a Print Delivery Hub (PDH). In this arrangement, print jobs are delivered to the PDH setup and the PDS servers communicate with PDH to detect and download the print jobs.

In such a scenario, the PDH service must be accessible over the network to the PDS servers. The PDH service can be installed in a central network operating center. Access to the PDH will be configured such that the PrintAnywhere Server, desktop PrintWhere clients and PDS deployments can access the PDH server. This configuration generally minimizes network changes, as the PDH is the only service requiring incoming network traffic access.

For information about adding and configuring a PDH, see Adding a Print Delivery Hub.
PrinterOn Server network port usage

The following table provides an overview of all ports used by the PrinterOn Servers. The ports listed below cover all sub components of the server.

Note:

- Some ports are used for interprocess communication on a local server. They are required but do not pose a security risk. A local firewall may be used to block the ports, as long as it does not interfere with local communication.

- Some ports, such as the PrintAnywhere ports for Processing Server and Status Server communication, are used for both interprocess communication AND clustering.
  - If clustering is not enabled, a local firewall may be used to block the ports, as long as they do not interfere with local communication.
  - If clustering is enabled, access can be limited to end points in the cluster.

- Some ports are configured as optional alternatives during installation, such as port 8080 in PDS. You can reconfigure and/or disable these ports if necessary.

- Some ports above 10000 may be created temporarily for interprocess communications on the same server. These are expected and may change from instance to instance.

<table>
<thead>
<tr>
<th>Port</th>
<th>Required?</th>
<th>Description</th>
<th>Owner</th>
<th>To disable:</th>
</tr>
</thead>
<tbody>
<tr>
<td>80</td>
<td>No</td>
<td>Used for internal subcomponent communication for configuration, authentication, and Web Print.</td>
<td>CPS</td>
<td>Redirect to SSL Port in Tomcat or block by firewall.</td>
</tr>
<tr>
<td>443</td>
<td>Yes</td>
<td>Used for internal subcomponent communication for configuration, authentication, and Web Print.</td>
<td>CPS</td>
<td>N/A</td>
</tr>
<tr>
<td>631</td>
<td>Yes</td>
<td>Used to receive print jobs from PrintAnywhere and PrintWhere.</td>
<td>PDS</td>
<td>N/A</td>
</tr>
<tr>
<td>Port</td>
<td>Required?</td>
<td>Description</td>
<td>Owner</td>
<td>To disable:</td>
</tr>
<tr>
<td>------</td>
<td>-----------</td>
<td>-------------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>4999</td>
<td>Yes</td>
<td>Deprecated as of version 3.2.3.</td>
<td>PDS</td>
<td>Deprecated.</td>
</tr>
<tr>
<td>5000</td>
<td>Yes</td>
<td>Deprecated as of version 3.2.4.</td>
<td>PDG</td>
<td>Deprecated.</td>
</tr>
<tr>
<td>5009</td>
<td>Yes</td>
<td>Used for Local Server Interprocess communication.</td>
<td>PAS (Processing)</td>
<td>Block by firewall.</td>
</tr>
<tr>
<td>5200</td>
<td>Yes</td>
<td>Used for communication between PrintAnywhere server components when clustering. Only required if clustered.</td>
<td>PAS (Status)</td>
<td>N/A</td>
</tr>
<tr>
<td>5400</td>
<td>Yes</td>
<td>Used for communication between PrintAnywhere server components when clustering. Only required if clustered.</td>
<td>PAS (Processing)</td>
<td>N/A</td>
</tr>
<tr>
<td>6310</td>
<td>No</td>
<td>Used for receiving IPP/AirPrint jobs from iOS devices and Apple Desktops.</td>
<td>PDG</td>
<td>Disable the Print Delivery Gateway.</td>
</tr>
<tr>
<td>8009</td>
<td>No</td>
<td>Used by the AJP Connector for load balancing Tomcat instances or integrating with Apache. Redirects to port 443.</td>
<td>Apache Tomcat</td>
<td>Remove the port in the server.xml file.</td>
</tr>
<tr>
<td>8057</td>
<td>Yes</td>
<td>Used to provide access to the Configuration Manager. Access to Web Configuration tools</td>
<td>Configuration Manager</td>
<td>Block by firewall.</td>
</tr>
<tr>
<td>8080</td>
<td>No</td>
<td>An alternate/optional port used for Receiving print jobs. This port is used for internal communication, except in a multi-server deployment, or when receiving print jobs from PrintWhere. This port is configurable.</td>
<td>PDS</td>
<td>Disable the port in the PDS admin page.</td>
</tr>
<tr>
<td>8081</td>
<td>No</td>
<td>An alternate/optional port used for Receiving IPP/AirPrint jobs from iOS devices and Apple Desktops. This port is configurable.</td>
<td>PDG</td>
<td>Disable the Print Delivery Gateway.</td>
</tr>
<tr>
<td>8181</td>
<td>No</td>
<td>Used by the Web Release User Interface. This port is only required if using the web release interface for job release.</td>
<td>PDS</td>
<td>Block by firewall.</td>
</tr>
<tr>
<td>8182</td>
<td>No</td>
<td>Used by the Brother BSI API Interface. This port is only required when using the Brother BSI API for job release.</td>
<td>PDS</td>
<td>Block by firewall.</td>
</tr>
<tr>
<td>9444</td>
<td>No</td>
<td>Used by the Storage Server. This port is only required to support Print Preview.</td>
<td>Storage Server</td>
<td>Block by firewall.</td>
</tr>
<tr>
<td>10051</td>
<td>Yes</td>
<td>Used for Local Server Interprocess communication.</td>
<td>PWC Bridge</td>
<td>Block by firewall.</td>
</tr>
<tr>
<td>48300, 49300, 50300</td>
<td>Yes</td>
<td>Used by internal PrintWhere processes.</td>
<td>Satellite, Post Render and Driver</td>
<td>Block by firewall.</td>
</tr>
</tbody>
</table>
Additional configuration details

Due to system or network changes, or the unique needs or characteristics of your PrinterOn service deployment, you may need to perform some additional configuration tasks to optimize the service. This chapter describes the following tasks:

- **Configuring Microsoft Office permissions** to deal with a change in the way Windows handles permissions, which may cause errors when printing Microsoft Office documents.
- **Reconfiguring the Print Anywhere Server for newly installed applications** that were installed after the PrinterOn software was installed.
- **Configuring region-specific encoding for text files** for environments where text files of non-ASCII encoding (such as Chinese or Korean) are commonly submitted for printing.
- **Enabling PrintAnywhere to permit print jobs from a remote CPS server**, when PrintAnywhere and CPS are located on different servers.
- **Disabling strict SSL verification for CPS**, when man-in-the-middle proxies prevents communication with the PrinterOn Directory.
- **Enabling LDAP/AD for PrintWhere**, to allow PrintWhere to use LDAP/AD authentication.

E.1 Configuring Microsoft Office permissions

Some users have reported errors printing some Microsoft Office files when deploying PrinterOn Server along with Microsoft Office. This issue is caused by a change in Windows
permissions, which impacts automation to some installations of Windows Server 2012 and Server 2008.

At present, the only workaround to this issue is to manually modify the DCOM configuration for Microsoft Office applications. PrinterOn is working toward a solution that will remove the need to perform these manual steps in an upcoming service release.

To modify the DCOM configuration:

1. From the command prompt, type `mmc -32` to launch the Console.
2. Expand **Component Services**, then select **DCOM Config**.
3. Perform the Steps 4 to 6 for each of the following entries:

   - Microsoft Word 97 -2003 Document
   - Microsoft Excel 97 -2003 Document
   - Microsoft PowerPoint 97 -2003 Document
   - Microsoft PowerPoint Slide
   - Microsoft Visio 97 -2003 Document (if installed)
4. Right-click and select **Properties**, then click the **Identity** tab.
5. Select **This User**, and enter the same dedicated Local Administrator user that was created to run the PrinterOn Services.
6. Click **Apply**.
7. Restart the Processing Server service:
   a) In the Configuration Manager, click **Home > Services**.
   b) Locate the **Print Anywhere Processing Server**, then click the adjacent **Restart** button.

### E.2 Reconfiguring the Print Anywhere Server for newly installed applications

The Application tab in the Print Anywhere configuration settings allow you to review and manage the applications available to the server. The PrintAnywhere Server can scan your
server to determine which applications have been installed and whether they can be used by the server to process print jobs.

If you have installed applications, such as LibreOffice or Microsoft Office, after installing the PrinterOn Server, you must refresh the server application configuration to use the newly installed applications.

To refresh the application settings:

1. In the Configuration Manager, click Advanced > Components.
2. Click the Configure button adjacent the Print Anywhere Server component. The Print Anywhere Server (PAS) component configuration appears.
3. Click Applications.

4. At the bottom of the page, click Auto Configure Settings.

5. When the auto configuration is complete, restart the Processing Server service:
   a) In the Configuration Manager, click Home > Services.
   b) Locate the Print Anywhere Processing Server, then click the adjacent Restart button.
E.3 Configuring region-specific encoding for text files

**Note:** These options only apply if you have Word or LibreOffice installed.

If users of your service regularly print simple text (TXT) files to your server, depending on your location, you may be able to improve the output of the text files with some additional configuration.

By default, the PrinterOn Server processes text files with a simple ASCII encoding. When a text file is submitted for printing, the server attempts to determine the encoding of file to select the best encoding automatically, such as UTF-8, ASCII, or UTF-16.

In some cases, the server cannot determine the encoding of a text file. You can specify a default encoding that the server uses for those cases when it cannot determine the encoding.

You should configure the default encoding if:

- Users regularly print text files.
- Users regularly submit text files other than ASCII or UTF-8, such as Korean or Japanese.
- The type of text file submitted is consistent across users.

**Note:** Although setting the default encoding to a value such as Korean or Chinese allows the server to process jobs with that encoding, it may cause jobs with other encodings to produce unexpected output.

To set the default encoding:

1. In the Configuration Manager, click **Advanced > Components**.
2. Click the Configure button adjacent the **Print Anywhere Server** component. The Print Anywhere Server (PAS) component configuration appears.
3. Click **Formats**.

4. In the **Format Options** panel, select the desired language encoding from the **Default Text File Encoding** drop-down.

5. Restart the Processing Server service:
   a) In the Configuration Manager, click **Home > Services**.
   b) Locate the **Print Anywhere Processing Server**, then click the adjacent **Restart** button.

---

**E.4 Enabling PrintAnywhere to permit print jobs from a remote CPS server**

If you have a PrinterOn deployment in which the PrintAnywhere Server and the CPS are on different servers, you need to modify Apache Tomcat to allow PrintAnywhere to accept requests from the CPS server.

To allow PrintAnywhere to receive jobs from a remote CPS server:

1. From the server hosting PrinterOn, stop the CPS Apache Tomcat service.
2. Navigate to `C:\Program Files (x86)\PrinterOn Corporation\Apache Tomcat\Conf`.
3. Open the server.xml file in any text editor.
4. Locate the following section:

   ```xml
   <Context path="/PasServlet">
   <Valve className="org.apache.catalina.valves.RemoteAddrValve" allow="127\.[0\-9]*\.[0\-9]*\.[0\-9]"/>
   ```

---
The `allow` parameter specifies the IP address of the server(s) from which Tomcat accepts requests.

5. Modify the value of the `allow` parameter to the IP address of the server hosting CPS. For example:

   `allow="172.16.39.52"` OR `allow="172.16.39.52"`

**Note:** If you have enabled email printing, or you have multiple CPS servers, you can enter multiple IP addresses by separating with a pipe character (|). For example:

   `allow="127.0.0.1|172.16.39.52"`

6. Save the changes to server.xml.
7. Start the Apache Tomcat service.

### E.5 Disabling strict SSL verification for CPS

In some cases, certain networks do not allow communication to the PrinterOn Directory, due to services such as Man in the Middle proxies. In those cases, there may be a need to disable SSL verification.

There is no configuration option to disable this setting in the Configuration Manager. You must manually edit the CPS configuration file.

To disable strict SSL verification:

1. Browse to the following folder:

   `C:\Program Files\PrinterOn Corporation\Apache Tomcat\Conf`

2. Open CPS_Config.xml in any text editor.
3. Locate the following entry:

   `<enableSSLVerify>true</enableSSLVerify>`

4. Modify the value to:

   `<enableSSLVerify>false</enableSSLVerify>`

5. Save the changes to CPS_Config.xml.
6. Restart Tomcat.
E.6 Enabling LDAP/AD for PrintWhere

To enable LDAP/AD for PrintWhere:


2. Click the Printers icon and locate the printer you’d like to enable authentication for.

3. Select the Payment & Authorization tab.

4. In the Authorizing Users section, select Redirect to authorize user, track pages or bill customer.

5. Check User Authentication URL, then enter the pathname of the server hosting the PrinterOn CPS Admin application. For example:
   
   192.168.1.20/cps/aaaLogin.jsp.

6. Save your settings and test the driver.
Trademarks and service marks

The following are trademarks or registered trademarks of PrinterOn Inc. in Canada and other countries:

PrinterOn®, PrintAnywhere®, Print Simply Anywhere®, PrintWhere®, PRINTSPOTS®, the PrinterOn Logo, the PrinterOn Symbol, PrintConnect™, Secure Release Anywhere™, and PrintValet™ are trademarks and/or registered trademarks of PrinterOn.

The following are trademarks or registered trademarks of other companies:

Windows, Internet Explorer, Microsoft Word, Microsoft Excel, Microsoft PowerPoint, and Microsoft Visio are trademarks or registered trademarks of Microsoft Corporation.

iPad, iPhone, AirPrint, and OS X are trademarks or registered trademarks of Apple.

iOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used by Apple under license.

Android, Chrome OS, and Chromebook are trademarks or registered trademarks of Google Inc.

BlackBerry is a registered trademark of BlackBerry, Ltd.

Other brands and their products are trademarks or registered trademarks of their respective holders.

Copyright notice

© Copyright 2016 by PrinterOn Inc.

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, photocopy, recording, or otherwise, without the prior written permission of PrinterOn Inc.

Disclaimer:

PrinterOn Inc. makes no warranty with respect to the adequacy of this documentation, programs, or hardware, which it describes for any particular purpose, or with respect to the adequacy to produce any particular result. In no event shall PrinterOn Inc. be held liable for special, direct, indirect, or consequential damages, losses, costs, charges, claims, demands, or claim for lost profits, fees, or expenses of any nature or kind.

Version 3.2.7 | November 4, 2016